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CHAPTER 1

Introduction
Zermelo is the premiere application for running table tennis tournaments. Zermelo automates nearly every aspect of running a tournament. Zermelo
Imports a rating list
Makes the draw
Calls matches and prints match cards
Optionally keeps track of which players have checked in or are playing
Prints updated draw sheets that show all results
Handles the most popular event formats:
– Single elimination
– Round robin (up to twelve players per group)
– Multiple round-robin groups with one or two players advancing from
each group to a single-elimination or round-robin second stage
• Submits results to Ratings Central or USATT
• Is compatible with time scheduling
• Is especially designed to handle both Ratings Central and USATTsanctioned tournaments
•
•
•
•
•
•

Zermelo solves two problems that plague most tournaments:
• Calling players for a match when they are already playing a match
• Not updating the posted copies of draw sheets with results
Zermelo makes it simple to submit your tournament to Ratings Central. If you
do so, you can see all the results and ratings on the Ratings Central website at
www.ratingscentral.com.
The only documentation for Zermelo is this manual; there is no Help. You
will probably want to print this manual (double-sided) and place it in a three-ring
binder. While Zermelo is very easy to use, you don’t want to be figuring out how it
works in the middle of a tournament. Therefore, you should read this manual and
experiment with Zermelo before using it at a tournament. Chapter 2 on page 25
contains an overview in the form of a tutorial. The following chapters of the manual are organized around each of the item’s in Zermelo’s main menu. There are a
couple of miscellaneous chapters at the end, followed by several appendices.
Zermelo is not free; see Appendix K on page 179.
1. Design Philosophy
If you run a tournament without a computer, you have lots of draw sheets at
the control desk. You do a lot of writing to record results and produce new match
cards. To call matches, you have to search through the draw sheets or match cards
17
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to find a match that you can call (preferably one involving players who have arrived
and who are not playing another match).
One way to use a computer to help run a tournament would be to use a spreadsheet. You could put each draw sheet on a spreadsheet page. You could then type
results into the appropriate place in the spreadsheet rather than writing the results on a paper draw sheet. You could have another spreadsheet that looked like
a match card into which you copied the names of the players for the match that
you wanted to play. You could then print match cards using the printer. You would
figure out which match to play next by searching visually through the draw sheets
on the computer screen.
Zermelo takes a very different approach. Zermelo handles all the details of
running the tournament. When you have an empty table, Zermelo figures out which
match to play next, checks that the players have arrived and are not playing other
matches, and prints the match card for you. When a result comes in, you don’t have
to find the appropriate place in the appropriate draw sheet to record the match.
Instead, you just type a couple of numbers, Zermelo pops up a window that looks
roughly like a match card, you mark the winner and the score, and you click the
OK button. In other words, Zermelo automates the running of a tournament with
the goal of making the tournament as easy for you as possible.
One consequence of this is that you will find that you rarely need to examine
a draw sheet at the control desk. If you do need to examine a draw sheet, Zermelo
can display the draw sheet on screen or print a copy.
2. Installation
This section discusses Zermelo’s hardware and software requirements, what
happens when you install Zermelo, how to upgrade Zermelo, and how to back up
and restore your data.
2.1. Hardware and Software Requirements. Zermelo runs on Windows 11,
10, 8.1, 8, 7. Your screen resolution must be at least 800 pixels wide by 600 pixels
high. Other than that, any computer hardware should work. You can also run it on
a Mac or Linux using Wine, CrossOver, Parallels, etc.
You must have a printer. You will be doing quite a bit of printing at the tournament (match cards and draw sheets), so a reliable printer is a necessity. You
will definitely want to test that match cards and draw sheets print properly (if you
work through the overview tutorial in Chapter 2 on page 25, you will print a draw
sheet and a match card).
At the tournament, the more easily you can work with the computer, the better.
So, if you are using a laptop, you will want to bring a mouse and perhaps a fullsized keyboard.
To submit your tournament to Ratings Central, you will need a connection to
the Internet (see Section 2 on page 39 for more information). You do not need to
be connected to the Internet while you are running your tournament.
2.2. Files. The installation program (e.g., Zermelo_29.3_Setup.exe) creates
a program folder (e.g., C:\Program Files (x86)\RatingsCentral\Zermelo\29) and
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places the executable (Zermelo.exe), User’s Manual (Zermelo.pdf), sample rating list (SampleRatingList.csv), sample club list (SampleClubList.csv), license file
(License.txt), OpenSSL files (libeay32.dll, ssleay32.dll; these files are only needed if
you check the ::Zermelo > Set Up Internet > Email > Use TLS check box), read-me file
(ReadMe.txt), and a file detailing the changes in each version (VersionHistory.txt)
in the program folder. It adds Zermelo and the User’s Manual to the “Start” menu
and optionally to the desktop. That’s all that the installation program does.
Note that the sample rating list and club list files are just samples; they do not
contain real players or clubs. Their only purpose is to let you work through the
overview section. Do not use them when running a real tournament.
When you start Zermelo, it will create the following set of database files
in the database folder: Club.nx1, Entry.nx1, Event.nx1, Member.nx1, Player.nx1,
RatingList.nx1, and Tournament.nx1. It will also create a TournamentLog.txt and
an nxTrans.cfg file.
The nxTrans.cfg file is used by the database library that Zermelo uses, but the
file is not essential. If it is erased, it will be recreated.
The Club.nx1 and RatingList.nx1 files only contain the data from whatever club
list and rating list that you’ve imported. Also, it is possible to keep these two files
in a different folder than the other database files (see Section 1.9 on page 57).
The remaining five files with the nx1 extension along with the TournamentLog.
txt file contain the information for the tournament. They are interdependent, so
you should treat them as a group.
2.3. Database Folder. The location of the database folder is controlled by the
shortcut that you use to start Zermelo. The shortcuts that the installer creates will
put this folder in your app data folder, e.g., C:\Users\YourUserName\AppData\
Roaming\RatingsCentral\Zermelo\29. Note that the default location of the database folder has been different in different versions of Zermelo.
The default location of the database folder is where Microsoft thinks apps
should put their files. It is probably a good idea to change the location to one that
is more convenient so that you can easily back up the files. See Section 6.1 on
page 61 for how to tell Zermelo where your database folder is.
See Appendix J on page 177 for advice on where you should put the database
folder.
2.4. Making Backups. Each time that you use Zermelo, be sure to make
backup copies of the files in your database folder, and keep the copies in a safe
place. To make a backup, close Zermelo, then copy the files.
As noted above, you don’t need to back up all the files in the database folder,
but it is simpler and safer to back them all up. If you don’t want to back up
the Club.nx1 and RatingList.nx1 files (since they are not needed when restoring a
backup), you can tell Zermelo to put these files in a different folder. See Section 1.9
on page 57.
You are responsible for making corrections (including removing duplicate players) for any tournaments that you submit to Ratings Central. Such corrections may
be necessary long after a tournament is submitted. Therefore you are expected to
back up your database files and retain them indefinitely. If you get a new computer,
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be sure to back up the files on the old computer and transfer them to the new computer. If you lose your database files, Ratings Central can send you replacements
that you can use to correct errors; see Section 2.3.2 on page 47. If you are no longer
able to be responsible for your tournaments, see Section 1.8.1 on page 56.
2.5. Upgrading. The format of the database files in a new major version of Zermelo will be different than in previous versions. However, the file format will not
change in a minor version release. You do not need to uninstall a previous version
when installing a new version (this applies to both major and minor versions).
By default, the installation program installs each major version in a different
folder. You will want to keep your old versions when you install a new major
version so that you can still access the files for the old tournaments that you’ve
run.
When Zermelo starts, it checks the version of the database files to make sure
that the version is consistent with the version of Zermelo that you are using. If the
versions do not match, Zermelo will display an error message and exit. However,
if it is only the Club.nx1 and RatingList.nx1 files that are the wrong version, Zermelo will simply delete these files and create new, empty ones that are the correct
version. If this happens, you will need to import the club and rating lists again.
2.6. Restoring Backups. To restore a backup (to the same or a different computer), you need to have Zermelo installed on the computer that you are restoring
to. You then need to determine (or change) the location of the database folder. See
Section 2.3 on the previous page and Section 6.1 on page 61. Finally, you need to
copy the files from your backup to the database folder. You can then start Zermelo.
The location of the database folder is displayed in the status bar at the bottom of
Zermelo’s main window (see Section 5.1 on page 22). Make sure that the status bar
displays the folder that you copied the files to.
2.7. Minor Issues. If you move the database files from one computer to another by writing them to a CD or DVD, or if you restore them from a backup on
a CD or DVD, the files may end up being read-only. When you start Zermelo, you
will get an error message to this effect. To fix the problem, right-click the files in
Windows Explorer, select Properties, and uncheck the Read-only check box.
Sometimes, if you move the database files to a different version of Windows
or if Windows has been updated, Zermelo will need to do a database pack when it
starts. If it does, you may see a slight delay when Zermelo starts. The reason is that
Windows is telling the database that the way it sorts strings may be in a slightly
different order from the other version of Windows, and the database wants to make
sure that everything will work correctly.
2.8. Clock. Be sure that your computer has the correct time and date. Zermelo
doesn’t call matches until the event’s start time has arrived, so if your computer
has its clock set incorrectly, you will be very puzzled as to why Zermelo doesn’t
print any match cards.
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3. Language
Zermelo uses the Unicode character set. Zermelo versions before version 21
used the ISO 8859-1 (Latin 1) character set (en.wikipedia.org/wiki/ISO_8859-1). If
you have database files from an ISO 8859-1 version of Zermelo, you can still use
the ISO 8859-1 version of Zermelo to resubmit a tournament to make corrections.
However, you should use a Unicode version of Zermelo for new tournaments. An
ISO 8859-1 version will not be able to use characters that are not in the ISO 8859-1
character set. If you use an ISO 8859-1 version to download club and rating lists
from the Ratings Central website, characters in those lists that are not in the ISO
8859-1 character set will be replaced by question marks.
Zermelo will use your Windows locale. Your Windows locale will affect the
order in which records are displayed in grids as well as the display of some dates,
times, and monetary values.

4. Time Scheduled vs. Paging
When running a tournament, there are two ways to get players to show up at
the control desk for their matches. One is to use a public-address system to page
them. The other is to time schedule the tournament. Time scheduling means that
every match is assigned a time and each player is given a schedule of when all their
matches will be. In the U.S., the U.S. Open, U.S. Nationals, and North American
Teams are time scheduled. Giant round-robin tournaments are also often time
scheduled. Most other tournaments in the U.S. use a public-address system to
page players. Note that if a tournament is not time scheduled, this does not mean
that events do not have starting times; they do. However, the starting time is when
the players must show up at the tournament and check in, not necessarily when
the matches in the event will be played.
Zermelo is most effective for tournaments that page players. However, you
can use it with time-scheduled tournaments, although Zermelo does not provide
any specific support for creating or using a time schedule. For time-scheduled
tournaments, you will want to uncheck the ::Matches > Modify Calling > Manage
match calling check box (see Section 8.1 on page 119). Also, see Section 1 on
page 147 for ways to use Zermelo with giant round-robin tournaments.
The advantages of time-scheduled tournaments are that players know when
each of their matches will be played and the hall is quieter because you do not
need to page players for matches. The advantages of using the paging system
are that you need much less time to play the same number of matches (i.e., the
table utilization is much higher), you don’t have to construct a time schedule, and
conflicts are not a problem (a conflict is when a player is scheduled to play two
matches at the same time or when a player’s match takes longer than expected and
overlaps the time that they are scheduled to play another match).
If you are using the paging system to get players to report to the control desk,
it is very important that the public-address system work well so that players can
recognize their names when you call them. With most public-address systems, you
should speak in a normal voice with the microphone held as close to your mouth
as possible.
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If you are using the paging system, you should choose event starting times
very differently than you would if you were time scheduling the tournament. See
Section 1 on page 151.
4.1. Hybrid Scheduling System. Tournaments that have events with multiple
round-robin groups of four players often use a hybrid scheduling system: The
tournament is not fully time scheduled, but all round-robin groups in an event are
sent out at the starting time of the event. Normally, Zermelo does not send out an
entire round-robin group at a time; instead Zermelo calls each match in the group
individually.
There are significant advantages to using Zermelo and the paging system for
round-robin groups: It is much simpler to get two players to report for a match
than to find all four for a round-robin group. You don’t have to worry about players not knowing how to fill out the round-robin draw sheet or taking a long time
between matches. It is easy to get the event started even if not all the players have
checked in. You don’t have to keep track of which table you sent each group out to
so that you can tell a player who is tardy or was playing another match where their
group is playing. You don’t have to assign a fixed number of tables to each group.
There are no problems with conflicts. Since players turn in the match card after
each match, you can post updated draw sheets showing the progress of the group
and also tell if the group is taking too long to play its matches. Players are available
to play their matches in other events rather than simply waiting for their group’s
table to be free when other players in their group are using it. When a player has
finished their matches in the group, you will know immediately (rather than only
when the entire group is done), and so you can send them out for another match.
You will find that using Zermelo and the paging system for tournaments that
were using the hybrid scheduling system, or even for giant round-robin tournaments, makes such tournaments more organized, both for the players and for the
control desk.
However, if you insist on sending out entire round-robin groups at a time,
but want Zermelo to help you keep track of who is playing for the other parts of
the tournament, see the ::Events > Modify > Edit > Search > Stages field and the
::Matches > Call Stages and ::Matches > Call Some menu items.
5. Main Window
When you start Zermelo, you will see Zermelo’s main window (Figure 1 on the
next page). The main window has the main menu at the top, a log window in the
middle, and a status bar at the bottom.
The log window records many of the actions that Zermelo performs (e.g., calling matches or recording results) so you can see what you’ve done. The information in the log window is duplicated in the file TournamentLog.txt (in the database
folder). Zermelo’s only use for this file is to display it for your benefit.
5.1. Status Bar. The first pane of the status bar is the posting-reminder pane.
The pane will show a pushpin icon when it is time for you to print modified draw
sheets for posting (see Section 4 on page 105 and Section 2 on page 100). When
the pushpin icon is displayed, you can print the draw sheets that need to be posted
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Figure 1. Main window
by clicking the pushpin icon. You can also print the draw sheets that need to be
posted at any time by pressing the ⟨M⟩ key. The pane will be hidden if the ::Draw
Sheets > Modify Posting > Remind check box is unchecked or if it is not during the
tournament.
The second pane of the status bar is the matches-playing pane; the value is labeled “Playing”. It shows how many matches are currently playing, i.e., the number
of match cards outstanding. Of course, Zermelo can’t tell if the players are actually
playing, waiting for a table to free up (if you are using double clipboards), or if the
match card is sitting at the control desk.
The third pane of the status bar is the overdue-results pane; the value is labeled
“Overdue”. It shows how many match results are overdue. See Section 8.6 on
page 123 for how to control when Zermelo considers a result to be overdue. The
pane will be hidden if the ::Matches > Modify Calling > Manage match calling check
box is not checked or if it is not during the tournament. If there are any overdue
results, the pane will be highlighted. To find out which results are overdue, do
::Matches > List Playing (see Section 7 on page 118).
The fourth pane of the status bar is the remaining-matches pane; the value is
labeled “Remaining”. It shows how many matches are remaining in the tournament,
i.e., the total number of matches in all events that are not completed.
The last pane of the status bar is the database-folder pane. It displays the
database folder.
6. Notation
In this manual, I’ll write the names of menu items, buttons, field labels, etc.
in a slanted sans-serif font, e.g., Rating List. I’ll specify sequences of menu items,
buttons, etc. by separating them with a “>” sign. I’ll use the double colon “::” to
mean that the sequence of items starts at the main menu. For example, you can exit
Zermelo via ::Zermelo > Exit. I’ll write keys on the keyboard by putting the name

24

1. INTRODUCTION

of the key between angle brackets, e.g., ⟨Ctrl+Del⟩ or ⟨Enter⟩. Note that ⟨Ctrl+Del⟩
means hold down the control key and press the delete key.
7. Features Relevant to Different Organizations
Some features of Zermelo are only relevant if you are submitting your tournament to Ratings Central, while others are only relevant if your tournament is
USATT-sanctioned. If I say that a feature is only for “Ratings Central tournaments”,
this means that it is only relevant if you are submitting your tournament to Ratings Central. Similarly, if I say that a feature is only for “USATT tournaments”, this
means that it is only relevant if your tournament is USATT-sanctioned.
Chapter 14 on page 133 explains exactly what information Zermelo sends to
Ratings Central when you submit your tournament.
Regardless of what organization your tournament is affiliated with, the defaults should get you started.

CHAPTER 2

Overview
This chapter provides a brief overview in the form of a tutorial. Working
through this tutorial is not a substitute for reading the rest of the manual. The
tutorial goes through all the major steps of running a simplified tournament consisting of one event and two players. The tutorial assumes that you are letting
Zermelo manage the calling of matches; if you aren’t, then checking players in is
optional (see Section 8.1 on page 119 and Section 1.2.19 on page 81).
Start Zermelo. You will see Zermelo’s main window, which we already saw
in Figure 1 on page 23. Select ::Lists > Import. You will see the window shown
in Figure 1. Click the button at the right of the Rating list field and select
the file SampleRatingList.csv in the program folder (e.g., C:\Program Files (x86)
\RatingsCentral\Zermelo\29). Click the button at the right of the Club list field and
select the file SampleClubList.csv in the program folder. Click the Import button.
Zermelo will import the lists.
Select ::Tournament > Modify. You will see the window in Figure 2 on the next
page. Type “Zermelo Open” in the Name field. Click the button at the right of the
Start date field. This will drop down a calendar. Click the Today button. Set State
to “VA”. Click the Save button.
Select ::Events > Modify. You will see the window in Figure 3 on page 27. Click

Figure 1. Import-lists window
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Figure 2. Modify-tournament window

the Add Event button. The notebook will switch to the Edit page (see Figure 4 on
page 28). Set Schedule > Start time to a few minutes ago. Click the Save button.
You will see the Browse page and the event you just added will be listed in the grid
(see Figure 5 on page 29). Click the Close button.
Select ::Players > Modify. You will see the window in Figure 6 on page 30. We’ll
assume that the players have played in a previous tournament and so are on the
rating list. If you have players who have not played in a previous tournament or
you don’t have a rating list, then you would add them by clicking the Add Player
button.
Since we are assuming that the players are on the rating list, click the Rating
List button. You will see the rating-list window (Figure 7 on page 30). Click the Add
Player button to add David James to the tournament. You will now see the Edit
page of the modify-players notebook (Figure 8 on page 31). Click the check box to
the left of where it says “1 Open Singles” to put the player in the event. Click the
Save button.
Click the Rating List button to bring up the rating list again. This time, click
on the line that says “O’Neill, Sean Patrick”, then click the Add Player button. Click
on the check box to the left of where it says “1 Open Singles”. Click the Save
button. The window should look like Figure 9 on page 32. Click the Close button.
Figure 10 on page 32 shows what the log window now looks like. Zermelo has noted
that each player has been added to event number 1. The numbers in parentheses
are the tournament player ID numbers (for identifying players at the tournament).
Zermelo only writes information about players adding and scratching events to the
log window if it is during the tournament.
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Figure 3. Modify-events window
Now that we have an event and two players entered in the event, we need to
make the draw. Select ::Events > Draw. Zermelo will make the draw. Zermelo
will also beep and the pushpin icon in the posting-reminder pane of the status bar
will go on to indicate that there are modified (in this case, new) draw sheets (this
only happens if you make the draw during the tournament). Select ::Draw Sheets >
Print. You will see the window in Figure 11 on page 33. Make sure your printer is
turned on. Click the check box to the left of where it says “1 Open Singles”, and
click the OK button. Zermelo will print the draw sheet (see Figure 12 on page 33).
Select ::Players > Print Lists. You will see the window in Figure 13 on page 34.
Click the Registration list check box. Click the OK button. Zermelo will print a
registration list (Figure 14 on page 34) that you can use to check players in at the
tournament.
When a player checks in, you need to tell Zermelo that the player has arrived.
Select ::Players > Check In or Out. You will see the window in Figure 15 on page 35.
Type “1” in the Player ID field and click the OK button. Type “2” in the Player ID
field and click the OK button. Click the Close button. The two players are now
checked in.
Select ::Matches > Call. Zermelo will print the match card (Figure 16 on
page 35). To enter the result, select ::Matches > Enter Result. You will see the
window in Figure 17 on page 36. The third line on the left of the printed match
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Figure 4. Edit-event page
card says “E1 R9 M1 0”. Type these numbers (without the letters), pressing the
⟨Enter⟩ key in between, i.e.,
1⟨Enter⟩9⟨Enter⟩1⟨Enter⟩0⟨Enter⟩
The window will look like Figure 18 on page 36. Let’s suppose David won the match
11–5, 10–12, 11–8, 11–3. Click the check box next to David’s name. Press ⟨Enter⟩
to move to the Score fields. Then type
5⟨Enter⟩-10⟨Enter⟩8⟨Enter⟩3⟨Enter⟩
The window will look like Figure 19 on page 37. Click the OK button. This saves
the result.
In a real tournament, you would now do ::Matches > Call to call the next match.
In fact, you will spend most of your time at a tournament entering results via
::Matches > Enter Result and then calling new matches via ::Matches > Call. However, this tutorial tournament only has one match, so the tournament is done.
For a Ratings Central or USATT tournament, the final step is to submit the tournament. Submitting the tournament to Ratings Central is covered in Section 2 on
page 45. Submitting the tournament to USATT is covered in Section 4 on page 60.
To erase the tournament that you just created and start fresh, close Zermelo
(via ::Zermelo > Exit). Then use Windows Explorer to delete the files in the database
folder. The location of the database folder is displayed in Zermelo’s status bar (see
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Figure 5. Event grid
Section 5.1 on page 22). Alternatively, you can do ::Tournament > Create New to
create a new tournament (see Section 6 on page 60).
Note that the sample rating list and club list files that you used in this overview
are just samples; they do not contain real players or clubs. Their only purpose
is to let you work through this overview. Do not use them when running a real
tournament.
Before using Zermelo with a real tournament that you are going to submit to
Ratings Central, please enter your Internet parameters (see Section 2 on page 39)
and perform the test in Section 2.3 on page 41 to verify that you will be able to
submit the tournament.
Before submitting a real tournament to Ratings Central, please read Chapter 13
on page 129 to learn how to set the priors for unrated players.
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Figure 6. Modify-players window

Figure 7. Rating-list window
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Figure 8. Edit-player page
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Figure 9. Player grid

Figure 10. Log window showing players that were added to events
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Figure 11. Print-draw-sheets window

Figure 12. Printed draw sheet
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Figure 13. Print-player-lists window

Figure 14. Printed registration list
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Figure 15. Check-in-or-out window

Figure 16. Printed match card
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Figure 17. Enter-result window

Figure 18. Match result being entered
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Figure 19. Match result entered
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CHAPTER 3

Zermelo Menu
The Zermelo menu contains items that relate to the application as a whole. The
items let you exit the application, set up your Internet parameters, select which
printer to use, and display the application’s version information.
1. Exit
The Exit menu item closes Zermelo. No information is lost when you do this
because Zermelo always writes all information to the database files immediately
after completing any operation.
2. Set Up Internet
The Set Up Internet menu item is only relevant for Ratings Central tournaments. It brings up a window (Figure 1 on the following page) that lets you set
your email and Web parameters. Zermelo uses these when submitting the tournament to Ratings Central and when downloading rating and club lists.
Put your email address in the Your email address field. Enter only your email
address; don’t include angle brackets or a display name. If you do a test submission
(see Section 2.3 on page 41), Ratings Central will send the reply to the email address
that you enter here. If you submit a tournament, Ratings Central will send any
error messages to the email address that you enter here. However, Ratings Central
will send the email message that the tournament has been processed to the email
address that Ratings Central has for your director ID, not the email address that
you enter here. To update the email address for your director ID, log into the
Ratings Central website. We recommend that you enter the same email address
here that you have set up for your director ID.
Zermelo can submit the tournament to Ratings Central using either email or
the Web. Select the method you prefer in the Submission method drop-down list.
The Web submission method is easier to set up and will work with more Internet
connections. The email submission method may work more quickly.
2.1. Email. Enter the name of your SMTP (outgoing mail) server in the
SMTP server field. This may be something like smtp.YourDomain.com or mail.
YourDomain.com. Your Internet or email provider may include this information
on their website in their instructions for setting up your email client. If you only
use webmail, then you probably won’t find the SMTP server name in your email
settings. If you can’t find the SMTP server name anywhere, ask your Internet or
email provider.
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Figure 1. Set-up-Internet window
Enter your SMTP port in the SMTP port field. The standard ports for SMTP are
25 and 587. If your Internet or email provider doesn’t tell you the port to use for
their SMTP server, try both of them (both, one, or neither may work).
Some Internet or email providers have their SMTP servers set up to use authentication (i.e., to require a username and password). If your Internet provider uses
SMTP authentication, check the Use authentication check box. Then enter your account username and password in the Username and Password fields. If the SMTP
server supports TLS (the “explicit” type of TLS), then check the Use TLS check box.
TLS encrypts the communication with the server so that your password is not sent
in clear text. The SMTP port to use may depend on whether you are using TLS.
When using TLS, Zermelo just makes sure to create a TLS connection and does not
verify that the certificate that the server provides is really for the server, is not expired, etc. Note that just because you have a username and password doesn’t mean
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Figure 2. Test-sent window
that your SMTP server uses SMTP authentication. You always have a username and
password so that you can access the POP (incoming mail) server.
If you don’t have access to an SMTP server or you don’t know how to configure
Zermelo to use it, then use the Web submission method.
2.2. Web Proxy Server. Usually, you don’t have to set any Web parameters.
However, some Internet connections use a proxy server to access the Web. It is
unlikely that a home connection uses a proxy server, but it is moderately common
for companies to use proxy servers. Zermelo uses the Web proxy server parameters
when downloading rating and club lists and when submitting the tournament to
Ratings Central using the Web submission method.
You can find whether you are using a proxy server by looking at your Internet options in Windows: Control Panel > Internet Options > Connections > LAN
Settings. . . > Proxy server. If the Use a proxy server for your LAN check box is
checked, then you should check Zermelo’s Use proxy server check box and copy
the values from the Windows Address and Port fields to Zermelo’s Server name
and Port fields. If your proxy server requires a username and password enter them
in the Username and Password fields.
Sometimes a company uses a proxy server, but you can still access the Web
even if you leave the User proxy server check box unchecked.
2.3. Test. Click the Test button to test your Internet setup. When you click this
button, Zermelo will send a test submission to Ratings Central. If Zermelo succeeds
in sending the test, it will display the window in Figure 2. Ratings Central will
respond with an email like the one in Figure 3 on the next page. The “Submitted”
date and time in the email will be the date and time that you clicked the Test
button.
Usually, you will get a reply to your test in a few minutes. However, the Ratings
Central processor may be busy processing events, so it may take longer. It won’t
take more than a day.
3. Select Printer
The Select Printer menu item brings up a window (Figure 4 on the following
page) that lets you select which printer Zermelo prints to. If you select “Default”,
then Zermelo will print to whichever printer you’ve set as the default printer in
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From: Ratings Central
Sent: Saturday, March 26, 2022 1:54 PM
To: David Marcus
Subject: Ratings Central received your test
Submitted: Sat, 26 Mar 2022 13:52:16 -0400 (EDT)
Status: Test
We received the test that you sent.
Ratings Central
www.ratingscentral.com
Figure 3. Test reply email

Figure 4. Select-printer window
Windows. Zermelo stores the printer that you select in the Zermelo.ini file, so
Zermelo will remember the value even after you quit Zermelo.
4. Display Version
The Display Version menu item brings up a window (Figure 5 on the next page)
that shows version and copyright information. The version number is also shown
in the title bar of Zermelo’s main window. You can find the latest version of Zermelo on the Ratings Central website.
You can click on the photo to go to a webpage about Ernst Zermelo.
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Figure 5. Version window
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Ratings Central Menu
The Ratings Central menu contains items that let you visit the Ratings Central
website and submit your tournament to Ratings Central. Ratings Central is not
free; see Appendix K on page 179.
1. Visit Website
The Visit Website menu item opens your browser on the Ratings Central home
page (https://www.ratingscentral.com). To get to the “Event Director Support” webpage, click the “Event Director Support” link that is in the left sidebar on every page
on the website.
2. Submit Tournament
The Submit Tournament menu item brings up a window (Figure 1) that lets you
submit the tournament to Ratings Central.
The menu item will be disabled if you haven’t set up your Internet parameters
(in ::Zermelo > Set Up Internet) or haven’t set the tournament name and start date,
entered your director ID and password, and set the tournament unrated prior (in
::Tournament > Modify). Of course, you will probably want to wait until the tournament is finished before you submit it.
Note: In this section, the word “event” means a Ratings Central event, not an
event within the tournament.
Ratings Central identifies a tournament by its start date and director ID. Do
not use the same director ID with Zermelo to submit two tournaments that have
the same start date or submit a tournament that has the same start date as the
event date of an event that you submit with Cantor, or any other client, for the
same director ID.
If you need to submit two tournaments or events that have the same date, then
you need a second director ID. If you aren’t sure what to do, discuss it with us; see

Figure 1. Submit-tournament window
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Figure 2. Tournament-submitted window
https://www.ratingscentral.com/Problems.php for our email address. Also, if you
want to submit events for more than one sport, you need a director ID for each
sport.
If you accidentally submit two different tournaments or events using the same
date and director ID, you must completely delete the event from Ratings Central
(by submitting the event with no results), then resubmit the event that you want
to have this date and director ID. If you do not completely delete the event, new
players in the event may have the wrong names, ratings, etc. If you need help with
this, please contact us; see https://www.ratingscentral.com/Problems.php for our
email address.
2.1. Submitted. The Submitted check box indicates whether you have ever
submitted the tournament. This is an informational check box, i.e., you can’t
change it. You can submit a tournament more than once, e.g., to correct an error; see Section 2.3 for how to correct errors.
Since Ratings Central identifies a tournament by its start date and director ID,
once you submit the tournament, Zermelo won’t let you change the start date or
director ID; see Section 2.3.1 on the next page if you need to change these. So
that Ratings Central can keep track of which player is which, once you submit a
tournament, Zermelo won’t let you delete a player or change a player’s tournament
ID.
2.2. Submit. Click the Submit button to submit the tournament to Ratings
Central. If Zermelo succeeds in submitting the tournament, it will display the window in Figure 2. See Chapter 14 on page 133 for what happens when you submit a
tournament.
If you are resubmitting a tournament because the first submission didn’t work,
i.e., wasn’t received by Ratings Central, you will need to re-check any player New
personal info check boxes that were checked in the prior submission.
2.3. Correcting Errors. If you need to correct any of the match results, player
data, or other information that you submitted, just correct them and then click
the Submit button to submit the tournament again. If you are correcting a player’s
personal information, you will have to check the player’s New personal info check
box. Do not check the New personal info check box if you are only correcting a
player’s Ratings Central ID or unrated prior. See Section 1.2.15 on page 79 for
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more information on the New personal info check box. See Section 1 on page 135
for how to fix a duplicate player.
If a player or another Ratings Central event director contacts you to inform you
of an error that you need to correct, you should reply to them within one business
day and fix the problem within one week.
2.3.1. Wrong Start Date or Director ID. If you submit the tournament using the
wrong start date or wrong director ID, there are three ways that you can fix it.
One way is to delete all the matches, resubmit the tournament containing no
matches (to delete it), then enter the matches into a new tournament on the correct
date and using the correct director ID. However, this way is impractical to do with
Zermelo. (It could be done by switching to using Cantor for the event, some trickery
to get Cantor to submit the empty event, and considerable effort, but we don’t
recommend it.)
The second way is to contact us and request the event report file (identifying it
by start date and director ID). Once you have the event report file, you can ask us to
delete the existing event. You can then edit the event report file to change the date
or director ID (changing them in the “[Event]” section and the filename), import it
into Cantor (::Events > Import), and submit it. If you use the second method, be
sure you don’t ever resubmit the wrong-date/wrong-director version (e.g., delete
the database files).
The third way is to send us the Tournament.nx1 file. We can then delete the
existing event, edit the file to change the start date or director ID, and send you
back the file. You can then submit the tournament.
If you contact us, be sure to tell us both the wrong start date and director
ID and the right ones. See https://www.ratingscentral.com/Problems.php for our
email address.
2.3.2. Lost Files. If you lose your database files, you won’t be able to resubmit
the tournament to make corrections. To replace lost files, contact us and tell us
the filename of the Ratings Central report file for each tournament that you have
lost. The filenames are of the form YYYY-MM-DD_<ID>.dat where YYYY-MM-DD is
the date of the tournament and <ID> is the director ID of the tournament. We will
send you the Ratings Central report files. The report files can only be imported
into Cantor, not Zermelo, since the detailed tournament information is not sent
to Ratings Central. See the discussion of ::Events > Import in the Cantor User’s
Manual. See https://www.ratingscentral.com/Problems.php for our email address.

CHAPTER 5

Lists Menu
The Lists menu contains items that let you import rating or club lists and
browse the imported lists.

1. Import
The ::Lists > Import menu item brings up a window (Figure 1) that lets you
import a rating list or club list into Zermelo.
If you will be submitting the tournament to Ratings Central, then you should
download rating and club lists from Ratings Central. Without a rating list, you
won’t know the Ratings Central IDs of players. Without a club list, you won’t be
able to set Ratings Central clubs for players or the tournament.
To add your club to the Ratings Central club list, go to the Ratings Central
website and log in (see Section 1 on page 45).
If you will not be submitting the tournament to Ratings Central, then you don’t
need a club list. While you also don’t need a rating list, having one will make it
easier for you to enter players. For a USATT tournament, you will want to get a
USATT rating list from USATT.

Figure 1. Import-lists window
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Figure 2. Download window
Ratings Central provides players’ personal information so that you can publicize and run your events. Please respect players’ privacy—do not use the information for other purposes or give it to anyone else.
There are two ways to download the rating and club lists: automatic and manual.
1.1. Automatic Download. To have Zermelo automatically download the rating and club lists from the Ratings Central website and import them, set the Source
drop-down list to “Web”. You won’t be able to select “Web” unless you’ve already
entered your director ID and password via ::Tournament > Modify > Director. You
must also have set the sport that is associated with your director ID. If you select
the wrong sport, then the import will fail with a message that Zermelo can’t find a
file.
If you’ve previously imported lists, then the Existing records radio box will be
active. If you select the Discard all radio button, then all the records that you
previously imported will be discarded. If you select the Keep radio button, the
new records you are about to import will be appended to the ones you previously
imported. (If you previously imported the sample rating or club lists that come
with Zermelo, be sure to select Discard all.)
If you select Keep, then the For duplicates, keep. . . radio box will be active.
You have a duplicate record if there are two records for the same player ID or club
ID number. If you select New, then the new record for any duplicate will be kept
and the old one will be discarded. If you select Old, then the old record will be kept
and the new one discarded.
Click the Import button to download and import the lists. Figure 2 shows the
window that Zermelo will display while downloading. Once the lists are downloaded, Zermelo will automatically import them.
In addition to importing the lists, Zermelo will place text copies of the lists
in the list database folder (see Section 1.9 on page 57). The files will have names
like RatingList.csv and ClubList.csv, but if your director ID is for a sport other than
table tennis, the filenames will have a prefix that identifies the sport (i.e., “Hardbat”,
“Sandpaper”). See Section 1.2 for more information on these two files.
If you connect to the Web via a proxy server, you will need to enter your proxy
server information in ::Zermelo > Set Up Internet.
1.2. Manual Download. To download a rating list and a club list manually, go
to the Ratings Central website and log in (see Section 1 on page 45). Just below
where it says “Download zipped . . . rating and club lists” (the sport name will
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Member ID,Last Name,First Name,Rating,State,Zip,Gender,Date of Birth,Expiration Date,Last Played Date
8840,O’Neill,Sean Patrick,2484,VA,22903,M,1/2/1967,12/31/2099,8/31/2003
56475,James,David H.,1827,VA,23227-1721,M,3/4/1973,9/30/2002,11/25/2001

Figure 3. Sample USATT rating list
be where the ellipses are), click the link for the appropriate version. This will
download the two lists in a single zip archive. Save the file.
You will need any unzip program to extract the two lists from the archive.
Windows has built-in support for unzipping files. There are also dozens of unzip
programs available on the Web.
Extract the contents of the zip file. You should now have two files with names
like RatingList.csv and ClubList.csv. (As mentioned above, if your director ID is for
a sport other than table tennis, the filenames will contain a prefix that identifies
the sport.) These are CSV files. “CSV” stands for comma-separated values. A CSV
file is just a text file with commas separating the values.
Excel understands CSV files, so you can open them in Excel, if you wish. You
can’t have a list open in Excel while you are trying to import it into Zermelo. If
you do this, you’ll get an error message that says something like “Cannot open file
RatingList.csv: The file is open in another application.” Excel uses a nonstandard
CSV format—Zermelo can import lists that are in either the standard CSV format
or in Excel’s CSV format.
Once you’ve downloaded the rating list and the club list, you are ready to
import them. Set the Source drop-down list to “File”. To import the rating-list file,
RatingList.csv, type the filename of the file in the Rating list field. Include the path
to the folder where the file is, e.g., C:\My Documents\RatingList.csv. Alternatively,
click on the button at the right of the field to browse for the file.
To import the club-list file, ClubList.csv, type the filename including path in
the Club list field, or click on the button at the right of the field to browse for the
file.
You can import both a rating list and a club list at the same time. If you do so,
then the selections you make in the radio boxes apply to both lists.
Click the Import button to import the lists.
Note that the rating list and club list are sport specific. So, if you have more
than one director ID and the director IDs are for different sports, be sure you
download and import the lists that are appropriate for your event’s sport.
1.3. USATT Rating List. Zermelo can also import a USATT rating list in CSV
format that you can get from USATT. USATT provides a list that is only available
to tournament directors that includes birth dates. There may also be a publicly
accessible list that does not include birth dates. Zermelo can import either version
of the list. Figure 3 shows the first few lines from such a list (including birth
dates). To compare Figure 3 to the file that you receive from USATT, view the
file in Notepad, not Excel. The first/header line must have the column headers
shown (ignoring case) and in the same order (the “Date of Birth” column can be
omitted). Each succeeding line must have the information for one player with the
fields separated by commas. Any field that contains a comma must be surrounded
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Figure 4. Import-lists error window
by double quotes. The “State” column may contain a three-letter country code.
Unrated players must have a rating of “0” or blank. Dates must be in m/d/yyyy
format. Gender must be either “M”, “F”, or blank. Players with life memberships
must have an expiration date of “12/31/2099”.
Import the USATT rating-list file the same way that you would import the Ratings Central RatingList.csv file, i.e., set the Rating list field to the name and path of
the file and click the Import button.
If your tournament is both a USATT tournament and a Ratings Central tournament, then you will want to import both the Ratings Central rating list and the
USATT rating list. When you import the second rating list, you will need to select
the Keep radio button in the Existing records radio box. For the For duplicates,
keep. . . radio box, it doesn’t matter whether you select New or Old because Zermelo knows to not confuse player IDs from the two organizations.
1.4. Import Errors. If Zermelo encounters a problem parsing a line in a list
that it is importing, it will display a window with a message explaining what the
problem is and what line is causing the problem; see Figure 4. Click the Continue
Importing button to skip the line and continue importing the list. Click the Continue and Ignore Errors button to skip the line, continue importing, and silently
skip any subsequent lines that have errors. Click the Stop Importing button to stop
importing the list. In all cases, any lines already imported will remain imported
and the problem line will not be imported.
2. Browse Rating
The Browse Rating menu item brings up a window that lets you browse the
rating lists that you’ve imported. See Section 1.3 on page 85 for more information.
3. Browse Club
The Browse Club menu item brings up a window that lets you browse the club
list that you’ve imported. See Chapter 11 on page 125 for more information.

CHAPTER 6

Tournament Menu
The Tournament menu contains items that let you set various parameters that
apply to the tournament as a whole, display counts of the number of players and
events, print table numbers for taping to the tables, generate a tournament report
file that you can send to USATT after the tournament is complete, export a list of
finalists, and generate a new set of database files so that you can use Zermelo with
a new tournament.

1. Modify
The Modify menu item brings up a window (Figure 1) that lets you set such
items as the name, date, and club of the tournament, the cutoff dates for juniors
and seniors, whether unrated players can advance in rating events, and information
for submitting your tournament to Ratings Central. No changes are made to the
database files until you click the Save button.

Figure 1. Modify-tournament window
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1.1. Name. Enter the name of the tournament in the Name field. Zermelo
prints the tournament name on draw sheets and match cards, writes it to the
USATT tournament-report file, uses it to construct the name of the tournamentreport file, and submits the name to Ratings Central. You must set the name for
the tournament.
1.2. Start Date and Days. Enter the start date for the tournament in the Start
date field. Even though Zermelo will display the month name, you can enter a date
by typing it in numbers, e.g., “7/21/03”. You can click on the button at the right
of the field to drop down a calendar that you can use to set the date. Once you’ve
submitted the tournament to Ratings Central, you can’t change the start date. If
you submit the tournament using the wrong start date, see Section 2.3.1 on page 47
for how to fix it.
Set the Days drop-down list to the number of days in the tournament. The
tournament can be up to three days long.
1.2.1. State and Province. The State and Province fields are only relevant for
Ratings Central tournaments. For the USA and Canada, set the State field to the
state (for the USA) or province (for Canada) where the event is located. For countries other than the USA and Canada, set the Province field to the province where
the event is located; you may leave the Province field blank. The State and Province
fields will be enabled or disabled appropriately when you select the country. Zermelo also uses the tournament state and province as the default state and province
when adding new players to the tournament.
1.3. Country. The Country field is only relevant for Ratings Central tournaments. Set this field to the country where the tournament is located. Zermelo
also uses the value you set as the default country when adding new players to the
tournament.
1.4. Registration Fee. The amount you enter in the Registration fee field will
be added to how much each player owes.
1.5. Cutoff Dates. The Cutoff dates fields allow you to specify the date on
which a player’s age is calculated for determining eligibility in junior or senior
events. Use the Juniors field to specify the date for junior ages and the Seniors
field to specify the date for senior ages. Use the year-month-day order that matches
your Windows regional settings. If you leave the field blank, then Zermelo will use
the tournament start date for this purpose. For some reason that is a mystery to
me, the USATT Tournament Guide says to use the end of the year as the cutoff date
for senior events. I suggest that you use the tournament start date as the cutoff
date for junior and senior events.
1.6. Unrated Players. If Advance is not checked, then unrated players will not
advance to the next round after playing a rated player in events where only players
under a certain rating can enter. In other words, win or lose, the rated player
will advance. Zermelo determines whether only players under a certain rating can
enter an event by whether you set a value for Eligibility > Rating cutoff or Doubles >
Team-rating cutoff in ::Events > Modify > Edit. So, if both these rating-cutoff fields
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are blank, then unrated players will advance in the event, even if the Advance check
box is not checked.
You should probably leave the Advance check box unchecked. It isn’t fair
to rated players for unrated players to knock them out of rating-limited events.
On the other hand, unrated players should get a discount on the entry fee when
entering such events. For a single elimination event, players play two matches on
average. Since an unrated player will play just one match, it would be reasonable
for unrated players to pay half price. For an event with round-robin groups of four
with the winner advancing to a single-elimination bracket, players play three and a
half matches on average (three matches in the group and a one quarter chance of
playing two more matches). Since an unrated player will play just three matches, a
15% discount would be reasonable.
Sometimes it makes sense to check the Advance check box. For example, the
Bay State Games (Massachusetts State Games) had events organized by age, but
also had a couple of novice events open to unrated players or players with low
ratings. Since the novice events are basically for unrated players, unrated players are allowed to advance. Note that the check box applies to all events in your
tournament.
The St. dev. threshold value controls whether a player is considered to be unrated. If a player’s standard deviation is at least this value, then Zermelo considers
the player to be unrated. This is for all purposes, i.e., event eligibility, seeding,
entry fees for unrated players, and unrateds advancing. You can set the threshold
field to blank to turn this feature off, in which case only players who don’t have a
rating are unrated.
Zermelo calculates ratings and standard deviations of doubles teams as follows. If either player doesn’t have a rating, then the team doesn’t have a rating.
Otherwise, the team’s rating is the average of the two players’ ratings. If either
player doesn’t have a rating or standard deviation, then the team doesn’t have a
standard deviation. If both players have ratings and standard deviations, then let
σ1 and σ2 be the standard deviations of the players. Then the standard deviation
of the team is
1
(σ12
2

+ σ22 )1/2 .

Note that this is less than max(σ1 , σ2 ), so if the st. dev. threshold applies to the
team, it must also apply to one of the players. But, the threshold could apply to
one of the players without applying to the team.
Ratings Central is the only organization that provides standard deviations for
players’ ratings.
1.7. Unrated Prior. The Unrated prior fields are only relevant for Ratings Central tournaments. They let you specify the mean and standard deviation of the playing strength of unrated players in the tournament. If you are submitting the tournament to Ratings Central, you must set these fields. See Chapter 13 on page 129
for advice on what values to use.
1.8. Ratings Central Director. The Ratings Central Director box is only relevant for Ratings Central tournaments. Enter the Ratings Central ID of the director
for the event in the Director ID field. To get a director ID, you must register on the
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Ratings Central website. Your director ID is not the same as your player ID (if you
have one). Once you’ve submitted the tournament, you can’t change the director
ID for the tournament. If you submit the tournament using the wrong director ID,
see Section 2.3.1 on page 47 for how to fix it.
Enter your director password in the Password field. You select your password
on the Ratings Central website. Since this is a password, Zermelo will display
asterisks in this field rather than the characters you type. The password is case
sensitive.
Select the sport that corresponds to your director ID in the Sport field. If you
want to submit events for more than one sport, you will need a director ID for each
sport.
1.8.1. Director ID Policies. Director IDs are assigned to people, not to clubs,
organizations, or groups. This is because we need to know whom to contact if there
is a question or a problem. Each person who submits tournaments or events must
have their own director ID and is responsible for the tournaments and events that
they submit and for the database files for those tournaments and events, including
backing up the database files (see Section 2.4 on page 19) and preserving them
indefinitely in case changes to tournaments or events are needed.
Do not share your director ID with anyone else. You may have someone assist
you, but you are still responsible for the tournaments and events submitted using
your director ID.
You may transfer your director ID to another person by giving the other person
the database files and updating the information for the director ID on the Ratings
Central website to be that of the other person. There are a couple of ways you
can do this: One way is to change the information on the website to the other person, change the password to a temporary one, give the other person the temporary
password, and have the other person set their own password. The other way is
to change the password to a temporary one, give the other person the temporary
password, and have the other person set their own password and change the information to them. In both cases, you need to give your database files to the other
person.
Note that this system makes it simple for a club to effectively have a director
ID. All the club has to do is pick a responsible person, who registers as the director.
When that person no longer wishes to be the responsible person, the club picks a
new responsible person, and the first person transfers the director ID to the second
person.
If you are no longer able to be responsible for the tournaments or events
that you submitted, do not simply disappear. It is best to find someone else
to transfer your director ID to. But, if you cannot do that, contact us; see
https://www.ratingscentral.com/Problems.php for our email address.
If you want to delete your director ID, contact us. However, we cannot delete
a director ID if there are tournaments or events that were submitted using that
ID. (You can search for your events on the website by entering your director ID in
the “Director ID number” field on the “Events” tab.) If you want to delete an event
that you submitted using Cantor, see the Cantor User’s Manual for how to do it.
(Are you sure that you want to delete the event? Players may wish to see their
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old results.) If you used Zermelo to submit a tournament, it isn’t practical to use
Zermelo to delete it. If you need assistance deleting tournaments or events, contact
us. Rather than deleting tournaments or events, it may be better to transfer your
director ID to another person.
1.8.2. Old Version Password Compatibility. Versions of Zermelo before version
21 only accept passwords that are at most twenty ISO 8859-1 (Latin 1) characters.
If you have a tournament that used such a version and you need to resubmit the
tournament and your current password does not satisfy the twenty ISO 8859-1
character limitation, you have two choices: You can change your password on the
website to satisfy the limitation (and maybe change it back when you are done) or
you can enter a “short password” on the website. If you enter a short password, it
will be used with Zermelo versions before 21 and Cantor versions before 10; your
regular password will be used with other (more recent) versions. In all cases, your
regular password will be used to log in to the website.
1.9. List Database Folder. The rating-list database file RatingList.nx1 and the
club database file Club.nx1 contain the same information that is in whatever rating
and club lists you’ve imported. Since the rating-list database file can be rather large
and there is no need to back up either of the list database files, you may wish to
keep them in a folder other than the database folder, thus making it simpler to
back up the database files that you do need to back up whenever you use Zermelo.
You can use the same list-database folder for both Zermelo and Cantor (or two or
more instances of either of them), but if you do so, you can only have one app
running at a time.
Enter the folder you wish to use in the List database folder field. Leave the
field blank to use the database folder as the list database folder. You can enter the
name of a folder that doesn’t exist and Zermelo will create it. You can click the
button to the right of the field to browse to the folder you want.
If you have already imported a list, changing the list database folder will not
move the list database files. You will either have to move them yourself or import
the lists again. If you wish to move them yourself, do it when Zermelo is not
running.
1.10. Club. The Club box is only relevant for Ratings Central tournaments. It
shows the Ratings Central club that is sponsoring the tournament. A tournament
doesn’t have to have a sponsoring club.
Zermelo won’t let you type the name of a club in the club field. To set or
change the club, click on the Change button to bring up the club browser. The club
browser is described in Chapter 11 on page 125. The Change button will only be
enabled if you have imported a club list (see Section 1 on page 49). To clear the
club, click the Clear button.
2. Display Statistics
The Display Statistics menu item brings up a window (Figure 2 on the following
page) that shows counts of events, players, and entries, and also shows totals of
various fees.
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Figure 2. Display-statistics window

2.1. Counts. The top grid shows counts of events, players, and entries for
singles, doubles, and both singles and doubles. An entry is a player or team entered
in one event. In the figure, we see that there is one doubles event, one singles
event, two players, each player is entered in the singles event, and the two players
are entered as a team in the doubles event.
You can get a rough idea of how long a tournament will last by considering
the number of entries. In a single elimination event, if there are N entries in the
event, then there will be N − 1 matches. A best-of-five match takes about twentyone minutes, a best-of-seven about thirty minutes. So, for example, if you had 10
events, 190 total entries, and 6 tables, you’d need (190 − 10) × 21
÷ 6 = 101/2 hours
60
to play all the matches. Actually, even if you keep the tables full most of the time,
you’ll need another hour or so at the end of the day to play the last few matches
(since you can’t keep the tables full at that time). Of course, if your tournament is
more than one day, then you need to count the matches for each day. Also, this all
assumes that you have enough players so that you can keep the tables full. If not,
then the tournament will take longer.
If your events are round robin rather than single elimination, there will be more
matches. If you have a round-robin group of size G, it has 12 G(G − 1) matches.
Formulas for two-stage events consisting of round-robin groups with one or two
players advancing are more complicated because the number of entries may not be
a multiple of the group size. It is simplest to approximate: If the group size is G
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Figure 3. Print-table-numbers window
and there are N entries, then there are approximately N/G groups. Each of these
has 12 G(G − 1) matches for a total of 12 N(G − 1) matches. If you have A players or
teams advancing from each group, then the second stage will have AN/G entries.
If the second stage is single elimination, this is another AN/G − 1 matches. If the
second stage is round robin, this is another 21 (AN/G)(AN/G − 1) matches.
The “Entries” column in the ::Events > Modify grid shows the number of entries
in each event. The “Remaining” column shows the number of matches in the event
that have not been completed. The “Remaining” pane in the main-window status
bar shows the number of matches in the tournament that have not been completed.

2.2. Fees. The bottom grid shows total fees in various categories. Each value
is the total for all the players.
The “Event and registration” value is the sum of event fees and registration
fees (from ::Tournament > Modify > Registration fee). The “Adjustments” value is
the sum of the ::Players > Modify > Edit > Fees > Adjustment values. Note that
neither of these values is affected by whether the Autocalc check box is checked.
So, if you manually set how much a player owes by unchecking the Autocalc check
box, your change will not be reflected in the totals.
USATT-affiliated clubs get to keep 10% of any USATT memberships (not including lifetime memberships and tournaments passes) that they sell. The “USATT
share of membership” value is how much you owe to USATT for USATT memberships that you sold, and the “Club share of memberships” value is your commission
that you get to keep.
Note that if you use the cash-box system described in Section 4.4.1 on page 95
and don’t update the USATT membership > Bought fields once the tournament
starts, then the “USATT share of membership” and “Club share of memberships”
values displayed in this window won’t be correct.
3. Print Table Numbers
The Print Table Numbers menu item brings up a window (Figure 3) that lets you
print table numbers for taping to the sides of the tables. If you only put numbers
on one side of the tables, be sure it is the side that you can see from the control
desk.
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4. Write USATT Report
The Write USATT Report menu item is only relevant for USATT tournaments.
The menu item will be disabled until all the events that count for USATT ratings
have finished.
When you select the menu item, Zermelo generates two files. One file contains
the list of players that played in a rated event or bought a membership. The other
file contains the match results. You should send both files to USATT for processing.
USATT uses the players file to determine which players bought (or renewed) a
USATT membership or tournament pass and to update its membership database
with information about the players. You should be sure to update the USATT membership > Bought field for all players. Besides information on which membership or
pass a player bought or whether the player is foreign exempt (i.e., is exempt from
the membership requirement because they are a member of a foreign national association), the file also contains the values from the player fields IDs > USATT ,
Name, Address 1, Address 2, City, State, Postal code, Sex, Birth, Email, and Phone.
To simplify USATT’s processing of your tournament, you should be sure to enter
values into these fields for players who buy memberships or passes or are foreign
exempt. USATT may also use the values in these fields to update its database for
other players. For players who are foreign exempt, you should edit the players file
to add the “Citizenship” and “RepresentingCountry” values before submitting it to
USATT.
Zermelo writes the two files to the database folder. The name of each file is the
date of the tournament concatenated with the tournament name concatenated with
Zermelo’s name and version concatenated with a suffix. The suffix for the players
file is “Players". The suffix for the match-results file is “Results”. The filename
extension of both files is .csv.
5. Export Finalists
The Export Finalists menu item writes a list of the finalists in each event to a file
in CSV format. This file might be useful if you want a list of winners to submit to a
magazine or post on your website. You can open the file in Excel, Word, Notepad,
etc. The menu item will be disabled until at least one event is finished.
Only finished events are listed in the file. The line for an event contains the
event ID, event name, winner’s name, and runner-up’s name. If the final is a roundrobin group, then all the players in the group will be listed in order of finish.
The order of finish for both single elimination and round robin finals takes into
account whether the Unrateds advance check box (in ::Tournament > Modify >
Unrated players) is checked. If it is not checked and the event is rating-limited (i.e.,
only players or teams whose rating is less than some value can enter), then unrated
players or teams are considered to have finished after rated ones.
6. Create New
The Create New menu item brings up a window (Figure 4 on the next page)
that makes it simple to create a fresh set of database files so that you can run a
new tournament. After explaining how to use this window, I’ll explain how to do
the same thing manually so you can understand what is happening.

6. CREATE NEW

61

Figure 4. Create-new-tournament window

In the Database folder field, enter the folder where you want to put the database files for the new tournament. You can enter the name of a folder that doesn’t
exist (Zermelo will create it). If you choose an existing folder, then be sure that the
folder does not contain the database files for an existing tournament. If it does,
then you will end up accessing those files rather than creating a new set. You can
click the button to the right of the field to browse to the folder you want. The
button at the top of the folder browser lets you create a new folder. Generally,
you will want to create a new folder in which to put the database files for the new
tournament rather than selecting an existing folder.
In the Icon caption field, enter the caption that you want to appear under the
desktop icon. It is a good idea to use a caption that clearly identifies the tournament.
Click the OK button. Now, exit Zermelo. You will find a new icon on your
desktop with the caption you specified. Double-click it to start Zermelo. You will
now have a fresh set of database files in the database folder you selected and you
can continue to use Zermelo and set up your new tournament.
To delete a tournament, first exit Zermelo. Then, use Windows Explorer to
delete the database folder. Finally, right-click the Zermelo icon for the tournament
on the desktop and select Delete.
6.1. Explanation. A folder can only contain the database files for one tournament. Since you will want to use Zermelo with more than one tournament, there
must be a way to tell Zermelo which folder contains the database files it should
use. There are two ways to tell Zermelo where the database folder is: setting the
current folder and using a command-line parameter.
Whenever Windows starts an application, it designates one folder as the current folder. When you start Zermelo, it looks for the database files in the current
folder. For example, if you double-click on a file with an “exe” extension, then the
current folder will be the folder containing the “exe” file. If you double-click on
a Windows shortcut (e.g., an item on the desktop that has a little arrow on the
bottom left or an item in the “Start” menu), then the current folder is determined
by the shortcut. To see or change the current folder that the shortcut is using,
right-click the shortcut and select Properties. The current folder is the folder listed
in the Start in field.
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You may also specify the database folder via a command-line parameter. You
can do this by typing it in a command prompt or bat file or including it in the Target
field in a shortcut’s properties. A command-line parameter takes precedence over
the current folder. You can use the special command-line parameter “appdata” to
have Zermelo put the database folder in a subfolder of your application data folder,
e.g., C:\Users\YourUserName\AppData\Roaming\RatingsCentral\Zermelo\29.
Zermelo’s installation program puts the “appdata” command-line parameter in
the shortcuts on the desktop and in the “Start” menu. So, you can move the database files to any folder you wish as long as you update the shortcuts by removing
“appdata” from the Target field and setting the Start in field to the new folder.
When Zermelo starts, if it doesn’t find a set of database files in the database
folder, it creates a new set. So, one way to create a new set of database files is
to move the database files out of the database folder and then start Zermelo. A
better way is to create another folder, make a copy of Zermelo’s shortcut, remove
“appdata” from the Target field of the shortcut, and set the Start in field of the
new shortcut to point to the new folder.
Rather than copying an existing shortcut, you can create a shortcut from
scratch by right-clicking the desktop and selecting New > Shortcut. This starts
the Windows “Create Shortcut” wizard. For the “location of the item” (on the first
page of the wizard), enter the path and filename of the Zermelo.exe file, e.g.,
C:\Program Files (x86)\RatingsCentral\Zermelo\29\Zermelo.exe. Click the Next
button to go to the second page of the wizard. For the name of the shortcut,
enter the text that you want to appear as the caption under the desktop icon. Click
the Finish button. Right-click the shortcut that you just created on the desktop
and select Properties. Change the Start in folder to the folder where you want to
put the files for the tournament. The ::Tournament > Create New menu item does
exactly the same thing, but saves you the bother of doing it manually.
Note that items in the “Start” menu are just shortcuts. If you don’t change
the shortcut in the “Start” menu that Zermelo’s installation program creates, it will
always point to the original database folder.
Shortcuts don’t have to be placed on the desktop. You can create shortcuts
in any folder or move shortcuts to or from folders, the desktop, and the “Start”
menu. Once you’ve run a tournament, you may wish to move the shortcut for the
tournament to a folder of past tournaments. Or, you could put the shortcut for a
tournament in the same folder as the database files for the tournament.
If you are comfortable with the Windows Command Prompt, you should have
no problem starting Zermelo from the Command Prompt or creating a bat file to
start it.
If you are planning to run several tournaments with similar formats, you might
want to save yourself some of the work of setting up Zermelo for each tournament.
The way to do this is to set up the events, and then copy the set of database files
to another folder. Use the copied set of files for the second tournament.

CHAPTER 7

Events Menu
The Events menu contains items that let you browse and add events, set event
parameters, and make the draw.
1. Modify
The Modify menu item brings up a tabbed-notebook window (Figure 1) that lets
you browse and add events and set the event parameters. This menu item will be
disabled until you set the tournament start date in ::Tournament > Modify > Start
date.
1.1. Browse. The first page of the notebook (the Browse page) contains a grid
listing the events along with various parameters for each event. Like Zermelo’s

Figure 1. Modify-events window
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other grids, you can resize a column by dragging an edge of the column header,
and you can rearrange the order of the columns by dragging a column header with
the mouse. The event grid is always sorted by the “ID” column.
Most of the columns display information that you set on the Edit notebook
page. As for the others, “Entries” shows the number of entries (i.e., players for
singles events, teams for doubles events) that are entered in the event, “Full” shows
whether the event has room for more players (or teams), “Finished” shows whether
all matches in the event have been completed, “Remaining” shows the number of
matches in the event that have not been completed, “Playing or Played” shows the
number of matches that have been played plus those that are currently playing
(not including matches for which a default card has been printed), “Defaults Out”
shows the number of default cards that are outstanding for matches in the event,
and “Modified” shows whether the draw sheet has been modified since the last
time all modified draw sheets were printed for posting. Zermelo tries to keep track
of which stage of a two-stage event has been modified. For one-stage events, the
“Modified” column will display either “Unmodified” or “Modified”. For two-stage
events, the column will display either “Unmodified”, “First Stage”, “Second Stage”,
or “Both Stages”.
The Add Event button switches to the Edit page to let you add a new event
to the tournament. The Edit button switches to the Edit page for the currently
selected event; you can also click the Edit notebook tab or double-click the row of
the event. The Close button closes the window.
Press ⟨Ctrl+Del⟩ to delete the event that is highlighted. The grid must have
the focus for you to delete an event. Zermelo will not let you delete an event if
any matches in the event have been played or called. You can tell whether you can
delete the highlighted event by whether the words “Ctrl+Del: Delete Event” just
below the grid are dimmed or not.

1.2. Edit. Figure 2 on the next page shows the Edit notebook page. Any
changes you make are not saved to the database files until you save them. One
way to save your changes is to click the Save button. If you click the Browse notebook tab, Zermelo will save your changes just as if you clicked the Save button.
In the bottom left of the window there is a navigator bar with four buttons. This
lets you move to a different event without first going back to the Browse page. The
left navigator button moves to the first event (order of events is determined by
event ID number), while the right navigator button moves to the last event. The
middle-left button moves to the event before the current one, while the middleright button moves to the event after the current one. If you navigate to a different
event, Zermelo first saves any changes you have made to the current event. If you
do not want to save your changes, you can click the Cancel button.
1.2.1. ID, Name, and Autoname. The ID field specifies the event ID Number.
You can use any number from 1 to 99 (so you can have at most 99 events). You
should use numbers that will be easy to remember, e.g., make the “Under 2000
Event” event number 20. The Name field specifies the event name that Zermelo
prints on draw sheets and match cards. If Autoname is checked, Zermelo will
construct a suitable name for the event based on the eligibility criteria that you
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Figure 2. Edit-event page
select. If you do not like the name Zermelo constructs, uncheck Autoname and set
the name you want.
1.2.2. Event Format. The Event format can be “SE” (single elimination), “RR” (a
single round-robin group), “RR to SE”, or “RR to RR”. The two latter formats are
similar in that both have one or more round-robin groups with one or two players
from each group advancing to a second stage. The difference is that in the “RR to
SE” format, the second stage is single elimination, while in the “RR to RR” format,
the second stage is a single round-robin group. (See Appendix D on page 147 for
suggestions on how to use Zermelo with other event formats.)
Zermelo can handle up to 256 players (or teams) in an “SE” format event and
up to 12 players (or teams) in a “RR” format event. These limits also apply to each
group or single-elimination bracket in the “RR to SE” and “RR to RR” formats. For
example, in a “RR to RR” format with two players advancing from each group, you
can have at most 6 first-stage round-robin groups because the second stage can
only hold 12 players.
Zermelo will not let you select an event format that cannot handle the number
of players that you have already entered into the event. To change to such a format,
remove some players from the event, then change the event format.
1.2.3. Schedule. The Start day and Start time fields specify the starting time
for the event. The start day is a number from one to however many days there are
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in the tournament (as specified by ::Tournament > Days). Start day 1 corresponds
to ::Tournament > Start date, start day 2 is the next day, etc. You can click the
button at the right of the Start time field to drop down a time-picker (basically a
clock) with which you can set the time.
The starting time of the event is used primarily by Matches > Call and
Matches > Call Some to determine which events to search and when to draw events
that have their Draw value set to “Auto”. The starting time (along with the value
of ::Tournament > Default times > Not here) also affects when Zermelo will print
a default card for a match involving a player who has not checked in. (However,
if ::Matches > Modify Calling > Manage match calling is unchecked, then Zermelo
will ignore the starting time when calling matches; see Section 8.1 on page 119.)
See Section 8.4 on page 121 and Section 1 on page 151 for a discussion of what
event starting times work well.
1.2.4. Eligibility. The fields in the Eligibility box let you control which players
can enter the event. If the Rating cutoff field is not blank, then only players whose
rating is less than the value you set can enter the event. This field only controls
eligibility for rated players, so if you don’t want rated players to be eligible, you can
set the value to either 1 or 0. The Unrateds can enter check box controls whether
unrated players are allowed to enter the event.
The Age cutoff field is for junior or senior events. If the value is 27 or less,
then only players whose age is less than the value can enter the event. If the value
is more than 27, then only players who are at least as old as the value can enter
the event. Ages for players are as of the first day of the tournament.
The Sex field controls what sex players must be to enter the event. The choices
are “Any”, “Men”, “Women”, and “Mixed”. The last one is only for doubles events.
1.2.5. Doubles. If the event is a doubles event, check the Event is doubles check
box. The Team-rating cutoff field is similar to the Eligibility > Rating cutoff field,
but applies to the sum of the ratings of the two players. For a doubles event, you
can have a rating cutoff, a team-rating cutoff, both, or neither. The team-rating
cutoff only applies to teams where both players have ratings. I.e., if either player is
unrated, then the team is considered to be unrated, and eligibility for the event is
controlled by the Unrateds can enter check box and, if one of the players is rated,
the individual rating cutoff.
1.2.6. Counts for Ratings. The Ratings Central check box is only relevant for
a Ratings Central tournament. Check the check box if the event counts towards
a player’s Ratings Central rating. If the box is checked, matches in the event will
be submitted to Ratings Central. If you are not submitting your tournament to
Ratings Central, it doesn’t matter whether the box is checked.
One of the requirements for submitting a tournament to Ratings Central is
that you submit all matches that are part of the tournament, not just some of
them. However, if you wish to run an unrated novice event or some sort of “fun”
event as part of your tournament, it is acceptable to submit the tournament and
not submit the novice or “fun” event.
Check the USATT check box if the event counts towards a player’s USATT rating. This check box controls whether matches in the event will be written to the
tournament report file when you do ::Tournament > Write USATT Report. If the
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tournament is not USATT-sanctioned, then it doesn’t matter whether this box is
checked.
Note that you should never submit a handicap event (i.e., an event where the
weaker player is spotted points) for ratings. If you let Zermelo calculate the handicap by setting the Match format field to one of the handicap formats, Zermelo
will uncheck the check boxes. If you run your handicap event some other way, you
need to uncheck the check boxes yourself.
1.2.7. Draw. The Draw field determines when and if Zermelo makes the draw
for the event. The possible values are “No”, “Yes”, “Auto”, and “Drawn”. If the
value is “No”, then Zermelo will not make the draw. If the value is “Yes”, then
Zermelo will make the draw when you do ::Events > Draw. If the value is “Auto”,
then Zermelo will make the draw when you do ::Matches > Call, but only if the
starting time for the event has arrived. Zermelo will set the value of the field to
“Drawn” after making the draw.
The algorithm that Zermelo uses to make the draw is described in Section 2
on page 72. One feature of this algorithm is that Zermelo tries to put players from
the same draw club in different sections of a single-elimination draw so they won’t
meet until the later rounds. If you don’t want Zermelo to do this for this event,
uncheck the Separate club members check box (e.g., I sometimes uncheck it for the
Open Singles event). Note that Zermelo also tries to avoid having two members of
the same draw club play each other in the first round; Zermelo does this regardless
of the setting of the Separate club members check box.
Another feature of Zermelo’s draw algorithm is that byes are placed randomly.
Placing byes randomly is fairer (see Section 2 on page 72 and Appendix F on
page 159). However, if you prefer to give byes to players in order of their seeding, uncheck the Place byes randomly check box.
If the event is drawn, Zermelo will not let you change the Event format, Event
is doubles, Separate club members, and RR groups > Players that advance fields.
If, for any reason, you want to get rid of a draw you made, simply change the
value of the Draw field to “No”, “Yes”, or “Auto”. Zermelo won’t let you do this if
any matches in the event have been played or are playing. In this case, undo the
matches (via ::Matches > Undo One), and then change the value of Draw.
There are at least two approaches to when to make the draw at a tournament.
One approach is to make the draw the night before or first thing in the morning. An
advantage of this approach is that you can post the draw sheets so the players can
see the draw when they arrive and can check that they are entered in the correct
events. However, this makes it harder if you need to add or scratch players from
an event before the event starts. Another approach is to wait to make each draw
until the starting time of the event. This makes it easier to add or scratch players,
but the players won’t see the draw until the event is starting. In this case, you may
wish to post lists of the players entered in each event so the players can check that
they are entered in the correct events and see which other players are entered. You
can generate these lists via ::Players > Print Lists. Regardless, you will want to tell
each player which events they are entered in when they register; this helps to catch
errors (both yours and the players’).
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Group sizes
Players in event u = 0 u = 1, o = 0 u = 1, o = 1 u = 1, o = 2
4
4
4
4
4
5
5
5
5
5
6
6
3,3
3,3
6
7
7
4,3
4,3
4,3
8
4,4
4,4
4,4
4,4
9
5,4
3,3,3
5,4
5,4
10
5,5
4,3,3
5,5
5,5
11
6,5
4,4,3
4,4,3
6,5
12
4,4,4
4,4,4
4,4,4
4,4,4
Table 1. Group sizes for desired group size of four and various
maximum underflows (u) and maximum overflows (o)

For doubles, you will probably want to set the Draw field to “No” and then set
it to “Yes” after you enter the doubles teams (via ::Players > Enter Doubles).
1.2.8. RR Groups. The RR groups fields only affect events with two-stage formats, i.e., “RR to SE” and “RR to RR”. The Desired size field is how many players
(or teams) you want in each of the first-stage round-robin groups. You can set any
value from three to twelve.
The Max underflow and the Desired max overflow when. . . > Drawing fields
control what happens if the number of players is not an exact multiple of the
desired group size. When making the draw, Zermelo will try to set up the groups
so that they are at least as large as the Desired size value while keeping the overflow
(i.e., the excess over the desired size) less than the maximum overflow you set. If
this can’t be done, then Zermelo will use more groups, but not if this would make
any of them underflow by more than the maximum underflow you set. Zermelo will
never exceed the maximum underflow you set (unless there aren’t enough players
in the event), but will, if necessary, exceed the maximum overflow you set.
An example will make this clearer. Suppose Desired size is four, Max underflow
is one, and Desired max overflow when. . . > Drawing is one. Then Zermelo will try
to use groups of size four and five (i.e., an overflow of one). If this is impossible,
then Zermelo will use groups of size four and three (i.e., an underflow of one). If
this is impossible, then Zermelo will use groups that are larger than five. Table 1
shows the group sizes for a desired size of four, a few different values of maximum underflow and overflow, and various number of players in the event. Note
that if the maximum underflow is zero, then it doesn’t matter what the maximum
overflow is.
When you add a player to an event which is already drawn, Zermelo will always
try to put the player in an existing group. As a last resort (e.g., if the group advancers have already played), Zermelo will add a new group (thus creating a group
with just one player). If Zermelo has to add a new group or place a player in a
group that is excessively large, it will pop up a message window to let you know
and write the group size to the log window. You control what “excessively large”
means by setting the Desired max overflow when. . . > Adding value. For example,
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if Desired size is four, and Desired max overflow when. . . > Adding is two, then
Zermelo will only alert you if the group it puts the player into is new or has more
than six players (including the player just added).
The Players that advance field specifies how many players advance from each
group to the second stage. You can set this to be either one or two.
1.2.9. Match Format. The Match format field determines how many games are
needed to win a match and whether the event is a handicap event (i.e., the weaker
player is spotted points). The choices are “2 of 3”, “3 of 5”, “4 of 7”, “5 of 9”, “2/3
then 3/5”, “2/3 then 4/7”, “2/3 then 5/9”, “3/5 then 4/7”, “3/5 then 5/9”, “4/7
then 5/9”, “Handicap to 31”, “Handicap to 41”, “Handicap to 51”.
The six formats containing the word “then” mean that early rounds are the
first format and later rounds are the second format. The Second format start field
determines in which round the second format starts. Choices are “Final”, “Semis”,
“Quarters”, “1/8-ths”, “1/16-ths”, “1/32-nds”, “1/64-ths”, and “1/128-ths”. If the
event format is “RR to RR”, then the first match format is used for the first-stage
round-robin groups while the second match format is used for the final roundrobin group.
Except for the three handicap formats, games are always to 11. For the handicap formats, the match is a single game, but there are three handicap formats so
you can choose 31, 41, or 51 points for the number of points needed to win the
game.
Zermelo prints the appropriate number of score boxes on match cards, so you
and the players can tell how many games are in the match. If the match is a
handicap match, Zermelo will also print on the match card the number of points
that are needed to win the game and the number of handicap points that the higherrated player must spot the lower-rated player (i.e., the weaker player starts with the
specified number of handicap points). Zermelo also prints the number of handicap
points on the draw sheet (for each unplayed match). Table 2 on the following page,
Table 3 on the next page, and Table 4 on page 71 are the handicap charts that
Zermelo uses.
1.2.10. Search. The Stages field controls whether the stages in the event are
searched for matches to call when you do ::Matches > Call or ::Matches > Call
Some. The possible values are “None”, “First”, “Second”, and “All”. The “None”
value means that the event is not searched. The “All” value means all of the event
is searched. The “First” and “Second” values only apply to events that have a
two-stage format. For such an event, “First” means to only search the preliminarystage round-robin groups. The “Second” value means to only search the final stage
(which may be a round-robin group or a single-elimination bracket, depending on
the value of Event format).
It is best to let Zermelo call matches. However, if you really don’t want to, this
field lets you control which event stages Zermelo will call. If you use a value other
than “All”, you will need to use ::Matches > Call Stages to get match cards for the
event stages that you have excluded from the normal search.
The Order field controls the order in which Zermelo searches the events for
matches to call when you do ::Matches > Call or ::Matches > Call Some. Zermelo
first searches the events with Order equal to “1st”, second it searches the events
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Rating difference Handicap Rating difference
0–6
0
295–333
7–19
1
334–378
20–32
2
379–428
33–47
3
429–486
48–61
4
487–552
62–77
5
553–629
78–94
6
630–719
95–112
7
720–825
113–131
8
826–951
132–152
9
952–1105
153–175
10
1106–1296
176–200
11
1297–1543
201–228
12
1544–1876
229–259
13
1877–2364
260–294
14
≥ 2365
Table 2. Handicap chart to 31

Handicap
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29

Rating difference Handicap Rating difference
0–4
0
305–334
5–14
1
335–367
15–24
2
368–403
25–34
3
404–443
35–45
4
444–488
46–56
5
489–537
57–68
6
538–592
69–80
7
593–653
81–93
8
654–722
94–106
9
723–801
107–120
10
802–890
121–135
11
891–993
136–151
12
994–1113
152–168
13
1114–1253
169–187
14
1254–1422
188–206
15
1423–1630
207–228
16
1631–1893
229–251
17
1894–2244
252–276
18
2245–2751
277–304
19
≥ 2752
Table 3. Handicap chart to 41

Handicap
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39

with Order equal to “2nd”, third it searches the events with Order equal to “3rd”,
. . . , ninety-ninth it searches the events with Order equal to “99th”.
Normally, if several events have the same value for Order, Zermelo searches
those events as follows. First, Zermelo searches doubles events, then singles
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Rating difference Handicap Rating difference
0–3
0
311–334
4–11
1
335–360
12–19
2
361–389
20–27
3
390–419
28–36
4
420–452
37–44
5
453–488
45–53
6
489–528
54–62
7
529–570
63–72
8
571–617
73–82
9
618–668
83–92
10
669–725
93–103
11
726–787
104–114
12
788–856
115–126
13
857–933
127–138
14
934–1019
139–151
15
1020–1117
152–164
16
1118–1229
165–179
17
1230–1357
180–194
18
1358–1508
195–210
19
1509–1686
211–228
20
1687–1904
229–246
21
1905–2177
247–266
22
2178–2539
267–287
23
2540–3057
288–310
24
≥ 3058
Table 4. Handicap chart to 51
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Handicap
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48
49

events. For each type of event (i.e., doubles or singles), Zermelo searches any unrated events, then any handicap events, then any open events, then any junior
events from high age to low, then any senior events from low age to high, then
any rating events from high rating to low. (If two events have the same values for
these criteria, Zermelo searches them in order of Event ID.) However, if ::Matches >
Modify Calling > Manage match calling is unchecked, then if several events have
the same value for Order, Zermelo searches those events in order of event ID.
You can probably just leave the Order field for all events set to “50th” and
rely on Zermelo’s default search order. The reason Zermelo sets the Order field to
“50th” when you add an event is to make it easy to bump an event either forward
or backward in the search order without having to change all the events.
Searching rating events from high to low helps free up more matches that can
be played at the same time by knocking the lower-rated players out of the higherrated events. The tournament will probably run in a more orderly fashion if you
start the events in a similar order. See Section 8.4 on page 121 and Section 1 on
page 151 for more discussion of what event starting times work well.
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The values in ::Matches > Modify Calling also affect the search order. See Section 8 on page 118.
1.2.11. Fees. The Regular fee is how much a player is charged to enter the
event.
If you want unrated players to be charged a different amount, enter the amount
in the Unrated players field. If you leave the latter field blank, then unrated players
will be charged the same amount as rated players.
If you want juniors to be charged a different amount, enter the amount in
Juniors > Fee. In this case, you also need to specify the Age cutoff . Players will get
the junior rate if they are younger than the age cutoff.
If you want low-rated players to be charged a different amount, enter the
amount in the Low-rated players > Fee field, and enter the rating threshold in the
Low-rated players > Rating cutoff field. Players have to be rated and have a rating
less than the cutoff to get the low-rated rate.
Note that the unrated-players standard-deviation threshold (::Tournament >
Modify > Unrated players > St. dev. threshold) affects whether a player is unrated.
If the player’s standard deviation is such that Zermelo considers the player to be
unrated, then the player qualifies for the unrated-players fee, not the low-rated fee
(regardless of their rating). In other words, a player is either unrated or low-rated,
never both.
If the event is doubles, all fees are per player, not per team.

2. Draw
The Draw menu item makes the draw for every event that has the Draw field
set to “Yes”.
The ITTF rules for single-elimination draws may be briefly described as follows:
• Place the first two seeds in different halves, then randomly place the next
two seeds in empty quarters, then randomly place the next four seeds in
empty eighths, etc., until all seeds are placed.
• If byes are needed, give them to the top seeds in order.
• Randomly place the unseeded players.
• When placing players, place players from the same association in different
sections of the draw.
The ITTF rules do not specify the number of seeds.
Another common draw procedure places the players deterministically in order
of seeding: Place players 1 and 2 at the top and bottom of the draw. Place player
3 in the same half as player 2. Place player 4 in the same half as player 1. Place
player 5 in the same quarter as player 4. Continue in this way until all players are
placed. Figure 3 on the facing page shows an example.
The article “What is the correct way to seed a knockout tournament?” by
Allen J. Schwenk, The American Mathematical Monthly, vol. 107, no. 2, Feb. 2000,
pp. 140–150, considers two desirable properties of a draw procedure:
Delayed Confrontation. Two players rated among the top 2j shall never
meet until the field has been reduced to 2j or fewer players.
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Figure 3. Deterministic draw

Sincerity Rewarded. A higher-seeded player should never be penalized by
being given a schedule more difficult than that of any lower seed.
Schwenk then proves that the deterministic draw procedure (perhaps surprisingly) violates the Sincerity Rewarded property. (The ITTF procedure violates Delayed Confrontation unless all players are seeded and violates Sincerity Rewarded
if there are any byes; see Appendix F on page 159 for an example demonstrating
the latter.) He then shows that both properties are satisfied by cohort randomized
seeding, which works as follows:
• Seed all the players.
• Place the first two seeds in different halves, then randomly place the next
two seeds in empty quarters, then randomly place the next four seeds in
empty eighths, etc., until all seeds are placed.
• Put byes in any remaining spaces.
This is similar to the ITTF procedure with all players seeded, except that byes are
placed randomly at the end.
By the way, Schwenk also considers a third property. However, this third property is less intuitive than the first two and his proof that cohort randomized seeding has the property is flawed. It appears that he added the third property in an
attempt to have the three properties determine a unique procedure.
Zermelo basically uses cohort randomized seeding, with the following modifications:
• Zermelo tries to place players from the same draw club in different sections of the draw.
• Zermelo tries to avoid having
– Two unrated players play each other in the first round
– Two players from the same draw club play each other in the first
round
– Two players play each other in the first round in two events
You can modify how Zermelo makes the draw using the Separate club members
and Place byes randomly check boxes (see Section 1.2.7 on page 67).
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Note that the unrated-players standard-deviation threshold (::Tournament >
Modify > Unrated players > St. dev. threshold) affects whether a player is unrated.
Unrated players are not seeded.
If the event is a handicap event, then Zermelo treats all players as having the
same rating, i.e., no one is seeded.
If the event format is a two-stage format, then the cohort size is the number of first-stage round-robin groups. For example, suppose there are ten groups.
Then the top ten seeds are placed one to each group. Then the next ten seeds
are distributed randomly, one to a group, while trying to separate draw clubs and
avoiding having unrated players play each other or players play each other in the
first round of multiple events.
2.1. Manual Draws. If you would like to make the draw yourself and enter it
into Zermelo, there is good news and bad news. The bad news is that Zermelo
doesn’t have any facility designed for this purpose. The good news is that you can
do it by entering all the players into the event, having Zermelo make the draw, then
moving the players to where you want them by using ::Draw Sheets > Swap Slots.
This isn’t as hard as it sounds, but it certainly isn’t as easy as letting Zermelo make
the draw.

CHAPTER 8

Players Menu
The Players menu contains items that let you add and modify players, add and
remove players from events, check players in or out, print player lists, and export
player information.
1. Modify
The Modify menu item brings up a tabbed-notebook window (Figure 1) that lets
you add and modify players, add and remove players from singles events, remove
players from doubles events, and access the rating list. This menu item will be
disabled until you have set up the tournament via ::Tournament > Modify.
1.1. Browse. The first page of the notebook (the Browse page) contains a grid
listing the players along with various information about each player. Just like
Zermelo’s other grids, you can resize a column by dragging an edge of the column

Figure 1. Modify-players window
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header, and you can rearrange the order of the columns by dragging a column
header with the mouse. Like many of Zermelo’s grids, you can sort the grid on
a column by clicking the button to the right in the column header. You can only
sort the grid on columns that have the button. The column that is being used for
sorting will show a downward-pointing arrowhead in the button.
Note that while you can sort on the “Status” and “Membership Bought”
columns, the sorting order is not alphabetical, but rather is the order that the
choices appear in the corresponding drop-down lists on the Edit notebook page.
Most of the columns display information that you set or can find on the Edit
notebook page. The only exception is “Matches Playing”, which shows how many
matches the player is currently playing (i.e., how many match cards have been
printed for the player). If the ::Matches > Modify Calling > Manage match calling check box is checked, then normally a player won’t be playing more than one
match, but you can request a match card for a player who is already playing via
::Matches > Call One. Conversely, note that there is no grid column corresponding
to the Owes field.
The Find field lets you search for a specific player. This is an incrementalsearch field, so you can type just the first part of what you are searching for and
the grid will move to the first matching player. The search happens after every
keystroke. The value you type must be the sort of thing that is in the column that
the grid is sorted on, e.g., if you want to search for a player by name, you must sort
the grid by name by clicking on the button in the header of the “Name” column.
The Add Player button switches to the Edit page to let you add a new player to
the tournament. The Edit button switches to the Edit page for the currently selected
player; you can also click the Edit notebook tab or double-click the player’s row.
The Close button closes the window.
Press ⟨Ctrl+Del⟩ to delete the player that is highlighted. The grid must have
the focus for you to delete a player. Zermelo will not let you delete a player who
has played or is playing a match. If you try to delete such a player, Zermelo will
pop up a message informing you that you can’t. Once you submit the tournament
to Ratings Central, Zermelo will not let you delete any players.
The Rating List button brings up the rating-list browser. See Section 1.3 on
page 85 for more information on the rating-list browser.
1.2. Edit. Figure 2 on the next page shows the Edit notebook page. This notebook page handles navigation and saving very similarly to the ::Events > Modify >
Edit notebook page (see Section 1.2 on page 64). The only difference is that the
navigator bar uses the sort order that you selected in the grid on the Browse page.
Several of the fields on the Edit page are only relevant for Ratings Central
tournaments. However, you can export these fields via ::Players > Export, if you
wish to use them for some other purpose.
1.2.1. Name. Enter the player’s name in the Name field with the surname first,
then a comma, then the given names. If the player’s name has a suffix, e.g., “Jr.”,
add that after a comma at the end.
The button to the right of the field brings up the rating-list browser positioned
on the player in the rating list whose name is closest to the name you have in the
Name field. The button will be disabled unless you’ve imported a rating list. The
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Figure 2. Edit-player page
shortcut key for the button is ⟨Ctrl+N⟩. This shortcut key also works from the
Browse page of the notebook. See Section 1.3 on page 85 for more information on
the rating-list browser.
Never do the following sequence of actions:
(1) Add a player leaving the IDs > Ratings Central field blank.
(2) Submit the tournament to Ratings Central.
(3) Change the player’s name in the Name field to that of a different player
while leaving the IDs > Ratings Central field blank and without checking
the New personal info check box.
(4) Resubmit the tournament to Ratings Central.
If you aren’t sure why you should not do this, see Section 1.2.15 on page 79 for
more information on the New personal info check box, and see the discussion of
how Zermelo and Ratings Central keep track of players without a Ratings Central
ID in Chapter 14 on page 133. If despite this warning you think that you need to
do this, contact us to discuss it; see https://www.ratingscentral.com/Problems.php
for our email address.
1.2.2. Club. The Club box is only relevant for Ratings Central tournaments. It
shows the club that the player is from. A player can be from more than one club,
but Zermelo only lets you set one club for a player. The club you set for the player
in Zermelo will be the player’s primary club. To add a secondary club for the player,
you must go to the Ratings Central website and log in (see Section 1 on page 45).
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A player doesn’t have to belong to a club. If you change an existing player’s primary club (and check the New personal info check box), the player will still be a
secondary member of the old primary club. To remove the player completely from
the club, you must go to the Ratings Central website and log in.
You set or change the player’s club just as you do for the tournament club
(::Tournament > Modify > Club). See Section 1.10 on page 57. If the player’s club
is not set, then when you click the Change button, the club browser will come up
with the tournament club selected. Since most new players are from the club that
is sponsoring the tournament, this makes it easy to set these players’ clubs.
1.2.3. Draw Club. Zermelo tries to separate players from the same draw club
in the draw. Zermelo ignores case when comparing draw clubs. However, except
for case, the clubs must be identical for Zermelo to consider the players as being
from the same draw club. You will probably want to use short abbreviations for
each draw club.
If the first character of the draw club is an exclamation point (“!”), then Zermelo
will make an extra effort to separate players from that draw club in the draw. For
example, if there are several players who are related, you could make up a new
draw club for them (say, using their surname) and put an exclamation point as the
first character. Another use might be if a couple of players are practice partners
who play each other all the time.
If you want Zermelo to use the player’s Ratings Central club as their draw club,
check the Use player’s club check box.
1.2.4. Address. Enter the player’s address in the Address 1 and Address 2
fields. If you only need one line for the player’s address, leave the Address 2
field blank. The address is optional, but is included in the USATT report and submitted to Ratings Central; for Ratings Central, the address helps directors identify
the player.
1.2.5. City. Enter the player’s city in the City field. The city is optional, but is
included in the USATT report and submitted to Ratings Central; for Ratings Central,
the city helps directors identify the player.
1.2.6. State and Province. For the USA and Canada, set the State field to the
state (for the USA) or province (for Canada) that the player is from. For countries
other than the USA or Canada, if the player’s mailing address includes a province,
enter it in the Province field. The province is optional; for Ratings Central, the
province helps identify the player. The State and Province fields will be enabled or
disabled appropriately when you select the country. When you add a new player,
Zermelo initializes the state and province to the state and province of the tournament, since most new players are from the state that the event is in.
1.2.7. Postal Code. Enter the player’s postal code in the Postal code field. The
city is optional, but is included in the USATT report and submitted to Ratings
Central; for Ratings Central, the postal code helps identify the player.
1.2.8. Country. The Country field is only relevant for Ratings Central tournaments. Set this field to the country that the player is from. When you add a new
player, Zermelo initializes the country to the country of the tournament, since most
new players are from the country that the tournament is in.

1. MODIFY

79

1.2.9. Sex. Set the Sex field to the player’s sex. Zermelo uses this field to determine event eligibility for events that have the ::Events > Modify > Edit > Sex field
set to something other than “Any”.
1.2.10. Birth. Set the Birth to the player’s birth date. Use the year-month-day
order that matches your Windows regional settings. Zermelo uses the player’s birth
date to determine eligibility for junior and senior events and to determine if the
player is eligible to buy a USATT junior tournament pass. The player’s birth date
is optional, but is included in the USATT report and submitted to Ratings Central;
for Ratings Central, the birth date helps identify the player.
If a player in the Ratings Central rating list that you download has an ITTF ID,
then the birth date probably came from the ITTF website. But, the ITTF website
only has birth years. So, lacking any other information, Ratings Central set the day
to January 1. If you know the correct day, you may correct the birth date, if you
wish.
1.2.11. Email. Enter the player’s email address in the Email field. Enter only
the email address; don’t include angle brackets or a display name. The email address is optional, but is included in the USATT report and submitted to Ratings
Central.
When you submit a tournament, Ratings Central will send an email to each
player who played in the tournament to let them know that the tournament has
been posted. The email will contain a link to the results on the Ratings Central
website and a link so that the player can unsubscribe from receiving future emails.
Of course, the player will only receive the email if Ratings Central has the player’s
email address. At most one email will be sent to a player for a given tournament.
So, if you resubmit a tournament (to make corrections), players who were in the
first submission will not receive a second email.
1.2.12. Phone. Enter the player’s telephone number in the Phone field. The
telephone number is included in the USATT report, but is not sent to Ratings Central. The format is 999-999-9999. The hyphens are optional.
1.2.13. Age. If you have entered a value in the Birth field, then the Age field
will display the player’s age as of the tournament start date.
1.2.14. Deceased. Check the Deceased check box if the player is deceased (i.e.,
dead, no longer living). Obviously a deceased player cannot be playing table tennis.
However, it would be appropriate to check this box if you are correcting a tournament that you submitted in the past and the player has died since they played the
tournament.
1.2.15. New Personal Info. The New personal info check box is only relevant for
Ratings Central tournaments. Check the New personal info check box if the personal information that Ratings Central has for the player is incorrect or incomplete
and you are updating it.
The New personal info check box only applies to the personal information
fields, i.e., the Name, Club, Address 1, Address 2, City, State, Province, Postal code,
Country, Sex, Birth, Email, Deceased, IDs > USATT , and IDs > TT Australia fields. If
you check the New personal info check box, the values in all these fields will be sent
to Ratings Central and will replace the corresponding information for the player
that Ratings Central has (however, if the player has an ITTF ID, see Section 1.2.16).
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Note that this includes any fields that you clear. For example, if you clear a player’s
Email field and check the New personal info check box, then after you’ve submitted
the event, Ratings Central will not have an email for the player. Also note that if
you check the New personal info check box, you should make sure that all of the
personal information fields for the player have the correct information since all of
them will be sent to Ratings Central.
Do not check the New personal info check box if you only make changes to nonpersonal-information fields such as the Rating, Standard deviation, and Unrated
prior fields, since the check box has nothing to do with these fields.
Generally, you should not check the New personal info check box if you change
the IDs > Ratings Central field. (The most common reason you would change the
IDs > Ratings Central field is if a player has two Ratings Central IDs, an original
one and a duplicate, and you are changing the value in the field to the player’s
original ID.) The Ratings Central ID is not personal information about the player,
but rather identifies who the player is. If you change the IDs > Ratings Central field
and also check the New personal info check box, then this means that you want
Ratings Central to update the personal info for the player who corresponds to the
new ID. This is unlikely to be what you want.
See Chapter 14 on page 133 for more information.
The New personal info check box will be disabled if the player’s IDs > Ratings
Central field is blank and the tournament has not been submitted (since there is
no old info in this case to update). When you submit the tournament, Zermelo will
clear the New personal info check box (since the new info has now been sent to
Ratings Central).
Note that Zermelo only submits a player to Ratings Central if the player has
played at least one match. So, checking the New personal info check box will have
no effect if the player doesn’t play any matches.
1.2.16. ITTF IDs and Personal Info. If a player has an ITTF ID in the Ratings
Central database, then you cannot change the player’s name, country, sex, or birth
year. So, checking the New personal info check box will only affect the other parts
of the player’s personal information. Also, you can’t set or modify the ITTF ID. And,
your updates to the player’s address will only be accepted if you set the country to
the country that the player already has (since you can’t change the country and an
address in a different country wouldn’t make sense). The Ratings Central website
enforces the same restrictions. If you think the personal information that you can’t
change should be changed for some player, contact us.
1.2.17. Fees. Zermelo displays the total fees in the Total field. This is the sum
of the event entry fees for the events the player is entered in, the registration
fee (from ::Tournament > Modify > Registration fee), and the cost of any USATT
membership that the player has bought (in the USATT membership > Bought field).
Enter the amount the player paid in the Paid field. The Owes field normally is
the Total field minus the Paid field. However, Zermelo provides two ways for you
to modify how much a player owes. One way is to enter a value in the Adjustment
field. Zermelo adds this value to what the player owes. So, if you want to charge
the player extra (e.g., a late fee) enter the amount as a positive quantity. If you
want to charge the player less (e.g., to let them play some events for free), enter
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the amount as a negative quantity. The second way to modify how much the player
owes is to uncheck the Autocalc check box. If you do this, then Zermelo will not
calculate the value for the Owes field; so you can set it to any value that you wish.
The amount you enter in the Paid field should be the amount the player paid
before the tournament starts. Whether you update this value once the tournament
starts depends on what bookkeeping system you use. See Section 4.4.1 on page 95.
1.2.18. USATT Membership. The USATT membership fields are only relevant
for USATT tournaments.
Enter the player’s USATT-membership expiration date in the Expiration field. If
the player has a lifetime membership, then check the Never check box. If the player
has never bought a USATT membership, then leave the Expiration field blank.
The Validity field tells you whether the player’s membership is “Current” or
“Expired” as of the first day of the tournament. USATT rules are that if a player’s
membership is good on the first day of the tournament, they can play for the whole
tournament (so if their expiration date is not before the first day, their membership
is good for the whole tournament). When a player buys a tournament pass, USATT
enters the last day of the tournament where they bought the pass as the player’s
membership expiration date. If the Expiration field is blank (i.e., if the player has
never bought a membership or tournament pass), then the Validity field will be
disabled.
If the player has paid for a USATT membership before the tournament (i.e., sent
in the money with their entry form), then set the Bought field to the membership
type that the player bought. The choices are “None”, “Basic”, “Pro”, “Lifetime”,
“Foreign”, “Junior Pass”, and “Adult Pass”.
The “Foreign” value is for players of other national associations affiliated with
ITTF that can show current membership in their association. Such players need not
have a USATT membership or buy a tournament pass. To buy a Junior Tournament
Pass a player must be under eighteen.
Zermelo uses the Expiration and Bought fields for the “Membership” column
of the registration list.
1.2.19. Status. The Status box has two fields: one that you set to tell Zermelo
where the player is and the other that lets you know if the player can go home.
The Check in field specifies whether the player is at the tournament. Usually,
you will use ::Players > Check In or Out to change the check-in status of a player,
but you can also do it from here. The possible player check-in statuses are “Never
Here”, “Not Here Today”, “Here Now”, “At Lunch”, “Gone for the Day”, and “Gone
for Good”. “Never Here” is the status that players start out with. When the player
checks in at the registration desk, you change the status to “Here Now”. If the
player leaves the tournament or you do not want to call them for a match right
now (maybe they need a short rest), you change the status to “At Lunch”. Be sure
to remind players to let you know when they return from lunch, so that you can
change their status back to “Here Now”.
If the player leaves and is not coming back at all, you can, if you wish, change
their status to “Gone for Good”. With this status, Zermelo will offer to default the
player’s matches rather than calling them (as would happen if the player’s status
were “Here Now”). Setting the status to “Gone for Good” is only useful if the player
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has more matches to play (but it doesn’t hurt to do it even if the player doesn’t
have more matches to play). If the player is leaving for the day, but will return for
subsequent days, set the status to “Gone for the Day”. This has the same effect on
matches, but Zermelo will change the player’s status to “Not Here Today” at the
start of the next day.
Normally, if the player is currently playing a match (i.e., a match card for the
player has been printed), you cannot change the player’s status (i.e., a player can’t
both be playing and not at the tournament). To change the status, undo the match
card (via ::Matches > Undo One). (However, see below for the effect of unchecking
the Manage match calling check box.)
When you start Zermelo for the first time on the second or third day of the
tournament, Zermelo changes the status of all the players who are “Here Now”, “At
Lunch”, or “Gone for the Day” to “Not Here Today”. Thus, you must have players
check in at the registration desk each day of the tournament, even if they were at
the tournament on a previous day.
The Playing field shows whether the player has more matches to play. This is
handy for answering the question, Am I done? The field will be disabled unless the
tournament is currently going on. The possible values are “Playing Now”, “More
to Play”, “Depends on Who Advances”, “Done for the Day”, “All Done”, and “Not
Entered”. The value “Playing Now” means the player is playing a match at the
moment. “More to Play” means the player has more matches to play in events
that either have started or are starting on the current day. “Depends on Who
Advances” means that the player will only have more matches on the current day
if they advance from a round-robin group which they have completed but which
isn’t done because other players still have matches to play in it. “Done for the Day”
means the player has no more matches on the current day, but is entered in events
that start on subsequent days. “All Done” means the player has finished playing in
all events that they are entered in. “Not Entered” means the player is not entered
in any events.
If the ::Matches > Modify Calling > Manage match calling check box is
unchecked, then Zermelo will ignore whether the players are at the tournament
or are playing when calling matches (see Section 8.1 on page 119). So in this case,
setting the player’s status is optional, and Zermelo will let you set it to whatever
value you want. Also, since in this case Zermelo will be printing match cards for
all matches, Zermelo won’t know which matches are really playing and the Playing
status field will be less informative.
1.2.20. Rating. Enter the player’s rating in the Rating field. Zermelo uses the
player’s rating to determine event eligibility in rating-limited events, seeding in
all events except handicap, whether low-rated or unrated entry fees apply, and
whether the player advances in events where unrated players don’t advance. To
indicate that the player does not have a rating, set the value to blank.
Note that the Ratings Central and USATT rating scales are different. You will
want to use a consistent scale for your players when running your tournament. See
Chapter 13 on page 129 for more information.
1.2.21. Standard Deviation. Only Ratings Central supplies standard deviations
for players. Enter the player’s standard deviation in the Standard deviation field.
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To indicate that the player does not have a standard deviation, set the value to
blank.
Note that if the player has a standard deviation and it is greater than or equal
to the unrated-players standard-deviation threshold (::Tournament > Modify > Unrated players > St. dev. threshold) then Zermelo considers the player to be unrated.
1.2.22. Unrated Prior. The Unrated prior fields are only relevant for Ratings
Central tournaments. If this is the player’s first tournament, the Mean and Standard deviation fields let you specify the mean and standard deviation of the playing
strength of the player. You can leave these fields blank, but if you set one, you must
set both. See Chapter 13 on page 129 for advice on what to put in these fields.
Notice that there are two sets of rating/mean and standard deviation values:
the tournament set (consisting of the Rating field and the Standard deviation field
in the unlabeled box) and the unrated-prior set (in the Unrated prior box). The
tournament set is used for the tournament, e.g., seeding and event eligibility. The
unrated-prior set is not used for the tournament, but is sent to Ratings Central
when you submit the tournament. The tournament set will never be sent to Ratings
Central nor used as the player’s unrated prior, even if you leave the unrated-prior
set blank. If you wish to specify an unrated prior for the player, you must fill in
the unrated-prior set. Also, note that copying a player from the rating list fills in
the tournament set, but not the unrated-prior set.
1.2.23. IDs. The Ratings Central field is only relevant for Ratings Central tournaments. Enter the player’s Ratings Central ID number in this field. If the player
does not have a Ratings Central ID (because this is the first time that the player has
played in a Ratings Central tournament or event), then leave the field blank.
The button to the right of the field brings up the rating-list browser positioned
on the player whose Ratings Central ID is closest to the value in the Ratings Central
field. The button will be disabled unless you’ve imported a Ratings Central rating
list. The shortcut key for the button is ⟨Ctrl+R⟩.
Enter the player’s USATT ID number in the USATT field. If the player does
not have a USATT ID, then leave the field blank. Zermelo writes the USATT ID
to the USATT tournament-report file to identify the player. Ratings Central will
save the USATT ID in its database to help identify the player, but does not use the
USATT ID for any other purpose. A player who has never bought a membership or
tournament pass might still have a USATT ID number because they were a USATT
associate member.
The button to the right of the USATT field brings up the rating-list browser
positioned on the player whose USATT ID is closest to the value in the USATT field.
The button will be disabled unless you’ve imported a rating list. The shortcut key
for the button is ⟨Ctrl+U⟩.
The TT Australia field is only relevant for Ratings Central tournaments. Enter
the player’s TT Australia ID number in the field. If the player does not have a TT
Australia ID, then leave the field blank. Ratings Central will save the TT Australia
ID in its database to help identify the player, but does not use the TT Australia ID
for any other purpose.
The button to the right of the TT Australia field brings up the rating-list
browser positioned on the player whose TT Australia ID is closest to the value
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in the TT Australia field. The button will be disabled unless you’ve imported a
Ratings Central rating list. The shortcut key for the button is ⟨Ctrl+T⟩.
The ITTF field is only relevant for Ratings Central tournaments. Enter the
player’s ITTF ID number in the field. If the player does not have an ITTF ID, then
leave the field blank. If the player has played in an ITTF tournament, Ratings
Central may have the ITTF ID for the player in its database (and in the rating list
that you download). However, you cannot set or modify the ITTF ID for a player
in the Ratings Central database. If the player has an ITTF ID in the Ratings Central
database, then the effect of checking the New personal info check box is different;
see Section 1.2.16 on page 80 for more information.
The button to the right of the ITTF field brings up the rating-list browser positioned on the player whose ITTF ID is closest to the value in the ITTF field. The
button will be disabled unless you’ve imported a Ratings Central rating list. The
shortcut key for the button is ⟨Ctrl+I⟩.
See Section 1.3 on the next page for more information on the rating-list
browser. The shortcut keys for the rating-list-browser buttons also work from
the Browse page of the notebook.
Each player must have a unique tournament player ID between 1 and 999 (so,
you can have at most 999 players). When you add a player, Zermelo will set the
value of the Tournament field to an unused number. This number appears on
match cards and draw sheets and in windows such as Matches > Enter Result. In
all these cases, the player’s ID number is the number enclosed in parentheses. See
Section 4.6 on page 96 for how to renumber players alphabetically.
If a player has played, or is currently playing, any matches, then Zermelo won’t
let you change the player’s tournament ID number because the ID is printed on the
match card, so changing the number might be confusing. If you have submitted
the tournament to Ratings Central, then Zermelo won’t let you change the player’s
tournament ID number because this would make it difficult for Ratings Central to
tell which player is which if you need to submit the tournament again.
1.2.24. Notes. The Notes field lets you record any notes about the player that
you wish to. For example, you may wish to make a note of why the player owes
money or some other information that will be useful when the player registers.
Besides viewing the notes here, you can see them in the player grid (on the Browse
page of the notebook) or print them via ::Players > Print Lists > Player notes.
1.2.25. Events. The Events check list lists all the events and lets you add or
scratch the player from singles events. For doubles events, you can scratch the
player, but to add them, you must use Players > Enter Doubles. If an event name is
grayed out, it means you cannot add the player to or scratch the player from that
event; either the player is not eligible or the reason is given by the code letter to the
right of the event name. Code letter “D” means the event is doubles (so you must
use Players > Enter Doubles). Code letter “X” means the player is not eligible for
the event. Code letter “P” means the player has played in the event and so cannot
be scratched (if you wish to remove the player anyway, you must first undo the
matches the player has played via ::Matches > Undo One). Code letter “F” means
the event is full, i.e., there is no room to add a player. The status bar below the
events check list explains what the code letters mean.
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Figure 3. Draw with defaulted match
Zermelo allows you to add a player to an event after the event has been drawn
or even after some matches have been called or played. If the event is already
drawn, then Zermelo will choose a slot in the draw in which to place the player.
When doing this, Zermelo will try to take the same factors into account as when
making the draw, i.e., seeding, draw-club separation, unrated players playing each
other in the first round, and players playing each other in the first round of multiple events. However, it is almost impossible to add a player to an event and
have the seeds be separated properly, so Zermelo only worries about seeding if
the player is one of the top seeds, i.e., one of the top four for a single elimination
bracket or one of the top N (where there are N groups) for multiple round-robin
groups. When choosing a slot, Zermelo takes into account whether the Separate
club members check box is checked, but behaves as if the Place byes randomly
check box is checked, regardless of whether it actually is. (See Section 1.2.7 on
page 67 for information on these check boxes.) If you do not like where Zermelo
places a player, you can change it via ::Draw Sheets > Swap Slots.
When adding a player to an event, Zermelo considers defaults to be revocable.
To explain, consider the draw in Figure 3. Since the final has been entered, if the
default were not revocable, then you would not be able to insert a player into the
draw unless you undid the match. However, Zermelo considers the default to be
revocable and so will automatically undo the default in order to insert a player.
Similarly, you can scratch a player all of whose matches in an event are defaults
without having to undo the matches. To add a player to an event, Zermelo may
scratch a player who has defaulted out of an event, but only if there are no other
slots in which to place the player.
If the tournament is currently going on or the draw is already made for any
of the changed events, Zermelo writes the player’s adds and scratches to the log
window.
1.3. Rating-List Browser. The rating-list browser (Figure 4 on the next page)
lets you view the rating list. You can bring up the rating-list browser from either
page of the player notebook or from the ::Lists > Browse Rating menu item. From
the Browse page of the player notebook you can click the Rating List button. From
the Edit page, you can click any of the buttons that show a hand pointing to a list
of records. From either page, you can use the ⟨Ctrl+N⟩, ⟨Ctrl+R⟩, ⟨Ctrl+U⟩, and
⟨Ctrl+T⟩ shortcut keys. These bring up the rating-list browser on the player whose
name, Ratings Central ID, USATT ID, or TT Australia ID (respectively) is closest to
that of the player that you are editing or that you have selected in the grid on the
Edit page. A button and shortcut will be inactive unless you’ve imported a suitable
rating list via ::Lists > Import.
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Figure 4. Rating-list browser

The rating-list grid works like Zermelo’s other grids (see Section 10 on
page 167). The meaning of most of the columns should be obvious. The “Last
Played” column contains the date of the last tournament that the player played.
The “Source” column indicates whether the record came from Ratings Central
(“R.C.”) or USATT. The “Expiration” column contains the player’s USATT membership expiration date. If the player has a life membership, the “Expiration” column
will say, “Never”.
The Find field lets you search for a specific player. It works like Zermelo’s
other incremental-search fields (see Section 10.1 on page 168).
Click the Add Player button to close the rating-list browser and add the selected player to the tournament. If you were editing a player (i.e., you were on the
Edit page of the player notebook), Zermelo will save any changes you made to the
player. Then Zermelo will add a new player to the tournament and copy the information for the player you selected in the rating-list browser from the rating list to
the new-player’s fields, all ready for you to save the player.
Click the Overwrite Player button to close the rating-list browser and overwrite
the player you were editing or had selected in the player grid with the player you
selected in the rating-list browser. If the value for the player in a column of the
rating-list browser is blank, then the corresponding value for the player you are
editing will be retained; it will not be blanked.
Click the Merge Player button to close the rating-list browser and merge the
information from the player that you selected in the rating-list browser into the
player that you were editing or had selected in the player grid. This copies all nonblank values from the player in the rating list to the player that you were editing or
had selected. But, if a value for the player in the rating-list browser is blank, then
the corresponding value for the player that you were editing or had selected will
be retained; it will not be blanked.
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Click the New Player button to close the rating-list browser and add a new,
blank player to the tournament. If you were editing a player, Zermelo will save
any changes you made to the player. If the rating-list grid is sorted on the “Name”
column, Zermelo will set the new-player’s name to the contents of the Find field. If
the string in the Find field is all lower case, Zermelo will capitalize the initial letters
of words when setting the new-player’s name. This makes it easy to add a player
when you discover that the player you are looking for is not in the rating list.
Click the Close button to close the rating-list browser without changing the
players in the tournament.
If you open the rating-list browser from the Rating List button on the Browse
page, the Overwrite Player and Merge Player buttons will be disabled, the Add
Player button will be the default button, and you can double-click a player in the
grid to add the player to the current event.
If you open the rating-list browser from the ::Lists > Browse Rating menu item,
the Add Player, Overwrite Player, Merge Player, and New Player buttons will be
disabled.
If your tournament is both a Ratings Central tournament and a USATT tournament, then you’ll probably have imported rating lists from both organizations.
If so, many players will appear in both lists and so will have two records in the
rating-list browser. For such players, you’ll usually have to find both records for
the player (so you’ll get both the Ratings Central ID and the USATT ID for the
player). You’ll use the Merge Player button to copy the information from the second record. Note that the rating that the player will have for the tournament will
be that of the second record that you copy. So, for example, if you want to use Ratings Central ratings for your tournament, you should first copy the player’s USATT
record, then copy the player’s Ratings Central record. The Ratings Central rating
list does have a field for the USATT ID. So, if the player has a value in this field in
the Ratings Central rating list, you only need to select the one record to get both
the Ratings Central ID and the USATT ID, but this won’t get you values that are
only in the USATT list, such as USATT membership expiration date.
If the list database folder is set (see Section 1.9 on page 57), the title bar of the
window shows the folder’s location.
2. Enter Doubles
The Enter Doubles menu item brings up a tabbed-notebook window (Figure 5
on the next page) that lets you add and scratch players from doubles events. This
menu item will be disabled until you have at least one doubles event and at least
two players.
2.1. Browse. The first page of the notebook (the Browse page) contains a grid
listing the doubles events along with various information about each event. The
grid works like Zermelo’s other grids (see Section 10 on page 167), except the grid
is always sorted by the “ID” column. The columns in the grid are a subset of
the columns that the ::Events > Modify grid displays, i.e., those columns that are
relevant to doubles events. The Edit button switches to the Edit page to let you add
and scratch players from the event that is selected in the grid.
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Figure 5. Enter-doubles window

Figure 6. Edit-doubles page
2.2. Edit. Figure 6 shows the Edit page of the notebook. You enter a player by
typing the player’s tournament ID number in either the “ID 1” column or the “ID 2”
column. When you leave a cell, Zermelo will display the name of the player in the
player column. To scratch a player from the event, delete the player’s ID number
from the cell. If a player has played a match, Zermelo will not let you change the
player’s cell. Zermelo will add a line to the grid as you fill the last line, but only
until there are as many lines as the event has room for teams. When you first
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Figure 7. Finished doubles
switch to the Edit page, if the event is full, there will not be an empty line of cells
at the bottom of the grid. Figure 7 shows the Edit page for a single-elimination
doubles event with two teams where the final has been played.
To save your changes, click the Save button. As with other notebooks, switching to the Browse page by clicking the Browse tab will also do a save.
It is simplest to not take doubles entries before the tournament. Players find
it hard to coordinate who their doubles partners will be (intended partners do not
come or players change their minds). To deal with doubles entries, tape a piece
of paper to the registration desk and label it with the name of the doubles event.
When teams enter, write the names of the two player on a line with the tournament
player ID number of each player next to the player’s name. If the player has paid,
note this next to the player’s name. When you are ready to draw the event, enter
the teams into Zermelo by typing the tournament player ID numbers (which you
read from the paper) into the grid. Once you have typed them in, compare the
piece of paper to what it says on the screen.
Of course, you can, if you prefer, take doubles entries in advance. When you
are entering players and their singles events, simply note if a player’s doubles
partner is already entered. If so, make a note of both players’ ID numbers on the
entry form. Once you’ve entered all the players, go back through the entry forms
and enter each doubles team.
If the draw for the event is made, Zermelo writes the adds and scratches to the
log window.
Note that even if you add several teams to a doubles event at the same time,
if the draw is already made, Zermelo will add the teams one at a time. So, for
example, if your event consists of round-robin groups of four, and you add four
new teams to an existing draw, Zermelo will try to put the teams in existing groups
rather than add a new group for the four teams.
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Figure 8. Check-in-or-out window

2.2.1. Draw. The Draw field is identical to the Draw field on the Edit page of
the ::Events > Modify notebook (see Section 1.2.7 on page 67). It is repeated here as
a convenience since you will probably want to set the value to “Yes” after entering
the doubles teams.

3. Check In or Out
The Check In or Out menu item brings up a window (Figure 8) that lets you
change the check-in status of players (i.e., where the players are). Type the tournament player ID number of the player in the Player ID field, select the appropriate
radio button corresponding to what has prompted you to change the status, and
click the OK button. Zermelo will then display the name of the player at the bottom
of the window (see Figure 9 on the next page) to let you know which player you just
changed the status for. This lets you know if you typed the wrong player ID number. See Section 4.4 on page 93 and also Chapter 12 on page 127 for information
on how to handle registration.
You can also use ::Players > Modify > Edit > Status > Check in to change the
status of players. Most of the time, you will find that Check In or Out is more
convenient. In addition, Check In or Out does not let you make some changes that
might be errors (such as marking a player as out to lunch if the player has already
gone for the day), while ::Players > Modify > Edit > Status > Check in lets you change
the status to anything you want (if the player isn’t playing or Manage match calling
is unchecked).

4. Print Lists
The Print Lists menu item brings up a window (Figure 10 on the facing page)
that lets you print various lists of players and renumber the players.
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Figure 9. Check-in-or-out window after checking payer in

Figure 10. Print-lists window
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Figure 11. Player list sorted by name

Figure 12. Player list sorted by rating
4.1. Player List Sorted by. . . Check the Name check box to get a list of all the
players in the tournament sorted by name (see Figure 11). The “Unrated Prior” column is only relevant for Ratings Central tournaments. Check the Rating check box
to get a list of all the players sorted by rating (see Figure 12). You can post copies
of these lists on the wall so the players can see who is entered in the tournament.
The list sorted by rating is also useful if you are trying to help players find doubles
partners for rating-limited doubles events.
4.2. Events. Check the appropriate check box in the Events check list to get a
list of the players entered in the event. If the event is drawn, there will be a “D”
to the right of the event name. If there are no entries in the event, the check box
for the event will be disabled (e.g., the Open Doubles event in Figure 10 on the
previous page).
Figure 13 on the facing page shows an event list for a singles event sorted by
name. For each player, the list shows the player’s rating, ID, check-in status, and
name. If the player’s check-in status is “Here Now”, then the status for that player
will be blank. If it is a doubles event, the list also shows the ID and name for the
player’s partner (see Figure 14 on the next page). These lists are useful if you want
to check that all players who entered an event have registered before you make the
draw.
Figure 15 on the facing page shows an event list for a singles event sorted by
rating. The list shows the player’s seeding, rating, ID, and name. If it is a doubles
event, then the list shows both players in the team, their ratings and IDs, and the
team (average) rating (see Figure 16 on the next page). The teams are listed in order
of team rating.
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Figure 13. Singles event list sorted by name

Figure 14. Doubles event list sorted by name

Figure 15. Singles event list sorted by rating

Figure 16. Doubles event list sorted by rating
4.3. Sort Event Lists by. . . The Sort event lists by. . . radio buttons control
how the event lists are sorted.
4.4. Registration List. Check the Registration list check box to get a list for
the registration desk to use to register players when they arrive at the tournament
(see Figure 17 on the following page).
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Figure 17. Registration list
The boxes on the left are so you can check off that people have registered. Put
an “X” in the first box when the person checks in. When the computer-desk person
and the registration-desk person are both ready to do check-in, the computer-desk
person selects Players > Check In or Out. The registration-desk person looks down
the list for a player that has an “X” in the first column, but not in the second
column. The registration-desk person says the ID number of the player to the
computer-desk person. The computer-desk person types the number and clicks
the OK button. The computer-desk person then reads the name of the player from
the bottom of the window and says it to the registration-desk person. This serves
as a check that they got the right player. The registration-desk person puts an
“X” in the second column. The registration-desk person looks for the next player
that only has an “X” in the first column, and they repeat the process until they’ve
checked in all the players who have registered.
The “Owes” column shows how much the player owes (i.e., the value from
::Players > Modify > Edit > Owes). This includes the cost of any USATT memberships listed in the “Membership” column. If the “Owes” column is blank, then the
player does not owe anything.
The “Membership” and “USATT” columns are only for USATT tournaments.
The registration list will only include these columns if you check the Include USATT
info check box.
If the “Membership” column is blank, then the player’s USATT membership is
OK. If the column shows “????”, then the player must show proof of membership
or buy a membership or tournament pass. If the membership column shows anything else, it means the player has paid for the specified membership. When the
player takes care of their membership, it helps to cross out whatever it says in the
“Membership” column, so that you know that you have taken care of it.
The “USATT” column shows the player’s USATT ID number. If the player shows
a membership card, be sure that you enter their USATT membership number into
::Players > Modify > Edit > IDs > USATT , if it is not already entered.
The remaining columns are mostly just for information. You should tell the
player what rating you have for them and what events you have them in, both to
make sure you did not make an error and to make sure that the player knows what
events they entered.
If the tournament is more than one day long, players must check in each day.
You should print a fresh registration list each day, so you can tell which players
are checked in for the current day. You probably want to save the registration lists
from previous days in case you want to check something on them.
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When you print a registration list, Zermelo will put an “X” in the check boxes
for a player if the player has checked in (i.e., if the player’s status is “Here Now”,
“At Lunch” or “Gone for the Day”).
You may want to print the registration list the night before so you can start registration in the morning without having to first get the computer set up (especially
if someone else is bringing the computer).
4.4.1. Bookkeeping. There are two approaches to keeping track of whether
players have paid what they owe, which we’ll call “cash box” and “computer”. These
two approaches correspond to the two choices in the Bookkeeping radio group.
In the cash-box bookkeeping system, you collect whatever money a player owes
the first time that the player checks in. You also take care of whatever USATT
membership the player needs. In this system, once the tournament starts, you do
not need to enter anything a player pays into the player’s Paid field (in ::Players >
Modify > Edit > Fees) nor update the player’s USATT membership fields.
If you are using the cash-box system and print a new registration list (e.g., on
the second day of a tournament), you need to know which players have paid. To
accomplish this, select the Cash box radio item. This will cause Zermelo to assume
that if a player’s check-in status is anything other than “Never Here”, then the
player paid the first time that they checked in. For these players, Zermelo will leave
the “Owes”, “Membership”, “USATT”, and “Paid” columns blank. In other words,
the registration list will show the player as not owing any money nor needing a
USATT membership.
Sometimes a player who is playing on more than one day wishes to pay a day
at a time. If you let the player do this, and you are using the cash-box system, write
yourself a note that the player owes money and put it where you will be sure to see
it (tape it to the registration desk).
When using the cash-box system, I find it helpful (although not essential) to
write on the registration list how much a player pays and what membership they
buy (this provides a record of the transaction).
The other approach to keeping track of whether players have paid is the computer bookkeeping system. In this system, you record whatever money a player
pays by updating the player’s Paid field. You also record whatever USATT membership they buy by updating the player’s USATT membership fields. If you use this
system, then the information Zermelo has is always up to date. If you select the
Computer radio item, then Zermelo will print all the columns of the registration
list.
An advantage of the computer bookkeeping system is that the USATTmembership fee values in ::Tournament > Display Statistics will be correct. On the
other hand, you could, if you wish, use the cash-box system, but also update the
USATT membership > Bought fields, perhaps after the tournament is over. Note
that information on membership purchases is included in the files that Zermelo
generates for you to send to USATT. For the files to be most useful to USATT, you
will need to enter the appropriate information into Zermelo before generating the
files. See Section 4 on page 60 for more information.
Regardless of which bookkeeping system you use, you’ll want to have a cash
box to put money and checks in. At the beginning of the tournament, put a bunch

96

8. PLAYERS MENU

Figure 18. Import-players window
of $1’s and $5’s in the box so you can make change. Write down how much money
you put in. During the tournament put all the money and checks that players
give you into the cash box. When the tournament is done, count the money and
checks in the cash box and subtract how much money you put in at the beginning. The difference is how much you took in. If you are using the computer
bookkeeping system, then this amount should match the total of the fees shown in
::Tournament > Display Statistics (assuming everyone paid and everyone entered
in an event actually played in the event and the Autocalc check box is checked for
all players).
I prefer the cash-box system because it is simpler and it allows you to register
players without having to touch the computer.
4.5. Player Notes. Check the Player notes check box to get a list containing
the notes you made for each player via ::Players > Modify > Edit > Notes. If you
made any notes, this list may be handy for registration.
4.6. Renumber Players. It is simplest for the registration desk if player IDs
are sequential on the registration list. Players are unlikely to send in their entries
in alphabetical order. If you check the Renumber players check box and click the
OK button, Zermelo will renumber the players so the players are numbered in
alphabetical order. You can do this, for example, when you print the registration
list for the first day. If you check both the Renumber players check box and the
Registration list check box, Zermelo will renumber the players before printing the
registration list.
Once any match cards are printed, Zermelo will not let you renumber the players because the player IDs are printed on the match cards, so this might be confusing. If you have submitted the tournament to Ratings Central, then Zermelo
won’t let you renumber the players because this would make it difficult for Ratings
Central to tell which player is which if you need to submit the tournament again.
5. Import
The ::Players > Import menu item brings up a window (Figure 18) that lets you
import players from the rating list into the tournament. The menu item will be
disabled until you have set up the tournament via ::Tournament > Modify and have
imported a rating list.
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You specify the players to import by providing a text file containing IDs. The
file must have each ID on its own line. Blank lines are ignored, as are leading and
trailing spaces and tabs.
You can construct this file in many ways. Possibilities include the following:
You could keep or create a list of players in Excel or Microsoft Access, then write
the IDs to a file (e.g., Save As Text) or copy them into a text editor such as Notepad.
You could open the Ratings Central rating list in Excel, sort and filter it to make it
more manageable, mark the players who are coming to your tournament, sort them
to the top or filter to select just them, then copy the IDs to Notepad. You could
copy a list of players from a page on the Ratings Central website, then edit the
list to contain the IDs that you want. You could export a player list from another
tournament via ::Players > Export, then edit it.
Set the Organization drop-down list to the organization that assigned the IDs.
If you have imported a Ratings Central rating list, then you can use IDs from Ratings Central, USATT, TT Australia, or ITTF. Note that it is up to event directors to
enter the USATT and TT Australia IDs into the Ratings Central database, so these
values may be missing for some players on the Ratings Central rating list. If the
only rating list that you have imported is from USATT, then you can only use IDs
from USATT, since these are the only IDs that the USATT rating list has.
Type the filename of the file of IDs in the ID list field. Include the path to the
folder where the file is. Alternatively, click on the button at the right of the field to
browse for the file.
Click the Import button to import the players. If any players cannot be imported, Zermelo will display a window listing the IDs that could not be imported
and the reason. The possible reasons are
Bad value for ID. The ID value is not an integer or not in the correct range.
Already a player in tournament with ID.
ID not found on rating list.
More than one player on rating list with ID. So, it isn’t clear which player
should be imported.
• ID from a different organization conflicts with a player in tournament.
The player was found on the rating list, but the record for the player in
the rating list includes an ID from a different organization that is the same
as a player already in the tournament.
• No room in tournament. Since each player must have a unique tournament player ID between 1 and 999, you can have at most 999 players in
the tournament.
•
•
•
•

If you have imported rating lists from both USATT and Ratings Central and
are importing players by specifying USATT IDs, then Zermelo will first look for the
player on the Ratings Central list, and import that record, if there is one. If there
isn’t one, then it will look for the player on the USATT list.
If the state or country on the rating list are not valid, Zermelo will use the state
and country values for the tournament.
If the gender value on a USATT rating list record is missing, Zermelo will use
male.
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If the player is imported from the Ratings Central list and the record includes
the player’s USATT ID and you have also imported a USATT rating list, then after
importing the Ratings Central record, Zermelo will also look for the player on the
USATT rating list. If Zermelo finds the player there, it will use the USATT rating for
the player instead of the Ratings Central rating. Note that the Ratings Central and
USATT rating scales are different; you will want to use a consistent scale for your
players when running your tournament. See Chapter 13 on page 129 for advice on
converting between the two scales.
6. Export
The Export menu item writes the player information to a file in CSV format.
This will be useful if you want to import the player information into a spreadsheet
or database or do a mail merge. The file is named “Player.csv” and will be created
in the database folder (the location of the database folder is shown in the right
pane of the status bar at the bottom of Zermelo’s main window).

CHAPTER 9

Draw-Sheets Menu
The Draw Sheets menu contains items that let you display, print, and modify
draw sheets and modify if and when Zermelo reminds you to post draw sheets.
1. Display
The Display menu item brings up a window (Figure 1) that lets you select a
draw sheet to display on screen. This menu item will be disabled until you have
events that are drawn.
To select which draw sheet to display, type the event number in the Event field
or select the event in the Event list box. Then click the OK button. Alternatively,
you can just double-click the event in the list box.
The list box only lists the events that are drawn. If the event is completed (i.e.,
is finished), there will be a “C” to the right of the event’s name.
If you check the Include clubs check box, then Zermelo will display each
player’s draw club in parentheses after the player’s name. Zermelo saves the check
status of this check box. So, the next time that you bring up this window, the box
will be checked if you left it checked. Zermelo saves the check status even if you
close the window by clicking the cancel button.
The Include clubs option applies to both displaying and printing draw sheets.
So, if you leave the check box checked and bring up the print-draw-sheets window
(Figure 3 on the next page), the Include clubs check box on that window will be
checked.
Figure 2 on the following page shows a draw sheet being displayed. Press ⟨Esc⟩,
⟨Enter⟩, or ⟨Space⟩ to close the window. You can switch back to Zermelo’s main
window without closing the draw-sheet window by clicking the main window’s title
bar. You can also display several draw-sheet windows at the same time by not

Figure 1. Display-draw-sheet window
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Figure 2. Draw-sheet window

Figure 3. Print-draw-sheets window
closing the draw-sheet window and then displaying another draw sheet via the
Display menu item.
See Section 2.1 on the next page for how to read the draw sheets.
2. Print
The Print menu item brings up a window (Figure 3) that lets you print draw
sheets. This menu item will be disabled until you have events that are drawn.
To select which draw sheets to print, you can type an event number in any or
all of the Event 1, Event 2, or Event 3 fields. Or, you can select the events in the
Events check list. If you check the All check box, then Zermelo will print the draw
sheets for all the events. If you check the Incomplete check box, then Zermelo will
print draw sheets for all the single-stage events that are not completed, and for
two-stage events, all the stages that are not completed.
If you check the Modified check box, then Zermelo will print those draw sheets
that have been modified since the last time you printed modified draw sheets for
posting. See Section 4 on page 105 and Section 5 on page 22.
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For two-stage events (i.e., “RR to RR” and “RR to SE”), the Events check list,
besides having a check box for the event, has a check box for each stage of the
event (see Figure 3 on the preceding page). This lets you print the draw sheet for
one stage without having to print the draw sheet for the other stage.
In the Events check list, the events that have been modified have an “m” in
brackets to the right of their names (e.g., in Figure 3 on the facing page events 3
and 4 are modified). For two-stage events, an “m” to the right of the event name
means both stages have been modified, while an “m” to the right of a stage means
that stage has been modified. The modified status is only cleared when you print
the draw sheets by checking the Modified check box or you print them from the
main window by clicking the pushpin icon when it is displayed in the postingreminder pane of the main window’s status bar or by pressing the ⟨M⟩ shortcut
key. The modified status is not cleared if you print the draw sheet for an event in
any other way. This lets you print draw sheets to look at without having to post
them.
The events that have been completed (i.e., are finished) have a “c” in brackets
to the right of their names. Similarly, a “c” in brackets to the right of a stage means
that the stage has been completed. For example, in Figure 3 on the preceding page
event 2 has been completed.
If you check the Modified check box and also select other draw sheets (using
any of the other fields), then the modified draw sheets will be printed after the
others.
If you check the Include clubs check box, then Zermelo will print each player’s
draw club in parentheses after the player’s name. If you intend to do this, you
should use short draw-club names. Zermelo saves the check status of this check
box. So, the next time that you bring up this window (or the display-draw-sheet
window, Figure 1 on page 99), the box will be checked if you left it checked. Zermelo saves the check status even if you close the window by clicking the cancel
button. If you leave the box checked, then draw sheets you print by clicking the
pushpin icon in the posting-reminder pane of the main window’s status bar or by
pressing the ⟨M⟩ shortcut key will also include the players’ draw clubs.
If you select the same draw sheet more than once, e.g., by entering it in Event 1
and also selecting it in the Events check list, Zermelo will print the draw sheet more
than once. That is, Zermelo prints what you select without removing duplicates.
2.1. Reading the Draw Sheets. Figure 4 on the next page shows a sample
single-elimination draw sheet. The start day and time of the event is in parentheses after the event name. The numbers on the draw sheet after the number sign
(“#”) are the players’ seedings. The numbers to the right of the seedings are the
players’ ratings (for doubles teams, this is the average rating of the two players).
If the player does not have a rating, there will be a zero. If the player has a standard deviation, it will be after a plus/minus sign, e.g., “2120 ± 57”. The numbers
in parentheses are the players’ tournament ID numbers. The number to the left of
where the winner’s name appears is the match number. The numbers in the line
just below the header of the draw sheet are the round numbers (“8” and “9” in the
figure). Zermelo numbers rounds backwards, i.e., the final round is round number
9, the semifinal round is round number 8, etc. For example, in the figure, Abril
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Figure 4. Single-elimination draw sheet

Figure 5. Round-robin draw sheet
defeated Andersson in match 1 of round 9. (The reason Zermelo numbers rounds
this way is so that the round number for a match will not change if an extra round
is added to the event to accommodate additional players.)
If Unrateds advance (in ::Tournament > Modify > Unrated players) is not
checked, then the player who advances to the next round in a match in a ratinglimited single-elimination event need not be the winner of the match. If a losing
player advances, Zermelo prints “Loser advanced” above the name of the losing
player. For example, in the figure, both Adams and Abril defeated Abrams.
Figure 5 shows a sample draw sheet for a group in a “RR to SE”-format event
with one player advancing from the group.
Normally, if a match is playing, Zermelo writes “playing” on the draw sheet on
the line or in the cell of that match. However, if the ::Matches > Modify Calling >
Manage match calling check box is unchecked (see Section 8.1 on page 119) or the
stage of the event is not selected in ::Events > Modify > Edit > Search > Stages (see
Section 1.2.10 on page 69), then Zermelo does not write “playing”, since in this
case, Zermelo doesn’t know which matches are really playing. If you posted the
draw sheets for the players to see, it would be confusing if all the matches were
listed as playing. If you display the draw sheet, rather than printing it, Zermelo
will write “printed”.
2.2. Round-Robin Places. For round-robin groups, Zermelo determines the
place (i.e., 1st, 2nd, etc.) of each player as soon as you enter all the results in
the group. Zermelo uses the ITTF rules for determining the places. The 2021 ITTF
Handbook, Chapter 3, says:
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3.7.5.1. In a group, or “round robin”, competition, all members of the group shall compete against each other and shall gain
2 match points for a win, 1 for a loss in a played match and 0 for
a loss in an unplayed or unfinished match; the ranking order shall
be determined primarily by the number of match points gained. If
a player is defaulted after the completion of a match for any reason, he or she shall be deemed to have lost the match, which shall
subsequently be recorded as a loss in an unplayed match.
3.7.5.2. If two or more members of the group have gained
the same number of match points their relative positions shall be
determined only by the results of the matches between them, by
considering successively the numbers of match points, the ratios
of wins to losses first in individual matches (for a team event),
games and points, as far as is necessary to resolve the order.
3.7.5.3. If at any step in the calculations the positions of one
or more members of the group have been determined while the
others are still equal, the results of matches in which those members took part shall be excluded from any further calculations
needed to resolve the equalities in accordance with the procedure
of 3.7.5.1 and 3.7.5.2.
3.7.5.4. If it is not possible to resolve equalities by means of
the procedure specified in 3.7.5.1-3 the relative positions shall be
decided by lot.
The 2021 ITTF Handbook for Tournament Referees, Chapter 2, says:
2.3.7. If a match is unplayed or unfinished, the player who is
declared the winner is awarded enough points to decide the match.
Thus, the winner of an unplayed match is regarded as having won
by 3–0 (or 4–0 in best-of-7 matches) in games and 11–0 in each
game. However, in a match which has been partly played when
it is abandoned in favour of one player, all points already scored
are counted. For example, if a player is injured and must retire
when leading 5–3 in the final game of a best-of-5 games match,
the winner’s score would, for example, be recorded as 11–7, 8–11,
11–6, 10–12, 11–5.
Even though Zermelo uses these rules for determining the places, Zermelo does
not show match points on the printed round-robin draw sheets; the draw sheets
only show matches won and lost and place. Note that the Unrateds advance check
box (in ::Tournament > Modify > Unrated players) has no effect on a player’s place,
but for two-stage events, it does affect which players advance from the group to
the final stage. For two-stage events, Zermelo prints the names of the players who
advance in bold. If a player defaults all their matches in a group, Zermelo will not
advance them to the final stage.
Zermelo does not have any way of recording an unfinished match. Since such
matches count for ratings, you need to record them like played matches. So, they
will be treated as such for tie-break, which is different from what the ITTF rules
say.
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Figure 6. Swap-slots window

3. Swap Slots
The Swap Slots menu item brings up a window (Figure 6) that lets you make
changes to draw sheets by swapping the contents (players, byes, or group advancers) of two slots. You will probably find that you rarely need to do this. You
can’t swap a slot if a subsequent match has been played or is playing (undo the
match first via ::Matches > Undo One).
Note in the figure that the labels for the fields in each slot indicate that each
field serves one of two purposes. If the slot is in a round-robin group, then the
fields are the group and row of the slot and you must put “0” in the third field.
If the slot is in a single elimination part of the draw, then the fields are round,
match, and slot. After you’ve entered appropriate values in all four fields for a
slot, click the Display button for the slot. Zermelo will then display the contents of
the slot (as in the figure). The numbers in parentheses are the tournament player
ID numbers.
In this window, the Cancel button is initially the default button, but it stops
being the default button as soon as you start to enter a value in one of the fields.
Once the Cancel button is no longer the default button, the ⟨Enter⟩ key will work
more like the ⟨Tab⟩ key, i.e., it will generally move the focus to the next control.
If you have entered values for all the fields for a slot and the 0/Slot field has
the focus, then pressing the ⟨Enter⟩ key will click the Display button for the slot.
This saves you one keystroke since normally you would have to press ⟨Enter⟩ (or

4. MODIFY POSTING

105

Figure 7. Modify-posting window
⟨Tab⟩) to move the focus to the Display button and then press ⟨Enter⟩ again to
click the button.
For a single-elimination bracket, you can only specify slots that are in the first
round or in the round before the first round. Doing the latter causes Zermelo to
add another round to the bracket thus creating lots of slots containing byes. When
Zermelo adds a round, a player in the top slot (slot number 1) of a match in the
original round is placed in the top slot of the match in the new round, but a player
in the bottom slot (slot number 2) of a match in the original round is placed in the
bottom slot of the match in the new round. When swapping slots, it isn’t necessary
that both slots be in the same round, i.e., one slot can be in the original first round
and the other in the new round (i.e., the round preceding the original first round).
Zermelo numbers rounds so the final round is 9, the semifinal round is 8, etc. The
round numbers are printed at the top of the draw sheet directly above the match
numbers for the matches in the round.
For two-stage events, both slots must be in the same stage. Swapping slots in
the second stage changes where players from the first-stage advance to. For the
first stage, you can specify a slot that is in a group that doesn’t exist and Zermelo
will create a new group.
For a group, you can specify a slot that doesn’t appear on the draw sheet and
Zermelo will increase the number of slots in the group, as needed.
For “RR to RR”-format events, the final group is group number zero.
4. Modify Posting
The Modify Posting menu item brings up a window (Figure 7) that lets you modify if and when Zermelo reminds you to post updated copies of the draw sheets.
It is a good idea to periodically post updated copies of the draw sheets on a
wall where the players can see them. This lets the players see how the tournament
is progressing and lets the players check that you have entered their match results
correctly. A bulletin board with pushpins is the best way to post draw sheets, but
masking tape and a wall works too. Zermelo keeps track of which draw sheets have
been modified (typically by having a result entered or the event being drawn), thus
making it easy for you to post only those draw sheets that have changed.
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Each day of the tournament, Zermelo will check for modified draw sheets at
the time set in the Start time field and at intervals after that corresponding to
the Interval field. If there are modified draw sheets, Zermelo will indicate this by
showing a pushpin icon in the posting-reminder pane of the main window’s status
bar. See Section 5 on page 22 and Section 2 on page 100 for more information.
Zermelo can automatically draw events when their starting time arrives when
you do Matches > Call (see Section 1.2.7 on page 67). If Zermelo automatically
draws any events, it will turn the pushpin icon on immediately, since you will want
to post the draw sheets right away. Zermelo will also turn on the pushpin icon if
you manually make the draw (via Events > Draw) during the tournament. Newly
created draw sheets are considered to be modified, so you can print the draw sheets
for the new events by clicking the pushpin icon.
Uncheck the Remind check box if you don’t want Zermelo to remind you to
post modified draw sheets. In other words, if the Remind check box is unchecked,
Zermelo will never display the pushpin icon and the posting-reminder pane in the
main window’s status bar will be hidden. See Section 5.1 on page 22 for more
information.
You can click the button at the right of the Start time field to drop down a
time-picker.

CHAPTER 10

Matches Menu
The Matches menu contains items that let you call matches (i.e., print match
cards), enter results, correct erroneous results, list what matches are playing, and
modify whether and how Zermelo manages the calling of matches.
1. Call
The Call menu item causes Zermelo to first draw any autodraw events whose
starting time has arrived, then search for matches to play and print the corresponding match cards. This menu item and the Enter Result menu item are the
items that you will use the most during a tournament. The Call menu item will be
disabled if there are no events.
Normally, Zermelo will only call a match if the players are at the tournament
(i.e., ::Players > Modify > Edit > Status > Check in is “Here Now”) and are not playing
another match. (However, see Section 1.1 on page 110 for the effect of unchecking
the Manage match calling check box.)
There are three types of cards that Zermelo will print: match cards, default
cards, and discard cards.
Figure 1 shows a match card. Figure 2 on the next page shows how the players
should fill in a match card. If the match format is best-of-three, the match card
will have two rows of three boxes. If best-of-five, then two rows of five boxes. And,
similarly for best-of-seven and best-of-nine. Handicap matches are one game to 31,
41, or 51, so the match card will have one box next to each player; Zermelo will
print the number of handicap points and the number of points in the game on the
match card.
Figure 3 on the following page shows a default card. Do not give a default card
to the players as if it were a match card. The default card is to tell you that Zermelo

Figure 1. Match card
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Figure 2. Filled-in match card

Figure 3. Default card

Figure 4. Discard card
thinks one (or both) of the players (or teams) in the match should be defaulted.
The player (or team) who should win the match by default is printed in bold. You
should call the player who is about to be defaulted over the public-address system.
If the player does not materialize, you can default them by circling the name of the
winner (i.e., the name in bold), writing “default” on the default card, and putting
the card in the computer-desk’s inbox so that the computer-desk person can enter
the result. If the match is a double default, then don’t circle either player and write
“double default” on the card.
Figure 4 shows a discard card. A discard card is a note to you that a previously
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Figure 5. Log window after call

printed default card should be thrown out. A typical reason that this happens is
if Zermelo prints a default card for a player who has not checked in and you then
check the player in. When you throw out the default card, you should also throw
out the discard card.
The time in parentheses to the right of the match coordinates on the third line
of a match, default, or discard card is the time that the card was printed. This is
purely for your information. It is handy, for example, if you are looking through
a box of completed match cards for a match that you know was played two hours
ago.
Zermelo prints cards four to a page for letter and A4 paper (six to a page
for legal paper). A rigid ruler makes a fine paper cutter. After the match cards are
printed and cut apart, call the names of the players over the public-address system.
(However, see Section 1.1 on the following page for the effect of unchecking the
Manage match calling check box.)
When a player comes to the control desk in response to hearing their name
over the public-address system, put a check mark next to the player’s name on the
match card. When you have both players for a match (or four for a doubles match),
put the match card on a clipboard and give it to the players. Since the clipboard
has the table number on it, it tells the players which table to play on.
The best way to deal with balls is to put a ball on each table first thing in
the morning and announce over the public-address system that the players should
leave the ball on the table when they finish their match.
Zermelo lists each card printed in the log window. Zermelo also writes in the
log window a count of the number of each type of card that it is printing. In
addition, Zermelo figures out how many queued matches there are, i.e., how many
additional matches it could have called if there were enough tables or clipboards.
If there are any queued matches, then Zermelo writes how many there are to the
log window. This is particularly useful if you are trying to decide whether to use
double clipboards. Figure 5 shows an example of the log window after doing a
Call. See Section 8 on page 118 for the settings that Zermelo uses to determine
how many matches to call.
The Call menu item will only call matches in event stages that are selected in
::Events > Modify > Edit > Search > Stages. See Section 1.2.10 on page 69.
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You can control the order in which Zermelo calls matches via ::Matches > Modify Calling and ::Events > Modify > Edit > Search > Order. See Section 8 on page 118
and Section 1.2.10 on page 69.
1.1. Effect of Unchecking Manage-Match-Calling. This section explains how
the Call menu item is different when the ::Matches > Modify Calling > Manage
match calling check box is unchecked. See Section 8.1 on page 119 for more information.
When deciding whether to call a match, Zermelo will ignore the event starting
time, whether the players are at the tournament or are playing, how many tables
and clipboards there are, and how many matches are already playing. The result is
that Zermelo will print match cards for all matches in drawn events, and will never
print a default card.
Zermelo will search the events in the order given by the ::Events > Modify >
Edit > Search > Order field, but if two events have the same value for the Order
field, then Zermelo will search the events in order of the event ID, which is probably
what you want.
For an event with multiple round-robin groups, Zermelo will search all of each
group, then search the next group. When printing the match cards for a roundrobin group, Zermelo will start a new page with the first match card in the group
and after the last match card in the group. In other words, the pages containing
match cards for the group will not contain match cards for any matches not in the
group.
Zermelo will print the order-of-play sequence number on each round-robin
match card. The sequence numbers are determined by the slots that appear on
the draw sheet and do not take into account any byes. For example: Suppose one
group consists of players in slots 1 through 4. Suppose another group consists of
players in slots 1, 2, and 4 (so slot 3 has a bye). The sequence numbers for the
matches between players 1, 2, and 4 will be the same in the two groups.
Even if the Manage match calling check box is unchecked, Zermelo will only
call matches in event stages that are selected in ::Events > Modify > Edit > Search >
Stages.
The Manage match calling check box has no effect on whether Zermelo will
autodraw an event.
1.2. Fixing Problems. Zermelo tries to make sure that the printer is online
before printing. However, if for some reason the cards do not actually print, you
can use the list of cards in the log window to undo them (using ::Matches > Undo
One), fix the printer, and then try again.
If you do a call by mistake, you can uncall the matches via ::Matches > Undo
One.
If Zermelo calls matches in an event that you don’t think has started or doesn’t
call matches in an event that you think it should be calling, check that you have
the correct start day and time for the event and that your computer has the correct
date and time.
1.3. Play a Match Later. Once in a while, Zermelo will call a match that you
would prefer to play later. Almost always, this happens because not all the players
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Figure 6. Enter-result window
are available for the matches that you would prefer to play, e.g., they are playing
other matches, not checked in, or out to lunch. (Another reason this might happen
is that the search options are not set the way that you would prefer, but this is less
likely.)
One way to handle this situation is to undo the match, then mark one of the two
players out to lunch. When one of the player’s other opponents becomes available,
mark the player as being back from lunch and do a call.
Another way to handle this situation is to just hold the match card at the
control desk. If you do this, then Zermelo won’t call any other matches for either
player. When one of the players’ other opponents becomes available, you can undo
the match you don’t want to play and do a call.
A third way is to undo the match and use ::Matches > Call One to force out
another match for one of the players. Since the player’s opponent presumably
isn’t available (or Zermelo would have called the match), you will have to hold the
match at the control desk until the opponent becomes available. This last option
will only work if the opponent is unavailable because they are playing. If they are
not at the tournament, Zermelo won’t print the match card.
2. Enter Result
The Enter Result menu item brings up a window (Figure 6) that lets you enter
match results. This menu item and the Call menu item are the items that you will
use the most during a tournament. The Enter Result menu item will be disabled if
no events are drawn.
Note in the figure that the labels for the fields indicate that three of the four
fields serve two purposes. If the match is in a round-robin group, then the fields
are the event, group, row, and column. If the match is in a single-elimination
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bracket, then the fields are the event, round, match, and zero (i.e., you must put
“0” in the Column/0 field). The numbers to enter into the fields are printed on the
top of each match card just above the players’ names (see Figure 1 on page 107).
After you’ve entered appropriate values in all four fields, click the Display button.
Zermelo will then display the players in the match. The numbers in parentheses
are the tournament player ID numbers.
As in the Swap Slots window, the Cancel button is the default button only until
you start to enter a value in one of the fields. Once the Cancel button is no longer
the default button, the ⟨Enter⟩ key will work more like the ⟨Tab⟩ key, i.e., it will
generally move the focus to the next control.
When you press the ⟨Enter⟩ key, Zermelo tries to be smart about when to display the players and which field or button to move to next. If you have entered
values in all four match coordinate fields and the Column/0 field has the focus,
then pressing the ⟨Enter⟩ key will click the Display button. This saves you one
keystroke since normally you would have to press ⟨Enter⟩ (or ⟨Tab⟩) to move the
focus to the Display button and then press ⟨Enter⟩ again to click the button. If
you have just checked one of the player check boxes and you press ⟨Enter⟩, then
Zermelo moves you to the first Score field. If you’ve entered a complete result and
you press ⟨Enter⟩, Zermelo moves you to the OK button.
When entering scores, you only enter the number of points scored by the loser
in the game. (Knowing this, you can determine the number of points scored by the
winner.) If the winner of the match lost the game, then you prefix the number of
points with a minus sign (i.e., hyphen). The scores will also be displayed this way
on the draw sheets. For example, the score 11–7, 12–10, 6–11, 0–11, 14–12 will be
entered and displayed on the draw sheet as 7, 10, −6, −0, 12.
It is probably most convenient to enter results using the numeric keypad without looking at the screen. (The behavior of the ⟨Enter⟩ key is designed to make this
simple.) For example, to enter the result in Figure 6 on the previous page, type
1⟨Enter⟩7⟨Enter⟩1⟨Enter⟩0⟨Enter⟩1⟨Enter⟩7⟨Enter⟩10⟨Enter⟩−6
⟨Enter⟩−0⟨Enter⟩12⟨Enter⟩

Note that when the player check boxes have the focus, typing “1” or “2” will check
the corresponding box.
Once you’ve entered all the information, compare what is on the screen with
what is on the match card. If they agree, press ⟨Enter⟩ to select the OK button and
store the result. Zermelo will clear the window, but leave it up so you can enter
another result (unless all events are finished, in which case, the window will close).
If you do not have any more results, you can press ⟨Enter⟩ to select the Cancel
button (which is again the default button now that the window is clear) to close the
window.
If several results come back at the same time, it is generally best to enter all of
them before doing ::Matches > Call. This lets Zermelo find the best match to play
next according to the search parameters you have set. (However, if there are tables
empty, then getting a new match card out is more important than entering a bunch
of results.)
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Figure 7. Default result being entered
The Enter Result menu item has two shortcut keys: ⟨R⟩ and ⟨+⟩. The latter
is handy because it lets you bring up the Enter Result window using the numeric
keypad.
To enter a result that is a default, check the Default check box instead of
entering a score. Figure 7 shows a default being entered. If the match is a double
default, then check the Default check box, but don’t check either of the player
check boxes. Typing “.” toggles the Default check box (this lets you use the numeric
keypad to enter defaults).
Zermelo will not accept partial scores, as will happen if a match is started, but
not completed due to a player being injured. If this happens, just make up a score.
Do not enter it as a default. Defaults do not count for ratings. Matches stopped in
the middle count for ratings if and only if one of the players is able to continue,
i.e., the player who can continue gets credit for the win.
Normally, you will enter results from an already printed match card or default
card. However, you can also enter the result for a match even though no match
card or default card has been printed for the match. If you do this, Zermelo will
display the words “Not Called” in the bottom-left corner of the window. If you
enter a result from a default card, Zermelo will display the words “Default Card”.
Note that for round-robin groups, the row number must be less than the column
number, i.e., you must use the cell in the top-right half of the group rather than
the cell in the bottom-left half. If the event is a “RR”-format event, then the single
round-robin group is group number 1. In a “RR to RR”-format event, the final
round-robin group is group number 0.
If you enter a result incorrectly, you can just enter the result again. However,
if a subsequent match has been called or played, then you must, in general, undo
the subsequent match via ::Matches > Undo One and then correct the result. The
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Figure 8. Call-one window

exception to this is that if the only thing you want to change is the score, then
you can use Enter Result even if a subsequent match has been called or played.
The exception to this exception is if the match is in a round-robin group and any
of the players that advanced from the group have played. In this case, you cannot
change the score this way. (The reason is that conceivably the change in score could
affect who advanced from the group and Zermelo isn’t smart enough to figure out
whether the changed score makes a difference.) You will have to undo the matches
that the advancers have played, change the score, then reenter the results for the
matches that the advancers have played.

3. Call One
Almost all of the time you will use ::Matches > Call to print match cards. However, if you want to play a particular match, you can use ::Matches > Call One.
Figure 8 shows the window that Zermelo displays. You enter the match coordinates just as you would in the Enter Result window. The Call One menu item will
be disabled if there are no events that are drawn and not finished.
It is OK if some of the players are playing. However, Zermelo will normally
refuse to print a match card if any of the players are not at the tournament (i.e.,
::Players > Modify > Edit > Status > Check in is not “Here Now”). If a player is
not at the tournament or is playing, Zermelo will display this information to the
right of the player’s name (e.g., see Figure 9 on the facing page). If the player is
at lunch, Zermelo will display when they went to lunch. If any of the players are
not at the tournament, then Zermelo will display “Default Card” in the bottom-left
corner of the window. This means that if you click the OK button, Zermelo will
print a default card, not a match card. (However, see Section 3.1 on the next page
for the effect of unchecking the Manage match calling check box.)
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Figure 9. Calling a default card
When you do Call One, Zermelo will ignore the event starting time, how many
tables and clipboards there are, and how many matches are already playing. So,
you can call a match regardless of how many matches you already have playing.
If you lose a match card or a match card gets mangled, you can generate a new
one by undoing the match (via ::Matches > Undo One) and then calling the match
(via ::Matches > Call One).
3.1. Effect of Unchecking Manage-Match-Calling. If the ::Matches > Modify
Calling > Manage match calling check box is unchecked, then Zermelo will print
a match card rather than a default card. See Section 8.1 on page 119 for more
information.
4. Call Stages
The Call Stages menu item brings up a window (Figure 10 on the next page)
that lets you call matches in the event stages that you select. The menu item will
be disabled if there are no events that are drawn and not finished or the Manage
match calling check box is checked and ::Events > Modify > Edit > Search > Stages
is “All” for all events.
To select a stage, type an event number in the Event > ID field and select the
stages in the Event > Stages field. Alternatively, select the stages in the Events
check list. Or, do both. Or, check the All check box to call all the stages listed in
the Events check list. The Events check list will only list events and stages that have
matches to call.
Normally, you can only select stages that are not selected in ::Events > Modify >
Edit > Search > Stages. So, this menu item is for calling matches in stages that you
have excluded from the normal search that Call does. (However, see Section 4.1
on the following page for the effect of unchecking the Manage match calling check
box.)
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Figure 10. Call-stages window
Normally, when you do Call Stages, Zermelo will only call matches where all
the players in the match are at the tournament, i.e., ::Players > Modify > Edit >
Status > Check in is “Here Now”. If a player is not at the tournament, Zermelo
will print a default card. (However, see Section 4.1 for the effect of unchecking the
Manage match calling check box.)
For a stage with multiple round-robin groups, Zermelo will search all of each
group, then search the next group. When printing the match cards for a roundrobin group, Zermelo will start a new page with the first match card in the group
and after the last match card in the group. In other words, the pages containing
match cards for the group will not contain match cards for any matches not in the
group. Zermelo will print the order-of-play sequence number on each round-robin
match card.
If you did Call Stages and some of the match cards did not print because a
player was not at the tournament or because it is the second stage of the event
and the players in the match had not yet been determined, you can do Call Stages
again once the match is ready.
Zermelo will ignore the event starting time, whether the players are playing,
how many tables and clipboards there are, and how many matches are already
playing.
4.1. Effect of Unchecking Manage-Match-Calling. If the ::Matches > Modify
Calling > Manage match calling check box is unchecked, then you can select any
stage in any event.
If the Manage match calling check box is unchecked, Zermelo will ignore
whether the players are at the tournament.
5. Call Some
The Call Some menu item brings up a window (Figure 11 on the facing page)
that lets you specify how many matches you would like Zermelo to call. The menu
item will be disabled if there are no events or if the Manage match calling check
box is unchecked.
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Figure 11. Call-some window

Figure 12. Undo-one window
Type the number of match cards that you want to call in the Match cards field.
Zermelo will do a call just like it does if you use the Call menu item. But, rather
than using the values for tables and clipboards in ::Matches > Modify Calling and
the number of matches that are playing to determine how many matches to call, it
will use the value that you enter.
This menu item is mainly for use when you are using ::Events > Modify > Edit >
Search > Stages to exclude stages from the normal call and are using the Call
Stages menu item to call those stages. If you are doing that, then Zermelo does
not know how many matches are really playing and so may think there are fewer
tables or clipboards available than there really are. So, you can use this menu item
to call the number of matches that you really need.

6. Undo One
The Undo One menu item brings up a window (Figure 12) that lets you undo
one match. This lets you correct results that you have entered incorrectly or uncall
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Figure 13. List-matches-playing output
matches that were called by any of the “call” menu items. You enter the match
coordinates just as you would in the Enter Result or Call One windows.
You can undo a match if you’ve entered a result or if a match or default card
has been printed. When you undo a match, the result is as if the match had never
been called and no default card printed. When you undo a match, you should throw
out any match or default cards for that match (unless, of course, you are undoing a
valid match to correct a preceding result that you entered incorrectly; in this case,
keep the match card that has the result!).
You cannot undo a match if a subsequent match has been played (i.e., the
result entered) or is playing (i.e., the match card printed). In these cases, undo the
subsequent match first, then undo the preceding match. In other words, you must
undo one match at a time. (The purpose of this restriction is to make it less likely
that you will do something that will confuse both you and Zermelo.)
On the other hand, you can undo a match if a subsequent match was defaulted.
That is, Zermelo will automatically undo subsequent defaults.
You can also undo a match if a default card has been printed for a subsequent
match. In this case, the next time that you do Call or Call Some, Zermelo will print
a discard card for the default card. If you prefer, you can avoid getting the discard
card by undoing the default card first.
7. List Playing
The List Playing menu item writes a list to the log window of the match cards
and default cards that are outstanding (see Figure 13). For each card, Zermelo
shows the time that the card was printed. The cards are listed in the order of
these times. If the card is a default card, the words “Default Card” appear after
the match coordinates. If the result for the match is overdue (see Sections 5.1
on page 22 and 8.6 on page 123), the word “Overdue” appears after the match
coordinates. The menu item will be disabled if there are no drawn events.
8. Modify Calling
The Modify Calling menu item brings up a window (Figure 14 on the next
page) that lets you modify what Zermelo does when you do ::Matches > Call or
::Matches > Call Some. The Manage match calling check box affects those menu
items and also affects ::Matches > Call One and ::Matches > Call Stages.
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Figure 14. Modify-calling window

8.1. Manage Match Calling. Normally, Zermelo only calls matches in events
that have started and for which the players are at the tournament and are not playing. In addition, Zermelo keeps track of how many matches are playing and won’t
call additional matches if there are already enough matches playing. However, if
you need to manage the calling of matches yourself, rather than having Zermelo do
it, uncheck the Manage match calling check box. For example, if you time schedule
your tournament (see Section 4 on page 21), then you will need to uncheck this
check box. If you do not time schedule your tournament, then your tournament
will run more smoothly and expeditiously if you check this check box. If you are
considering unchecking this box because your tournament has round-robin groups,
see Section 4.1 on page 22.
Unchecking the Manage match calling check box affects ::Matches > Call,
::Matches > Call One, and ::Matches > Call Stages. For the effect on Call, see Section 1.1 on page 110. For the effect on Call One, see Section 3.1 on page 115. For
the effect on Call Stages, see Section 4.1 on page 116. Unchecking the check box
disables ::Matches > Call Some.
If Manage match calling is unchecked, then the rest of the fields in the modifycalling window are irrelevant and will be disabled.
If Manage match calling is unchecked and there are any match cards outstanding for players whose status is not “Here Now”, then you will not be able to check
the Manage match calling check box. In other words, to switch back to having Zermelo manage the calling of matches, you must not have any match cards outstanding for players that are not at the tournament (you can either check the players in,
undo the matches, or enter results or defaults for the matches).
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8.2. Tables, On-Deck Matches, Double Clipboards. The Tables, On-deck
matches, and Double clipboards fields control how many match cards Zermelo will
print when you do ::Matches > Call.
Set the Tables field to the number of tables you have (not counting practice
tables, if any).
While you only need as many match cards as you have tables, the control desk
is less hectic if you have some extra match cards all ready. This way, when a match
is finished, you don’t need to enter the result immediately before you can get a
new match card and call the players over the public-address system. You specify
how many extra match cards you want in the On-deck matches field. One third the
number of tables is a good value, but use more if you feel the need. Keep the extra
match cards sorted in the order that they were printed and call the matches in that
order.
Normally you won’t want to use a very large value for On-deck matches (with
the idea of having all the match cards printed and ready), because you’ll end up
playing matches in a less than ideal order (where “ideal” means the tournament as
a whole will finish as quickly as possible). However, there are times when it may
work better to use a large value. For example, if each player can only enter one
event, then a small value may result in the events that are searched first getting
ahead of the events that are searched last. Using a large value will ensure that all
players are playing without any having to wait too long for their next match. If you
have enough time, this may be a more important goal. However, to deal with this
problem, it is probably better to change Method to “Round”; see Section 8.4 on the
next page.
Sometimes tournaments can be hectic. If you find yourself trying to do several
things at once (e.g., entering results, helping registration, entering players into
doubles events) and so having a hard time printing enough match cards to keep
the tables in use, bump up the On-deck matches value to a large value, and print out
a bunch of match cards. This will give you some breathing space to do other things
while keeping the tournament going. When you’ve dealt with the other things, you
can bump the On-deck matches value back down.
You’ll need to have a clipboard for each table. Each clipboard must have the
table number written on it in large numerals so that the players will notice it. It also
helps to have the table number written both near the bottom of the clipboard and
also at the very top. This way the numbers can be seen if you have the clipboards
stacked up on the control desk. 9′′ by 6′′ clipboards work well. Larger ones take
up too much space on the control desk. You also should attach a pen to each
clipboard. Pens that are connected to an adhesive base via a coiled elastic work
well. Bring some adhesive mounting squares to reattach the pens if they fall off.
If you have lots of matches to play, double clipboards is the best way to keep
the tables in use. With double clipboards, you have two clipboards for each table.
If the players see that there is a match currently playing on their assigned table
(i.e., they see that the players playing have a clipboard), they simply wait until it is
finished, then play their match. At the control desk, you should keep the clipboards
sorted in order of the time that they came back to the desk so that, when sending
out new matches, you can use the clipboard that has been there the longest (since
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the match playing on that table is closest to being finished). You also need to check
that you don’t have both clipboards for a table at the control desk. If you do, you
need to give out one of them next (since the table is not being used) and put the
other at the bottom of the pile. There is no point doing double clipboards if you
can only send out a few more matches than you have tables. In fact, if you have
only a few more matches than tables, using double clipboards is a bad idea because
the table where the players are waiting may not be the one that frees up next. So,
at some point in the day, you will need to drop back to a single set of clipboards.
If you are using double clipboards, check the Double clipboards check box. If
this is checked, Zermelo will send out as many matches as twice the number of
tables plus the on-deck matches. If you are using double clipboards, you probably
want to set On-deck matches to zero.
If you are not using double clipboards, it is a good idea to get ahead by calling
the players for one more match than you have clipboards for. When the players
come to the control desk, tell them that they have the next table and to please wait
right there.
8.3. Default Times. The Default times fields determine when Zermelo will
print a default card for a match. The Event time is the amount of time (entered
as hours and minutes, i.e., h:mm) after the event’s start time that Zermelo will wait
before printing a default card for the match of a player who hasn’t checked in. The
Lunch time is the amount of time that a player can be at lunch before Zermelo will
print default cards for the player’s matches. For players who are at lunch, Zermelo
also checks the Event default time: If a player is at lunch, the player must have
been at lunch too long and the default time for the event must have arrived before
Zermelo will print a default card.
Don’t set these times to too large a value since the only way Zermelo will
remind you if you’ve forgotten to check a player in is by offering to default the
player. For more information, see Section 1 on page 107.
8.4. Method. The Method drop-down list lets you choose how Zermelo
searches for matches to call when you do ::Matches > Call. The choices are
“Round”, “Event”, “Round > Event”, “Time-Round”, “Time-Round > Time-Event”,
“Time-Round > Event”, and “Match”.
If the search is by “Event”, then Zermelo searches all of each event before
searching the next event. The order in which the events are searched is determined by ::Events > Modify > Edit > Search > Order (see Section 1.2.10 on page 69).
When searching an event, Zermelo first checks all the first-round matches, then the
second-round matches, etc.
If the event has round-robin groups, then Zermelo searches the groups according to the order of play in Appendix B on page 141. If there is more than one group
in the round, then Zermelo checks the first match (according to the order of play)
in each group, then the second, etc. In this case, the search order is the search
order for the largest group in the round, with the smaller groups effectively having
byes for the additional players.
Zermelo numbers rounds in single-elimination brackets so that the final match
is always round 9, regardless of how many rounds the event has. The semifinals
are round 8, etc. The most rounds that a single-elimination event can have is eight,
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so the first possible round is 2. For purposes of searching, any round-robin groups
are considered to be in round 0, with the exception that the final group in “RR to
RR”-format events is considered to be round 1. If the search is by “Round”, then
Zermelo searches the round 0’s in all of the events, then the round 1’s, etc. When
searching a given round number, Zermelo searches the events in the same search
order that it would use if searching by event. It searches the entire round in the
event, then moves on to the next event.
If the search is by “Time-Round”, then Zermelo searches the events in order of
their starting time. If there is more than one event starting at a certain time, then
the events starting at that time are searched by round.
If the search is by “Time-Event”, then Zermelo searches the events in order of
their starting time, but if there is more than one event starting at the same time,
then those events are searched by event.
If the search is by “Round > Event”, then Zermelo first searches by round. If
the number of matches that could be played is only enough to fill up the tables
(or, if Double clipboards is unchecked and On-deck matches is zero, the number of
matches is not enough to fill up the tables) Zermelo doesn’t call any of the matches
from the search by round, but instead searches by event.
The “Time-Round > Time-Event” and “Time-Round > Event” are analogous to
the “Round > Event” search. That is, Zermelo does the search using the first specified method, but if there aren’t enough matches that could be played, Zermelo
redoes the search using the second specified method.
If the search is by “Match”, then Zermelo checks each match in all the events,
then checks the next match, etc. This is probably most useful if you are running
a giant round-robin tournament. For round-robin groups, "each match" means
according to the round-robin order of play for that event. The first match in the
order of play will be checked in all groups in all events, then the second match,
etc. Note that the order of play is different if one player advances from a group
than if two players advance, so the “first match” is also different. Also, the order of
play that is used for all groups will be the order of play for the largest group in all
events, with the smaller groups effectively having byes for the additional players.
Generally, searching by round is good if there are enough matches to fill up
the tables. If there are more tables than matches, then searching by event from
the highest-rated event down to the lowest-rated event is more likely to free up
players so that more matches can be played at the same time. Thus, if you want the
tournament to end as soon as possible, “Round > Event” is the way to go. However,
this can result in a small event whose start time is early in the day not having its
matches called until late in the day. Thus, “Time-Round > Time-Event” is a good
compromise between getting the matches all played and playing the matches in the
order of the event starting times. “Time-Round > Event” is a bit more aggressive
than “Time-Round > Time-Event” in trying to get more matches to play once the
tables can’t be kept full.
For the search by time options to work well, you should start events in bunches,
i.e., with several events starting at identical times. If all the events start at different
times, you’ll just be searching by event with the search order determined by the
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starting times. Starting events in bunches generally makes it easier for the registration desk to register players rather than having a constant stream of players all
day. See Section 1 on page 151 for more discussion of what starting times to use
for events.
8.5. Play Doubles First, Finals Last. If Doubles first is checked, then Zermelo
searches all doubles events before searching any singles events when searching by
“Round” or by “Time-Round”. The idea here is that it is harder to get all the players
available for a doubles match, so if you don’t search those events first, the doubles
will end up being played after all the singles are done. Note that even if the search
is by “Time-Round”, all doubles will be searched before all singles, regardless of
their starting times.
If Finals last is checked and the search is by “Event”, then Zermelo searches
the non-finals of all the events, then searches the finals of all events. (Here, “final”
means the final match in a single-elimination bracket, not matches in a final roundrobin group.) The idea here is that suppose A has to play B in the final of an event
and the winner of A and C has to play D in the final of another event. If C beats A,
you can play both finals at once, but if you play the A vs. B match first, then you’ll
have to play the three matches one at a time.
If the search is by “Time-Event”, then the Finals last check box only affects
the search within those events that start at the same time, e.g., finals of 2:00 p.m.
events will be searched before non-finals of 4:00 p.m. events, regardless of whether
Finals last is checked.
8.6. Result Overdue Time. The Result overdue time field determines how long
after a match card is printed that Zermelo considers the match result to be overdue.
Enter the length time into the field as hours and minutes, i.e., h:mm. Zermelo
displays how many results are overdue in the overdue-results pane of the main
window’s status bar (see Section 5.1 on page 22). To find out which results are
overdue, do ::Matches > List Playing (see Section 7 on page 118).

CHAPTER 11

Club Browser
This chapter is only relevant for Ratings Central tournaments.
The club browser (Figure 1) lets you view the Ratings Central club list and select
the club for the tournament or for a player. You can bring up the club browser from
the Club > Change button of the tournament window (::Tournament > Modify) or
the Edit pages of the player notebook (::Players > Modify). The club browser is also
accessible via the ::Lists > Browse Club menu item.
The grid works like Zermelo’s other grids (see Section 10 on page 167). The
Find field lets you search for a specific club. It works like Zermelo’s other
incremental-search fields (see Section 10.1 on page 168).
If you’ve brought up the club browser by clicking the tournament or player
Club > Change button, then the Select Club button will be enabled. Click this
button to make the club that is selected in the grid the club of the tournament or
player.

Figure 1. Club browser
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CHAPTER 12

Control and Registration Desks
You will need a control desk, a registration desk, and a computer desk at the
tournament. This chapter describes how you should set up these desks and some
of the procedures you should follow when using Zermelo to run your tournament.
Of course, in some sense, this entire manual is about tournament procedures.
It is simplest if the three desks are on the same table. Put the computer desk
in the middle, the control desk (clipboards and public-address microphone) on one
side, and the registration desk (cash box, membership forms, scrap paper, pens)
on the other side. The desks should be close enough that the people running them
can easily talk to each other and pass each other match cards and notes.
Tape a copy of the registration list (printed via ::Players > Print Lists > Registration list) and a copy of the entry form to the registration desk. If you have
doubles, tape a piece of paper to the registration desk on which to write doubles
entries. Tape another copy of the entry form to the computer desk. You will need
a couple of rigid rulers; these make excellent paper cutters (the match cards are
printed three to a page, so you need to cut them apart). Place a medium-size box
or plastic bin on the floor under the computer desk; completed match cards go
here after being entered into the computer. Place a shallow box, bin, or tray on
the computer desk; this is the inbox for the computer desk. You can also have
an inbox for the control desk in which the computer-desk person puts new match
cards, although this box is less essential.
When players turn in their completed results to the control desk, check that the
match card is filled out correctly (i.e., the winner is circled and the score shows the
circled player as winning), then place the match card in the computer-desk inbox.
The computer person takes the match card from the inbox, enters the result into
the computer, then places the match card in the bin on the floor.
The computer-desk inbox is also the place where the registration-desk person
places notes for the computer-desk person. For example, suppose player 7 adds
event 2. After taking the player’s money, write a note that says “7 add 2”, and place
it in the computer-desk inbox. Or, if player 23 says they are going to lunch, write a
note that says “23 out to lunch”. If a new player arrives who did not pre-register, it
is usually simplest if the computer-desk person and registration-desk person deal
with the player at the same time. The computer-desk should look up the person
in the rating list to determine the player’s rating and, for USATT tournaments, the
USATT membership expiration and should then add the player to the tournament.
Be sure to set the player’s Status > Check in to “Here Now”. The registration-desk
person should write the ID number and name of the new player at the bottom of
the registration list.
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It is a good idea to always get the tournament started on time. Even if registration is going slowly and many players haven’t checked in yet, start calling matches.
It is much better to play some matches than to have everyone waiting. To start
calling matches, simply have the registration-desk person stop registering players
for a minute and follow the check-in procedure described in Section 4.4 on page 93
to tell Zermelo which players have checked in. You can then do ::Matches > Call,
assuming you’ve already drawn the events or have the events’ Draw field set to
“Auto”. Note that there is no need to check that all the players in an event have
shown up. Zermelo will not call matches involving players that have not checked
in. When the default time for the event arrives (see Section 8.3 on page 121), if a
player in the event has not checked, Zermelo will let you know by printing a default card. If you know that registration is way behind, you will want to increase the
event default time to avoid Zermelo printing a bunch of default cards for players
who are standing in line to register.
How many staff people you need depends on how many entries you get and
how many tables you have. The number of people you need will also vary during the day. You can have a computer-desk person, a control-desk person, and a
registration-desk person. When players are arriving to check in, you will probably
find that you need at least a computer-desk person and a registration-desk person
(with the two sharing the control-desk duties). At other times, one person may be
able to handle all three roles. Of course, at those times, you do not need to write
so many notes, but can just enter the information directly into the computer.
Stuff to bring to the tournament:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Public-address system
Duct tape (for taping down microphone and power cords)
Masking tape
Pens
USATT Membership forms
Clipboards
Computer
Printer and extra ink or toner cartridge
Plenty of printer paper
Rulers for tearing paper
Cash box
$1’s and $5’s for change
Trophies and prize money
Medium-size box or bin for recorded match cards
Shallow bin or tray for computer-desk inbox
Net height measurer
Rule book
Balls

CHAPTER 13

Unrated Players
This chapter is only relevant for Ratings Central tournaments.
When Ratings Central processes a tournament, it first assigns a prior mean and
standard deviation to each unrated player in the tournament. The adjective “prior”
means that it is the player’s mean and standard deviation prior to the start of the
tournament. If you entered a prior mean and standard deviation for the player (in
::Players > Modify > Edit > Unrated prior), then it uses those values. If you didn’t
enter a prior mean and standard deviation for the player, then it uses the prior
mean and standard deviation that you set for the tournament (in ::Tournament >
Modify > Unrated prior). Note that it never uses the player’s rating (in ::Players >
Modify > Edit > Rating) for the prior.
The following sections explain how to set the individual player prior means
and standard deviations and the tournament prior mean and standard deviation.
This will give you an idea of how the system works. However, it isn’t easy to set
good priors. You must get our approval for the approach that you will use to
set priors! To get our approval, contact us; see https://www.ratingscentral.com/
Problems.php for our email address.
Please get unrated players at your tournament as many matches with rated
players of a similar playing level as you can. This will make the resulting ratings
for these players more accurate.

1. Rating Scale
The Ratings Central rating scale (i.e., what playing strength a number corresponds to) is not the same as the USATT rating scale or any other organization’s
rating scale. Unfortunately, you cannot reliably convert a USATT rating to a Ratings
Central rating because USATT ratings are inflating, have regional differences, and
vary widely in accuracy. All we can say is that a player’s USATT rating will often
(but not always) be significantly greater than their Ratings Central rating. To help
you understand the Ratings Central rating scale, we have provided videos on the
website at https://www.ratingscentral.com/Videos.php.
Ratings Central uses the same rating scale for all the table tennis sports (Table
Tennis, Hardbat Table Tennis, Sandpaper Table Tennis). If a Table Tennis player
who plays with an inverted sponge racket or a pips-out sponge racket plays Hardbat Table Tennis (with a hardbat, of course), we would expect their rating as a
Hardbat Table Tennis player to be 200 points lower than their Table Tennis rating.
If they play Sandpaper Table Tennis, we would expect their rating as a Sandpaper
Table Tennis player to be 250 points lower than their Table Tennis rating.
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2. The Fewer Priors the Better
Priors are necessary, but the fewer priors, the better. Every time you set a
new player prior or tournament prior, you are adding new parameters to the rating
system model. Each new parameter may be wrong or may have unintended consequences. The best approach is to determine a single prior that describes your
entire population of players, then use that single prior as the tournament prior for
all your tournaments and not use player priors. If there isn’t sufficient mixing (i.e.,
players of different levels playing each other), this may not work, in which case you
will have to use different priors for subpopulations.
If you are just starting to use Ratings Central, and so most of your players
are unrated, you may find that if you use one prior for everything, it takes a few
tournaments for the ratings to become accurate. It is generally best to live with
such a “burn-in” period rather than try to use priors to make every player have
an accurate rating immediately. Letting the ratings be determined by the match
results rather than by the priors is also fairer. Backloading historical data is a
good way to get things started. Such data can also be used to evaluate the effect of
different priors. We can assist with such investigations.
The following sections explain how to set player priors and event priors. But,
to reiterate, it is best to not use player priors and to use the same event prior for
all your events. If you feel that this won’t work for your situation or if you have
already submitted events and it isn’t working, then contact us for assistance.
It isn’t easy to set good priors. You should get our approval for the priors that
you use.

3. Player Priors
The following advice for setting player priors assumes that you are very familiar with the rating scale, i.e., you know and play with many players who have
established ratings. If this is not true, then you should rely on the event prior and
rarely set individual player priors. Even if you are very familiar with the rating
scale, evaluating individual players takes effort to do well, so relying on the event
prior for some or all players can be simpler, more reliable, and fairer. If you aren’t
sure what to do, please contact us for assistance.
Despite the cautions in the previous paragraph, it can be helpful to set the
player prior mean and standard deviation for an unrated player. However, you
should only set the prior mean and standard deviation for an unrated player if you
have additional information about that player. The “additional information” can be
any information other than the player’s match wins and losses in the tournament
(Ratings Central sees those). For example, you might know the player from before
the tournament or you might watch the player play their matches or you might
look at how many points the player scored in their matches.
If a player is different from the general population of unrated players at the
tournament, e.g., much better or much worse (perhaps because they are very
young), then it is probably a good idea to set the player’s prior mean and standard deviation, rather than trying to stretch the tournament prior to include the
player.
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If many or most of the players in your tournament are unrated, and so the
unrated players are playing mostly other unrated players, then it is probably a
good idea to set the prior mean and standard deviation for some or many of the
unrated players.
The prior standard deviation for a player measures how sure you are that you
know that player’s playing strength. You should be willing to bet at 1:2 odds that
the player’s playing strength is within one standard deviation of the mean, and you
should be willing to bet at 2:1 odds that the player’s playing strength is more than
one standard deviation from the mean. (Odds of 1:2 mean that you win $1 if you
win the bet, but you lose $2 if you lose the bet. Odds of 2:1 mean that you win $2
if you win, but you lose $1 if you lose.)
For example, suppose you assign a prior mean of 1200 and a prior standard
deviation of 100 to a player. Then you should be willing to bet at 1:2 odds that
the player is really between 1100 and 1300, and you should be willing to bet at 2:1
odds that the player is really less than 1100 or more than 1300. Equivalently, you
should believe that there is a 2/3 chance that the player is really between 1100 and
1300 and a 1/3 chance that the player is really less than 1100 or more than 1300.
Here are some very rough guidelines: If you know an unrated player extremely
well (e.g., they’ve been playing at your club every week for a couple of years), then
you might use a prior standard deviation of 100. If you only know a player moderately well (e.g., they came to your club a few times and played several matches with
players of a similar level), then you might use a prior standard deviation of 125. If
you know very little about a player (e.g., you had the player hit with a rated player
of a similar level for five minutes), then you might use a prior standard deviation
of 175.
Be cautious using low values for prior means or for prior standard deviations,
as these can pull the ratings of other players down or make it difficult for a player’s
rating to change. It is harder to estimate the level of players below 1000 because
these players are less consistent. So, you should use larger standard deviations for
such players than you would otherwise. But, see Section 5 on the next page.
If a player has a USATT rating, then that is a source of information. However,
for the reasons mentioned above, it is not possible to simply convert USATT ratings
to Ratings Central ratings. You will have to use your judgment in how you let a
player’s USATT rating influence the prior mean and standard deviation that you
use. It is unlikely that you will want to use the player’s USATT rating as the prior
mean. Do not make the mistake of using too small a standard deviation when
relying on a player’s USATT rating.

4. Tournament Prior
You must always set the tournament prior mean and standard deviation.
While the prior mean and standard deviation for a player measure what you
know of the player’s playing strength, it is best to interpret the tournament prior
mean and standard deviation as describing the range of unrated players at your
tournament. For example, if you think the unrated players range from 800 to
1400, then you would use the average of these two values (i.e., 1100) as the mean
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and the difference of these two values divided by four (i.e., 150) as the standard
deviation.
More precisely, about 2/3 of the unrated players should be within one standard
deviation of the mean (and about 1/3 should be more than one standard deviation
from the mean), 95% should be within two standard deviations, and 99.7% should
be within three standard deviations. So, for the example in the previous paragraph
of a mean of 1100 and a standard deviation of 150, you should think that
• 2/3 of the players are between 950 and 1250,
• 95% of the players are between 800 and 1400,
• 99.7% of the players are between 650 and 1550.
Note that when estimating the tournament prior standard deviation from the
range of players that you expect at your tournament, you should interpret the
range as being plus or minus two standard deviations, not three.
If you set the prior mean and standard deviation for any individual unrated
players, then the tournament prior mean and standard deviation should only describe the population of unrated players for whom you haven’t set individual prior
means and standard deviations. If you set the prior mean and standard deviation
individually for every unrated player at your tournament, then Ratings Central
won’t actually use the tournament prior mean and standard deviation, but you still
have to set them.
It is possible that a player that you thought was rated may become unrated
because of a correction to some other tournament. If this happens, the tournament
prior mean and standard deviation would be used for the player, even though you
thought it wouldn’t be. But, this eventuality is extremely unlikely, so not worth
worrying about.
5. Rating System Floor
While the system allows ratings to range from 1 to 3500, we don’t expect an
adult player to be less than 500. Do not set a player prior or tournament prior such
that the mean minus twice the standard deviation is less than 500 unless you have
first asked us and we have approved it. This applies to both adults and children.

CHAPTER 14

Submitting Tournaments
This chapter is only relevant for Ratings Central tournaments. It describes
what happens when you submit a tournament to Ratings Central. For information
on how to submit a tournament or why the ::Ratings Central > Submit Tournament
menu item is disabled, see Section 2 on page 45.
When Zermelo submits a tournament to Ratings Central, it sends the following
information:
• From the ::Tournament > Modify window: name, start date, state, country,
unrated prior mean and standard deviation, Ratings Central director ID,
password, sport, and club.
• From the ::Ratings Central > Submit Tournament window: your email
address.
• From the ::Players > Modify > Edit notebook page for each player that
played in an event that counts for Ratings Central ratings: name, club,
address 1, address 2, city, state, province, postal code, country, sex, birth,
email, deceased, unrated prior mean and standard deviation, Ratings Central ID, USATT ID, TT Australia ID, and tournament ID.
• All results (including the scores) in events that count for Ratings Central
ratings
An event counts for Ratings Central ratings if the Counts for ratings for. . . > Ratings Central check box on the event edit notebook page is checked.
Note that the values in the Rating and Standard deviation fields (the ones in the
unlabeled box) on the player edit notebook page are not sent to Ratings Central.
The way that Ratings Central handles player information is a bit complicated.
To make the explanation clearer, define the player’s RC-ID-and-rating information
to be the player’s Ratings Central ID and unrated-prior mean and standard deviation. Define the player’s personal information to be the player’s name, club, address
1, address 2, city, state, province, postal code, country, sex, birth, email, deceased
status, USATT ID, and TT Australia ID.
While Zermelo sends both the RC-ID-and-rating information and the personal
information for each player in the tournament to Ratings Central, normally Ratings
Central only copies the personal information for a player to its database if it is the
first time that it has received information for that player. The reason for this is that
suppose that you download a rating list, enter a player from the rating list into the
tournament, don’t make any changes to the player’s personal information that was
on the rating list, and submit the tournament. Also, suppose that in between the
time that you download the rating list and the time that you submit the tournament, some other director makes a change to the player’s personal information.
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If Ratings Central always copied the personal information to the Ratings Central
database, then the old values that you submit would overwrite the changes that
the other director made. Similarly, if you were to make a correction to an old tournament and resubmit it, all the old player personal information would overwrite
the current information.
The exception to this rule of not copying personal information for players already in the Ratings Central database is if you check the New personal info check
box for the player (the check box is on the ::Players > Modify > Edit notebook page).
If you check this check box, it tells Ratings Central that you have updated the
player’s personal information and that Ratings Central should replace the player’s
personal information in its database with the information that you are submitting.
See Section 1.2.15 on page 79 for specific instructions on when you should check
the New personal info check box. You can also update a player’s personal information by logging in to the Ratings Central website. Note that there are special rules
for players with ITTF IDs; see Section 1.2.16 on page 80 for more information.
When Ratings Central processes a tournament, it assigns a Ratings Central ID
number to any player in the tournament who doesn’t have one. You use this Ratings Central ID number to identify the player in subsequent tournaments, typically
by downloading an updated rating list from the Ratings Central website or by entering it in the IDs > Ratings Central field in the ::Players > Modify > Edit notebook
page.
Zermelo and Ratings Central keep track of which player without a Ratings Central ID is assigned which Ratings Central ID, so resubmitting a tournament will
work correctly, even if it contains new players that don’t have Ratings Central IDs.
You only need to use the Ratings Central ID for the player when they play in a
subsequent tournament.
When Ratings Central finishes processing the ratings for the tournament, it will
send you an email like the one in Figure 1 on the next page. If there is a problem
with a tournament that you submit, Ratings Central will send you an email like the
one in Figure 2 on page 136.
Ratings Central will send an email to each player who played in the tournament
to let them know that the tournament has been posted. The email will contain a
link to the results on the Ratings Central website and a link so that the player can
unsubscribe from receiving future emails. Of course, the player will only receive
the email if Ratings Central has the player’s email address. At most one email
will be sent to a player for a given tournament. So, if you resubmit a tournament
(to make corrections), players who were in the first submission will not receive a
second email.
When Ratings Central receives a tournament (or a resubmitted tournament), it
processes the ratings for the tournament and also processes all subsequent tournaments/events that any of the players in the tournament (or in a subsequent
tournament/event that is being processed) played in.
Usually, it takes only a few minutes to process a tournament. However, the
Ratings Central processor may be busy processing other tournaments/events or
may need to process other tournaments/events affected by your tournament, so it
may take longer. It won’t take more than a day.
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From: Ratings Central
Sent: Wed, 30 Jul 2003 21:38:26 -0400
To: David Marcus
Subject: Event processed by Ratings Central
Event: Ratings Central Open
Event date: July 20, 2003
Submitted: July 30, 2003, 9:38 pm
Status: Processed
Thank you for submitting this event to Ratings Central. We have
finished processing it.
Summary report:
https://www.ratingscentral.com/EventSummary.php?EventID=1138
Detailed report:
https://www.ratingscentral.com/EventDetail.php?EventID=1138
Here is the information that we have for you:
Name (Surname, Given): Marcus, David
Email: email@example.com
Director ID: 5044
Title:
Clubs: Boston Table Tennis Club
Address: 25 Beacon St. Apt. 16
City: Somerville
State: Massachusetts
Postal code: 02143-4336
Country: USA
Phone: 617-555-0100
Sport: Table Tennis
If any of this information is incorrect or missing, please log in to the
Ratings Central website to correct it.
Ratings Central
www.ratingscentral.com

Figure 1. Event-processed email

1. Duplicate Players
If you neglect to enter a player’s Ratings Central ID number for a player who
has one (typically because, although the player had played before, you didn’t notice
them listed on the rating list), then when you submit the tournament, the player
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From: Ratings Central
Sent: Wed, 30 Jul 2003 21:13:44 -0400
To: David Marcus
Subject: Incorrect Ratings Central password
Event: Ratings Central Open
Event date: July 30, 2003
Submitted: July 30, 2003, 7:27 pm
Status: Problem
The director’s password is not correct or the director is not authorized.
Ratings Central
www.ratingscentral.com
Figure 2. Problem email
will end up in the Ratings Central database twice, i.e., there will be two Ratings
Central ID numbers that are really the same player.
The way to fix this is to enter the player’s first Ratings Central ID number (the
ID number that you neglected to enter, not the new one) in the IDs > Ratings Central
field and resubmit the tournament. After you do this, the second ID number will
be for a player who has not played at all. The system automatically deletes players
who haven’t played.
Actually, you can keep either of the two player IDs by changing the tournaments/events for the other ID and resubmitting. So, you can keep the second ID, if
that is easier, which it may be if different or multiple directors submitted tournaments/events for the players.
If you need another event director to remove a duplicate, please contact them
directly. If that doesn’t work, please contact us; see https://www.ratingscentral.
com/Problems.php for our email address.

CHAPTER 15

Mistakes and Errors
This chapter discusses Zermelo’s handling of mistakes or errors in what you
type or click. To correct information that Zermelo submitted to Ratings Central,
see Section 2.2 on page 46.
Zermelo checks all values that you enter or selections that you make to ensure
that they are valid and consistent with all other values. On the other hand, Zermelo
almost never asks you to confirm your selections, i.e., it will do what you tell it
without asking you if you really mean it. (Such confirmation dialogs rapidly become
tedious and are often ignored anyway.) If you do make a mistake, Zermelo provides
ways to correct it.
If you enter a value that is not valid, Zermelo displays an error-message window (Figure 1). In this window, you cannot select the Close button by pressing
⟨Enter⟩ or ⟨Space⟩. This is so that you won’t accidentally close the window without
noticing it was there. To close the window, you can click the Close button or press
the ⟨Esc⟩ key. You can also use the standard Windows ways of closing windows,
i.e., click the “×” in the title bar or press ⟨Alt+F4⟩.
You can copy the message to the clipboard via ⟨Ctrl+C⟩. You can select all
of the message text via ⟨Ctrl+A⟩. You can select part or all of the message with
the mouse. Once you click in the message with the mouse, you can use the usual
keyboard keys to change the selection, e.g., ⟨Shift+Right⟩. If part or all of the
message is selected, ⟨Ctrl+C⟩ copies the selected text to the clipboard. If nothing
is selected, then ⟨Ctrl+C⟩ copies the entire message to the clipboard.

Figure 1. Error-message window
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APPENDIX A

Who Was Zermelo?
Ernst Zermelo (1871–1953) was a famous mathematician best known for his
work in set theory. In 1929 (actually 1928, but the journal volume is dated 1929),
he published the paper, “Die Berechnung der Turnier-Ergebnisse als ein Maximumproblem der Wahrscheinlichkeitsrechnung”, Math. Zeit., vol. 29, pp. 436–460
(translated into English and reprinted in Annotated Readings in the History of Statistics, by H.A. David and A.W.F. Edwards, Springer-Verlag, New York, 2001, ISBN
0-387-98844-0). The title of Zermelo’s paper in English is, “The evaluation of tournament results as a maximization problem in probability theory”. In this paper,
Zermelo studies the problem of how to rank players in a “broken-off” chess tournament, i.e., in a round-robin tournament where not all the matches are completed.
Zermelo provides a solution to the problem and a practical algorithm for computing the solution.
If you use Zermelo (the software system), your tournaments will run smoothly
and you will not need to avail yourself of Ernst Zermelo’s algorithm to determine
the winner.
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APPENDIX B

Round-Robin Group Order of Play
If an event has round-robin groups, then Zermelo searches the groups according to the order of play in Section 2.2 of the 2021 ITTF Handbook for Tournament
Referees. If the number of players in the group is odd, then a “bye” player is added
as the last player.
Table 1 on the next page gives the order of play for round-robin groups of
various sizes when one player advances from the group. Zermelo also uses these
one-advancer orders of play for the final group in a two-stage event and for the
only group in a one-stage round-robin event. Table 2 on page 143 gives the order
of play for round-robin groups of various sizes when two players advance from the
group.
By the way, an alternative order of play is given in “A revised method
of deciding the order in a round-robin tournament” by Zhizhong Han, International Journal of Table Tennis Sciences, no. 3, 1996, pp. 135–140, https:
//sasportssience.blob.core.windows.net/ijtts/IJTTS_3_pdf%20files/IJTTS_3_135_
140_Han_A%20revised%20method.pdf. Zermelo uses the order of play in the ITTF
Handbook, not the one in this article.
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2 players: 1–2
3 players: 2–3

1–3

1–2

4 players: 1–4

2–3

1–3

2–4

1–2

3–4

5 players: 1–4

3–5

4–5

2–3

1–5

2–4

1–3

2–5

1–2

3–4

6 players: 1–4 2–6 3–5 1–6
2–5 4–6 1–2 3–4 5–6

4–5

2–3

1–5

3–6

2–4

1–3

7 players: 1–4 2–6 5–7 1–6 2–7 3–5 6–7 4–5 2–3 1–7
3–6 2–4 1–5 3–7 4–6 1–3 2–5 4–7 1–2 3–4 5–6
8 players: 1–4 2–6 3–8 5–7 1–6 4–8 2–7 3–5 1–8 6–7
4–5 2–3 1–7 5–8 3–6 2–4 1–5 3–7 2–8 4–6 1–3 2–5
4–7 6–8 1–2 3–4 5–6 7–8
9 players: 1–4 2–6 3–8 7–9 1–6 4–8 3–9 5–7 1–8 4–9
2–7 3–5 8–9 6–7 4–5 2–3 1–9 5–8 3–6 2–4 1–7 5–9
2–8 4–6 1–5 3–7 2–9 6–8 1–3 2–5 4–7 6–9 1–2 3–4
5–6 7–8
10 players: 1–4 2–6 3–8 5–10 7–9 1–6 4–8 2–10 3–9 5–7
1–8 6–10 4–9 2–7 3–5 1–10 8–9 6–7 4–5 2–3 1–9
7–10 5–8 3–6 2–4 1–7 5–9 3–10 2–8 4–6 1–5 3–7 2–9
4–10 6–8 1–3 2–5 4–7 6–9 8–10 1–2 3–4 5–6 7–8
9–10
11 players: 1–4 2–6 3–8 5–10 9–11 1–6 4–8 2–10 5–11
7–9 1–8 6–10 2–11 3–9 5–7 1–10 6–11 4–9 2–7 3–5
10–11 8–9 6–7 4–5 2–3 1–11 7–10 5–8 3–6 2–4 1–9
7–11 3–10 2–8 4–6 1–7 5–9 3–11 4–10 6–8 1–5 3–7
2–9 4–11 8–10 1–3 2–5 4–7 6–9 8–11 1–2 3–4 5–6 7–8
9–10
12 players: 1–4 2–6 3–8 5–10 7–12 9–11 1–6 4–8 2–10
3–12 5–11 7–9 1–8 6–10 4–12 2–11 3–9 5–7 1–10 8–12
6–11 4–9 2–7 3–5 1–12 10–11 8–9 6–7 4–5 2–3 1–11
9–12 7–10 5–8 3–6 2–4 1–9 7–11 5–12 3–10 2–8 4–6
1–7 5–9 3–11 2–12 4–10 6–8 1–5 3–7 2–9 4–11 6–12
8–10 1–3 2–5 4–7 6–9 8–11 10–12 1–2 3–4 5–6 7–8
9–10 11–12
Table 1. Order of play with one player advancing
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2 players: 1–2
3 players: 1–2

1–3

2–3

4 players: 1–2

3–4

1–3

2–4

1–4

2–3

5 players: 2–5

3–4

1–2

4–5

1–3

2–4

1–4

3–5

1–5

2–3

6 players: 1–6 2–5 3–4 1–2
3–5 2–6 1–5 4–6 2–3

3–6

4–5

1–3

2–4

5–6

1–4

7 players: 1–7 2–5 3–4 2–7 3–6 4–5 1–2 4–7 5–6 1–3
2–4 6–7 1–4 3–5 2–6 1–5 4–6 3–7 1–6 5–7 2–3
8 players: 1–7 6–8 2–5 3–4 1–8 2–7 3–6 4–5 1–2 3–8
4–7 5–6 1–3 2–4 5–8 6–7 1–4 3–5 2–6 7–8 1–5 4–6
3–72–8 1–6 5–7 4–8 2–3
9 players: 1–8 7–9 2–5 3–4 1–9 2–7 3–6 4–5 2–9 3–8
4–7 5–6 1–2 4–9 5–8 6–7 1–3 2–4 6–9 7–8 1–4 3–5
2–6 8–9 1–5 4–6 3–7 2–8 1–6 5–7 4–8 3–9 1–7 6–8
5–9 2–3
10 players: 1–8 7–9 6–10 2–5 3–4 1–9 8–10 2–7 3–6 4–5
1–10 2–9 3–8 4–7 5–6 1–2 3–10 4–9 5–8 6–7 1–3 2–4
5–10 6–9 7–8 1–4 3–5 2–6 7–10 8–9 1–5 4–6 3–7 2–8
9–10 1–6 5–7 4–8 3–9 2–10 1–7 6–8 5–9 4–10 2–3
11 players: 1–9 8–10 7–11 2–5 3–4 1–10 9–11 2–7 3–6
4–5 1–11 2–9 3–8 4–7 5–6 2–11 3–10 4–9 5–8 6–7
1–2 4–11 5–10 6–9 7–8 1–3 2–4 6–11 7–10 8–9 1–4 3–5
2–6 8–11 9–10 1–5 4–6 3–7 2–8 10–11 1–6 5–7 4–8
3–9 2–10 1–7 6–8 5–9 4–10 3–11 1–8 7–9 6–10 5–11
2–3
12 players: 1–9 8–10 7–11 6–12 2–5 3–4 1–10 9–11 8–12
2–7 3–6 4–5 1–11 10–12 2–9 3–8 4–7 5–6 1–12 2–11
3–10 4–9 5–8 6–7 1–2 3–12 4–11 5–10 6–9 7–8 1–3 2–4
5–12 6–11 7–10 8–9 1–4 3–5 2–6 7–12 8–11 9–10 1–5
4–6 3–7 2–8 9–12 10–11 1–6 5–7 4–8 3–9 2–10 11–12
1–7 6–8 5–9 4–10 3–11 2–12 1–8 7–9 6–10 5–11 4–12
2–3
Table 2. Order of play with two players advancing

APPENDIX C

Putting Draw Sheets on the Web
The simplest way to post draw sheets on the Web is to convert them to PDF.
One way to do this is with Adobe Acrobat (www.adobe.com). Note that the free
Adobe Reader does not create PDFs. Assuming that you have Acrobat installed, do
::Zermelo > Select Printer and select the Adobe PDF printer. Now, print the draw
sheets. You can print them all at once by checking All in ::Draw Sheets > Print.
There are numerous products (both free and commercial) other than Adobe
Acrobat that let you create PDF documents. Any of them should work fine with
Zermelo.
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APPENDIX D

Other Event Formats
While it is simplest to only use event formats that Zermelo understands, you
can use Zermelo with some other event formats, if you are willing to give Zermelo
some manual assistance. This appendix discusses how to use Zermelo with these
formats:
•
•
•
•
•

Giant round robin
Multiple round-robin groups with all players advancing
Preliminary round-robin groups followed by divisions
Playoff for third place
Players seeded out
1. Giant Round Robin

Giant round robin is a common type of tournament. In one version of this
format, there is only one event in the tournament. You take all the players and
divide them into groups, say of ten players each. You give each group two tables
and an order of play. You send the players out to their tables. The players play
all the matches in their group, and the tournament is done. To divide the players
into groups, you first list the players in order of rating. Then, you place the top ten
players in the first group, the next ten in the next group, etc.
To use Zermelo with this type of tournament, make a separate event for each
group. Set the format of each event to “RR”. When you are ready to divide the
players into groups (it is probably a good idea to wait until the players actually
arrive at the tournament, since no-shows will mess up the groups), do ::Players >
Modify. Click the sort button in the “Rating” column header. The players are now
listed in order of rating, so it is simple to add each player to the appropriate group
(i.e., event). The navigator bar in the bottom left of the Edit page is a convenient
way of moving to the next player. To make the draw, do ::Events > Draw.
It is simpler to put the unrated players into the right groups if you enter an
estimated rating for each such player so they will appear in the correct place when
you sort the players by rating.
Once you’ve made the draw, there are several ways you can manage the
matches. One way is for you to simply print the draw sheets, give one to each
group along with a sheet you’ve prepared giving the order of play (see Appendix B
on page 141 for the round-robin group order of play), and send all the players out
to play their matches. You can enter the match results into Zermelo as the groups
finish. It doesn’t take long to enter the results. Entering the results will allow you
to create paper and PDF versions of the completed draw sheets and generate a file
of the results (via ::Tournaments > Write USATT Report) to submit to USATT.
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A second way is you can uncheck the ::Matches > Modify Calling > Manage
match calling check box (see Section 8.1 on page 119), print all the match cards,
and have the players fill out the appropriate match card as they play each match.
This will make it easy to enter results into Zermelo as the tournament progresses.
Advantages of this approach compared with giving each group a draw sheet are
that you can post updated draw sheets as the tournament progresses, the players
don’t have to know how to fill out the draw sheet properly, and it is much easier
for you to keep track of how the groups are progressing.
The third (and best) way is to let Zermelo call matches. This approach has
all the advantages of the previous approach plus tables aren’t left empty while
players (or you) try to figure out which match to put out next on a table. If you use
Zermelo to call matches, you will want to use double clipboards and to set Method
(in ::Matches > Modify Calling) to “Match”.
When a group is finished, Zermelo calculates what place each player finished
in. Zermelo does this without regard to whether a player is unrated, so if you don’t
wish to give trophies to unrated players, you need to remember to skip over them
yourself.
Note that the registration list that Zermelo produces won’t show how much the
players owe, since you don’t actually put the players into the events until you are
ready to make the groups. Usually, all players will owe the same amount, so this
isn’t a big problem. In fact, you may wish to not take entries before the tournament.
However, if you want a registration list that shows the correct amount that each
player owes, create a dummy event, say event number 99, that you enter each
player into. If you have such a dummy event, set Draw for the event to “No”. Also,
don’t set Event format to “RR”, since then Zermelo will only let you enter twelve
players in the event (any of the other formats should be fine, since their capacities
are much larger). If yours is a USATT tournament, when you are ready to write
the USATT tournament-report file, uncheck the Counts for ratings for. . . > USATT
check box (in ::Events > Modify > Edit). Otherwise, Zermelo will insist that you
finish the dummy event before it will write the tournament-report file.

2. Round Robins with All Players Advancing
Another format that Zermelo does not specifically support is an event with a
first stage consisting of multiple round-robin groups with all players advancing to
a round-robin second stage. All the group winners from the first stage are placed
in one group in the second stage, all the second-place players are placed in another
group, etc.
The way to handle this format is to have the first stage be a single “RR to RR”format event. Set the Players that advance value to one. This takes care of the
second stage for the group winners. For each of the other second stage groups,
create a separate “RR”-format event. Once the first-stage groups finish, you can
enter each player who didn’t win their group into the appropriate second stage
event and make the draw. Alternatively, you can enter the players into the second
stage events in advance based on their expected order of finish, then adjust once
the first stage is done and you know the actual order of finish.

5. PLAYERS SEEDED OUT
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3. Preliminary Round-Robin Groups Followed by Divisions
This format is similar to the preceding one. The first stage is again multiple
round-robin groups. All the group winners go into Division A. All the secondplace players go into Division B, etc. The difference is that instead of each division
being a single round-robin group, each division is two round-robin groups with the
winners of the two groups playing a final to determine the division winner.
To handle this format, make the first stage a single “RR to SE”-format event.
Make each division a separate “RR to SE”-format event. Suppose you have 60 players total and want 12 groups in the first stage. Then for the first stage event, set
RR groups > Desired size to 5. For each division event, set Desired size to 6. Once
the 12 first-stage groups finish, enter each player into the appropriate division.
There is one complication. The event with the 12 groups has a single elimination second stage that you don’t want. You need to double default all of these
matches. To make it easy to tell which match cards correspond to these matches,
set the match format for these matches to a format you don’t use. For example, if
the round-robin groups are best-of-five and none of your matches are best-of-nine,
set Match format to “3/5 then 5/9” and set Second format start to “1/128-ths”.
4. Playoff for Third Place
Sometimes (particularly in state games) people use a format where the event
(or second stage) is single elimination and the losing semifinalists play a match
to determine who wins third prize. To handle this, create a separate event for
the third-place match and set the event format to “SE”. When the semifinals are
finished, enter the losing semifinalists into the new event and make the draw.
5. Players Seeded Out
Sometimes people use a two-stage format where the top players in the event
are seeded out, i.e., they advance directly into the second stage without having to
play in the first stage. Zermelo doesn’t do this format. If you want to seed out a lot
of players, you will have to make the draw yourself as described in Section 2.1 on
page 74. To seed out a player, you place them in a group that has no other players.
On the other hand, if you just want to seed out a few players, then you may be
able to get Zermelo to do this with only a little effort. To take a specific example,
suppose you want to use round-robin groups of three, but if the number of players
is not a multiple of three, then you want to seed out just enough players so all the
groups have exactly three players.
If you have one extra player, then tell Zermelo to make every group at most
three by setting Desired size to three, Max underflow to one, and Desired max
overflow when. . . > Drawing to zero. Uncheck Place byes randomly. You will end
up with two groups that have only two players, and one of these two groups will
contain the first seed. Move the second player in the first seed’s group to the other
group of two (or move the second player to some other group and move a weaker
player from that other group to the second group of two).
If you have two extra players, then tell Zermelo to make every group at least 3
people. by setting Desired size to three, Max underflow to zero, and Desired max
overflow when. . . > Drawing to one. Uncheck Place byes randomly. You will end
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up with two groups that contain four players. Move the two other players in the
first seed’s group to a new group, and move one of the players from a group of four
to the new group. Do the same with the two players in the second seed’s group
and one of the players in the other group of four.

APPENDIX E

Sample Entry Forms
This appendix contains sample entry forms for
• A single-elimination tournament,
• A giant-round-robin tournament,
• A tournament where singles events are round-robin groups of four with
the winner advancing to a single elimination bracket.
All three tournaments are USATT sanctioned. The last one is also a Ratings Central
tournament. The giant-round-robin entry form is one page while the others are
each two pages. Note that these tournaments were run quite a few years ago, so
some USATT regulations or fees may have changed since then.
1. Event Starting Times
Some comments are in order regarding event starting times. The logic for
choosing starting times is different for a tournament where you are using Zermelo
and paging players than it is for a time-scheduled tournament (or a tournament
that sends out an entire round-robin group of four to a table).
For a time-scheduled tournament, you want to avoid having events with the
same players start at the same time because you want to avoid conflicts. With
Zermelo, conflicts are not a concern since Zermelo handles them. Instead, the key
issue is whether there are enough matches that you can put out to make use of the
available tables. From this perspective, the most efficient way to run the tournament would be to start all the events in the morning at the same time. This would
give you the most possible matches to play. However, there are other considerations.
With a time-scheduled tournament, players know when their next match is, so
they can come and go as they please. If you are paging players, then it is difficult
for players to leave the hall. You need the players to hang around in case you
need them for a match. You can let them leave (by marking them out to lunch,
see Section 1.2.19 on page 81 and Section 3 on page 90), but if a large number of
players leave, the tournament will grind to a halt. So, it is best if you can play all of
a player’s events at roughly the same time, so the player can finish their matches
and go home. This suggests that events that have many of the same players should
start at the same (or similar) times.
Another consideration is when players will show up to register. If all the events
started in the morning, then all the players would show up at the same time. This
would swamp registration. It is much simpler if players arrive at registration in
groups. This suggests starting events in bunches, e.g., a bunch at 10:00 a.m., another bunch at noon, and a final bunch at 2:00 p.m.
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The final consideration is whether higher or lower rating events should start
first. If the lower event starts first, then the player who wins the event will delay the
higher events that they are also playing in. On the other hand, if the higher event
starts first, then the lower-rated players in this event will (we hope) get knocked
out and will thus be available to play in the lower events. This will allow the events
to decouple and run in parallel rather than sequentially.

Boston TTC December Open
Table Tennis Tournament
December 7–8, 2002

Boston Table Tennis Center, Inc.
407R Mystic Ave., Suite 19D
Medford, MA 02155-6383
www.bostonttc.us
EVENT
Open Singles
Under 2175 Singles
Under 2075 Singles
Under 1975 Singles
Under 1875 Singles
Under 1775 Singles
Under 1675 Singles
Under 1575 Singles
Under 1475 Singles
Under 1375 Singles
Under 1275 Singles
Under 1175 Singles
Under 1075 Singles
Under 975 Singles
Under 875 Singles
Junior Under 14 Singles
Unrated Singles
Handicap Singles
Under 3900 Doubles
Under 2700 Doubles

ENTRY FEE
DAY
STARTING TIME
$9
Sunday
12:00 noon
$9∗
Sunday
12:00 noon
$9∗
Sunday
12:00 noon
$9∗
Sunday
12:00 noon
$9∗
Sunday
2:00 p.m.
$9∗
Sunday
2:00 p.m.
$9∗
Saturday
10:00 a.m.
$9∗
Saturday
10:00 a.m.
$9∗
Saturday
10:00 a.m.
$9∗
Saturday
10:00 a.m.
$9∗
Saturday
10:00 a.m.
$9∗
Saturday
2:00 p.m.
$9∗
Saturday
2:00 p.m.
$9∗
Saturday
4:00 p.m.
$9∗
Saturday
4:00 p.m.
$4
Saturday
4:00 p.m.
$9
Saturday
2:00 p.m.
$9
Saturday
2:00 p.m.
$9 per player
Sunday
3:00 p.m.
$9 per player Saturday
4:00 p.m.
∗ $4 for unrated players

AWARDS
$100, $50
$50, $25
Trophy, Trophy
Trophy, Trophy
Trophy, Trophy
Trophy, Trophy
Trophy, Trophy
Trophy, Trophy
Trophy, Trophy
Trophy, Trophy
Trophy, Trophy
Trophy, Trophy
Trophy, Trophy
Trophy, Trophy
Trophy, Trophy
Trophy, Trophy
Trophy, Trophy
$50, $25
Trophies, Trophies
Trophies, Trophies

The Boston Table Tennis Center is a 3000 square-foot facility, used exclusively for table tennis, with six top-of-the-line Donic “Persson 25” tables, heating
and air conditioning, a state of the art Connor NeoShok maple wood floor, and excellent lighting.
cut here

Boston TTC December Open
Circle the events you wish to enter (enter doubles at the tournament):
Open 21
20
19
18
17
16
15
14
13
$9 $9∗ $9∗ $9∗ $9∗ $9∗ $9∗ $9∗ $9∗ $9∗
USATT Membership
Adult 1 year
Adult 3 year
Junior (Under 18) 1 year
Junior (Under 16) 3 year
College Student (with Xerox of ID) 1 year
Family 1 year

$30
$75
$20
$45
$20
$50

12
$9∗

11
$9∗

10
$9∗

9
$9∗

8
$9∗

U-14
$4

Total for Membership and Events

$

Rating Fee

$

Total Enclosed

$

Name

USATT Expiration

Address

USATT ID Number

City, State, Zip

Rating

Day Telephone

Home Club

Night Telephone

Birth

Email
P LEASE P RINT N EATLY U SING A LL C APS

Unrated
$9

Handicap
$9

3

Boston TTC December Open
December 7–8, 2002

SANCTION, LOCATION, AND TOURNAMENT COMMITTEE: The Boston Table Tennis Center, Inc., 407R Mystic Ave., Suite 19D,
Medford, MA 02155-6383, presents a one-star tournament sanctioned by USA Table Tennis. T OURNAMENT D IRECTOR AND R EFEREE :
David Marcus, USATT National Umpire. S TAFF : Humberto Gil, Alex Landsman, Qiumars Hedayatian.
HOW TO ENTER: The deadline for entering is 10:00 p.m., Thursday, December 5, 2002. Entries received after the deadline will be
accepted, if there is still space, but will be charged $1 extra per event (this includes entries lost in the mail, bounced email, and additional
events you enter at the tournament). To enter, mail entry form to David Marcus; 17 Somewhere St.; Somerville, MA 02143-4336, telephone
David Marcus at 123-456-7890, email tournaments@example.com, or enter via the Web at www.bostonttc.us. If entering by telephone or
email, please provide all information requested on the entry form. If you enter by leaving a voicemail message, please spell your name.
Email and Web entries (with a valid return email address) will be replied to; others will not. No extra charge for telephone, email, or Web
entries. Make checks payable to “Boston TTC, Inc.”
DIRECTIONS: F ROM THE NORTH, take I-93 South to exit 30 (Mystic Ave., Somerville). Bear right (sign says “North 38 Medford Sq”)
onto Mystic Ave. Go 0.3 miles and turn left onto Hicks Ave. (street signs say “Hicks Ave” and “407 Rear”); Sentry Lincoln Mercury dealer is
on the far left corner (signs say “Lincoln Mercury” and “Sentry Used Cars”), Avellino’s Restaurant is on the near left corner, and Blockbuster
Video is on the right. Go 0.1 mile and turn left (street sign on right says “407 Rear”); Demetrios Air Freight is on the near left corner and
MDC (Materials Development Corporation) is on the far left corner. Go 0.1 mile. On the left, you will see a long, light-colored building
with a blue top and two red lines. Go in the first door and up to the third floor. The BTTC is in suite 19D. There is parking both in front
and behind the building. F ROM THE SOUTH, take I-93 North to exit 32 (Medford Sq., Malden). Go around the rotary and get on I-93 South.
Follow the “From the north” directions. F ROM THE WEST, take the Mass. Pike to I-93 North. Follow the “From the south” directions. B Y
PUBLIC TRANSPORTATION , take the Route 95 West Medford bus from the Sullivan Square T stop. It should be less than a ten minute ride.
Service is limited; the bus runs only once an hour after the evening rush hour (www.mbta.com/schedmaps/bus/bus.cfm?routenumber=95).
Ask the driver to let you off at the stop on Mystic Ave. closest to Hicks Ave. From there, it is a five minute walk to the BTTC. Walk down
Hicks Ave. and follow the “From the North” directions.
EQUIPMENT: Six Donic “Persson 25” tables, Donic Stress net sets, white three-star Nittaku 40-mm balls. Wood floor, bright lighting. We
supply the balls. Bring your own racket. Rubber must be USATT or ITTF approved.
DOUBLES AND HANDICAP: D OUBLES : Do not enter in advance. Enter on the day of the event at the tournament. The deadline for
entering is the starting time of the event. H ANDICAP : The event is not for physical handicaps. The weaker player is spotted points.
ELIGIBILITY: You must be a member of USATT or another ITTF-affiliated national association. If you are not a member, you must
join USATT by paying the USATT membership fee when you arrive at the tournament or by including it with your entry form. “Family”
membership is for up to two adults and any juniors all residing at the same address. To buy a “College Student” membership, you must
bring a Xerox of your student ID. If you are a member, then you must bring your membership card or a Xerox of a valid membership receipt
(the special form you received when you purchased your membership at a tournament). If you are a member of another ITTF-affiliated
association, you must bring a Xerox of your membership card. If you are a USATT member, but forget to bring your card or receipt, you
will have to purchase an extension to your membership (unless you are listed at www.usatt.org/ratings/history.html as having an unexpired
membership). Do not send money directly to USATT for a membership for one month prior to the tournament because there will not be
time for you to receive your membership card from USATT, and we will have no way of verifying that you sent the money. To enter the
Junior event, you must be the specified age as of the day of the event. No “Tournament Passes”.
UNRATED PLAYERS: If you have never played in a USATT-sanctioned tournament, then you are unrated. The tournament is designed to
accommodate players of all levels; unrated players are encouraged to enter. If you are unrated, then you will not advance to the next round
(even if you win) after playing a rated player in the Under 875 through Under 2175 events; you may enter these events for $4 each. You
will advance, if you win, in the Open, Unrated, and Junior events. You do not have to enter the Unrated event. You must enter at least two
singles events other than the Unrated event. You cannot enter the doubles events. You cannot enter the Handicap event.We strongly suggest
you enter several singles events, otherwise your resulting rating is likely to be inaccurate. If you have no idea what your level is, we suggest
you enter Unrated Singles plus four events selected from the 975 through 1475 events. The purpose of these rules is to make the tournament
fair to rated players, while providing the opportunity for unrated players to play rated players.
RULES AND CLOTHING: All USATT rules and the USATT dress code apply (see www.usatt.org/rules). One side of the racket must be
bright red and the other side must be black. The main color of your shirt and shorts must be clearly different from white. Table tennis shoes,
court shoes, tennis shoes, or something similar. No black-soled shoes or street shoes.
FORMAT AND SCHEDULE: All events are single elimination. All matches are best-of-five 11-point games, except the Handicap event
which is one game to 51. On each day that you are playing, please check in by the starting time of your first event. You may enter as many
events as you are eligible for, including multiple events that have the same starting time. For Open Singles, if you are one of the top four
seeds, you must arrive by the starting time or you will be scratched from the event.
RATINGS: All singles events count for USATT ratings, except the Handicap event. Unrated players who play in an event that counts for
ratings will get a USATT rating from USATT. All players who enter an event that counts for ratings must pay the $3 rating fee (regardless
of whether or not you already have a rating). It takes a month or more after the tournament for USATT to process the results and produce
the new ratings.

Boston TTC May Giant Round Robin
Open Table Tennis Tournament
May 3–4, 2003
The Boston Table Tennis Center, Inc. (www.bostonttc.us) is a 3000 square-foot facility, used exclusively for table tennis, with six top-of-the-line
Donic “Persson 25” tables, heating and air conditioning, a state of the art Connor NeoShok maple wood floor, and excellent lighting.

SANCTION, LOCATION, AND TOURNAMENT COMMITTEE: The Boston Table Tennis Center, Inc., 407R Mystic Ave.,
Suite 19D, Medford, MA 02155-6383, presents a zero-star tournament sanctioned by USA Table Tennis. Tournament Director and
Referee: David Marcus, USATT National Umpire. Staff: Humberto Gil, Alex Landsman, Qiumars Hedayatian.
FORMAT: Sunday is for players 1600 and above, Saturday for players below 1600. You will be placed in a round-robin group of
seven to ten players (depending on how many players enter) and will play each of the players in your group once. We will form the
groups in order by rating, e.g., the top ten players will go in the first group, the next ten in the next group, etc. We will do our best
to place unrated players in an appropriate group. All matches are best-of-five 11-point games.
PRIZES: Top group on Sunday: $100, $50, $25. All other groups: trophies for first and second.
HOW TO ENTER: Register at the tournament. To play on Saturday, arrive by 10:00 am. To play on Sunday, arrive by 12:00 noon.
If you are late, you will probably not be able to play. There is no advance registration. The entry fee is $25 plus the $3 rating fee
for a total of $28. We accept cash or checks. No credit cards. Make checks payable to “Boston TTC, Inc.”
INFORMATION: For information, email tournaments@example.com or call 123-456-7890.
DIRECTIONS: From the north, take I-93 South to exit 30 (Mystic Ave., Somerville). Bear right (sign says “North 38 Medford
Sq”) onto Mystic Ave. Go 0.3 miles and turn left onto Hicks Ave. (street signs say “Hicks Ave” and “407 Rear”); Sentry Lincoln
Mercury dealer is on the far left corner (signs say “Lincoln Mercury” and “Sentry Used Cars”), Avellino’s Restaurant is on the
near left corner, and Blockbuster Video is on the right. Go 0.1 mile and turn left (street sign on right says “407 Rear”); Demetrios
Air Freight is on the near left corner and MDC (Materials Development Corporation) is on the far left corner. Go 0.1 mile. On the
left, you will see a long, light-colored building with a blue top and two red lines. Go in the first door and up to the third floor. The
BTTC is in suite 19D. There is parking both in front and behind the building. From the south, take I-93 North to exit 32 (Medford
Sq., Malden). Go around the rotary and get on I-93 South. Follow the “From the north” directions. From the west, take the Mass.
Pike to I-93 North. Follow the “From the south” directions. By public transportation, take the Route 95 West Medford bus from
the Sullivan Square T stop. It should be less than a ten minute ride. Service is limited; the bus runs only once an hour after the
evening rush hour (www.mbta.com/schedmaps/bus/bus.cfm?routenumber=95). Ask the driver to let you off at the stop on Mystic
Ave. closest to Hicks Ave. From there, it is a five minute walk to the BTTC. Walk down Hicks Ave. and follow the “From the
North” directions.
ELIGIBILITY: You must be a member of USATT or another ITTF-affiliated national association. If you are not a member, you
must join USATT by paying the USATT membership fee when you arrive at the tournament: Adult one-year is $30, Adult threeyear is $75, Junior (under 18) one-year is $20, Junior (under 16) three-year is $45, College Student (with Xerox of ID) one-year
is $20, Family one-year is $50. Family membership is for up to two adults and any juniors all residing at the same address. To
buy a College Student membership, you must bring a Xerox of your student ID. If you are currently a USATT member, then you
must bring your membership card or a Xerox of a valid membership receipt (the special form you received when you purchased
your membership at a tournament). If you are a member of another ITTF-affiliated association, you must bring a Xerox of your
membership card. If you are a USATT member, but forget to bring your card or receipt, you will have to purchase an extension to
your membership. Do not send money directly to USATT for a membership for one month prior to the tournament because there
will not be time for you to receive your membership card from USATT, and we will have no way of verifying that you sent the
money. No “Tournament Passes”.
UNRATED PLAYERS: If you have never played in a USATT-sanctioned tournament, then you are unrated. If you are unrated,
you may play on Saturday or Sunday, but not both. It is unlikely that you will be placed in the top group on Sunday. If you do not
know what your level is, we strongly suggest you play on Saturday. You will not be eligible to win a trophy.
EQUIPMENT: White three-star Stiga 40-mm balls provided by Stiga, the ball sponsor of the BTTC May Giant Round Robin. Six
Donic “Persson 25” tables, Donic Stress net sets. Wood floor, bright lighting. Bring your own racket. Your rubber must be USATT
or ITTF approved.
RULES AND CLOTHING: All USATT rules and the USATT dress code apply (see www.usatt.org/rules). One side of the racket
must be bright red and the other side must be black. The main color of your shirt and shorts must be clearly different from white.
Table tennis shoes, court shoes, tennis shoes, or something similar. No black-soled shoes or street shoes.
RATINGS: All matches count for USATT ratings. Unrated players who participate will get a USATT rating from USATT. All
players must pay the $3 rating fee, regardless of whether or not you already have a rating. It takes at least a month for USATT to
process the results and produce the new ratings.

UVA Open
Table Tennis Tournament
March 12, 2005

UVA Aquatic and Fitness Center
450 Whitehead Road
Charlottesville, VA 22903
EVENT
Open Singles
Under 2200 Singles
Under 2000 Singles
Under 1800 Singles
Under 1600 Singles
Under 1400 Singles
Under 1250 Singles
Under 1000 Singles
Junior Under 18 Singles
Senior Over 40 Singles
Unrated Singles
Open Doubles
Under 3200 Doubles

FORMAT
RR to SE
RR to SE
RR to SE
RR to SE
RR to SE
RR to SE
RR to SE
RR to SE
RR to SE
RR to SE
RR to SE
SE
SE

ENTRY FEE CHECK-IN TIME AWARDS
$15
1:00 p.m.
$200, $100
$13/$10∗
10:00 a.m.
$40, $20
$13/$10∗
10:00 a.m.
Trophy, Trophy
$13/$10∗
10:00 a.m.
Trophy, Trophy
$13/$10∗
10:00 a.m.
Trophy, Trophy
$13/$10∗
12:00 noon
Trophy, Trophy
$13/$10∗
12:00 noon
Trophy, Trophy
$13/$10∗
2:00 p.m.
Trophy, Trophy
$13
2:00 p.m.
Trophy, Trophy
$13
2:00 p.m.
$40, $20
$13
2:00 p.m.
Trophy, Trophy
$7 per player
3:00 p.m.
$80, $40
$7 per player
3:00 p.m.
Trophies, Trophies
∗ $13 for rated players, $10 for unrated players

Everyone who enters gets a free t-shirt!
College students get a $3 discount on the entry fee for each event!
The top four seeds in the Open Singles must be at the tournament by the scheduled check-in time or they will not be allowed to
play in the event.
cut here

UVA Open
Circle the events you wish to enter (enter doubles at the tournament):
Open
2200
2000
1800
1600
1400
$15
$13/10
$13/10
$13/10
$13/10
$13/10
USATT Membership
One-time Pass
Adult 1 year
Adult 3 year
Junior (Under 18) 1 year
Junior (Under 16) 3 year
Collegiate (with Xerox of ID) 1 year
Household 1 year
Household 3 year
Name
Address

$ 10
$ 40
$100
$ 20
$ 50
$ 20
$ 60
$150

1200
$13/10

1000
$13/10

U-18
$13

Total for Membership and Events

$

Rating Fee

$

Total Enclosed

$

Ratings Central Rating
Ratings Central ID

City, State, Zip

USATT Rating

Day Telephone

USATT ID

Night Telephone

USATT Expiration

Email

Home Club
Birth
P LEASE P RINT N EATLY U SING A LL C APS

O-40
$13

Unrated
$13

4

SPONSORSHIP AND TOURNAMENT COMMITTEE: The UVA Table Tennis Club presents a two-star tournament sponsored by
the UVA Parents Fund, supported by Ratings Central (www.ratingscentral.com), and sanctioned by USA Table Tennis. Tournament
Director and Referee: David Marcus, USATT National Umpire. Staff: Martin Del Vecchio, Sean O’Neill.
HOW TO ENTER: The deadline for entering is 10:00 p.m., Thursday, March 10, 2005. Entries received after the deadline will be
accepted, but will be charged $1 extra per event (this includes entries lost in the mail, bounced email, and additional events you enter at
the tournament). To enter, mail entry form to Martin Del Vecchio, 1234 Old Lynchburg Rd., Charlottesville, VA 22903, telephone Martin
Del Vecchio at 123-456-7890, fax to 123-456-7890, email email@example.com, or enter via the web at www.example.com/~pingpong/
tournament.html. If entering by telephone or email, please provide all information requested on the entry form. If you enter by leaving
a voicemail message, please spell your name. Email and web entries will be replied to—others will not. No extra charge for telephone,
email, or web entries. We accept cash, checks, or money orders. No credit cards. Make checks payable to “Table Tennis Club at UVA”.
Do not enter doubles in advance—enter at the tournament. The deadline for entering doubles is the check-in time of the event.
DIRECTIONS: From I-64, follow signs to the UVA Information Center and get off at exit 118B for the Route 29/250 Bypass. Go
approximately 2 miles and take the offramp for Route 250 East Business (Ivy Rd.). Turn right off the exit ramp and follow Ivy Road. At
the fourth traffic light, turn right onto Route 29 Business/Emmet St. After going under bridge, Emmet St. will veer to the left. Continue
straight onto Stadium Rd. instead. Take first right onto Whitehead Rd. The Aquatic and Fitness Center is at the end of Whitehead Rd. on
the right. Parking can be found in several lots surrounding facility (see map at www.example.com/~pingpong/map.html). From I-66 via
US Route 29 North, take I-66 West from Northern Virginia past Manassas. Take exit 43B (“Route 29 South—Gainesville”). Proceed to
Charlottesville, where Route 29 becomes Emmet St. Proceed straight through the traffic light at the intersection with Route 250 Business
(University Ave./Ivy Rd.). Pass tennis courts on the left. After going under bridge, Emmet St. will veer to the left. Continue straight
onto Stadium Rd. instead. Continue as above.
FORMAT AND SCHEDULE: Singles events are round-robin groups of four players with the winner of each group advancing to a
single-elimination bracket. Doubles events are single elimination. All matches are best-of-five 11-point games. Please check in by the
check-in times of your events. (You only need to check in once, even if your events have different check-in times.) You may enter as
many events as you are eligible for, including multiple events that have the same check-in time. All events will finish in the evening.
ELIGIBILITY: You must be a member of USATT or another ITTF-affiliated national association or you must purchase a One-time Pass.
You may only purchase a One-time Pass if you have never played in a USATT-sanctioned tournament before. You may join USATT by
paying the USATT membership fee when you arrive at the tournament or by including it with your entry form. Household membership
is for up to two adults and any juniors all residing at the same address. Collegiate membership is for full-time college or graduate
students; you must bring a Xerox (not the original) of your student ID. If you are currently a USATT member, then you must bring your
membership card or a Xerox (not the original) of a valid membership receipt (the special form you received when you purchased your
membership at a tournament). If you are a member of another ITTF-affiliated association, you must bring a Xerox (not the original) of
your membership card. If you are a USATT member, but forget to bring your card or receipt, you may have to purchase an extension to
your membership. Do not send money directly to USATT for a membership for one month prior to the tournament because there will
not be time for you to receive your membership card from USATT, and we will have no way of verifying that you sent the money. To
enter the Junior or Senior event, you must be the specified age as of the day of the tournament.
RATINGS: For purposes of event eligibility and seeding, we will use your Ratings Central rating if you have one and its standard
deviation is less than 250. Failing that, we will use your USATT rating, if you have one. Failing that, you are “unrated”. All singles
events count for both Ratings Central and USATT ratings. All players who play in the tournament will get a rating from both Ratings
Central and USATT. The Ratings Central ratings will be available the day after the tournament at www.ratingscentral.com. All players
who enter a singles event must pay the $4 USATT rating fee (regardless of whether or not you already have a USATT rating). It takes a
couple of weeks for USATT to process the results and produce the new ratings. The USATT ratings will be posted at www.usatt.org.
UNRATED PLAYERS: If you do not have a USATT rating and either do not have a Ratings Central rating or your Ratings Central
standard deviation is at least 250, then you are “unrated”. The tournament is designed to accommodate players of all levels; unrated
players are encouraged to enter. If you are unrated, then you will not advance to the single-elimination bracket even if you win your
group in the Under 1000 through Under 2200 events; you may enter these events for $10 each. You will advance, if you win, in the
Open, Junior, Senior, and Unrated events. You do not have to enter the Unrated event. You must enter at least one singles event other
than the Unrated event. You cannot enter the Under 3200 Doubles events. We suggest you enter more than one singles event, otherwise
your resulting rating is likely to be less accurate. If you have no idea what your level is, we suggest you enter Unrated Singles plus two
events selected at random from the Under 1200 through Under 1600 events. The purpose of these rules is to make the tournament fair to
rated players, while providing the opportunity for unrated players to play rated players.
EQUIPMENT: Only USATT-approved equipment will be used. White three-star Stiga Optimum balls. 18 tables: 8 Stiga Prestige, 5
Stiga Elite Roller, 1 Stiga Expert Roller, 3 Butterfly Octet, 1 Butterfly Centrefold. Butterfly National League, Butterfly Europa, and Stag
Clip On net sets. Wood floor, excellent lighting. Bring your own racket. Rubber must be USATT or ITTF approved.
RULES AND CLOTHING: All USATT rules and the USATT dress code apply (see www.usatt.org/rules). One side of your racket must
be bright red and the other side must be black. The main color of your shirt and shorts must be clearly different from white. Table tennis
shoes, court shoes, tennis shoes, or something similar. No black-soled shoes or street shoes.

APPENDIX F

Giving Byes to Top Seeds Is Unfair
This appendix shows that giving byes to the top seeds in order, as the ITTF
rules specify, can lead to situations where a player would prefer to be seeded lower
rather than higher.
Suppose there are seven players, pi , i = 1 . . . 7, each from a different association. Assume that the probability that p1 defeats any of the other players is x,
where 1/2 < x < 1, and that all the other players are equal in ability. Assume that
all players are seeded and that player pi is seeded ith.
To make the draw according to the ITTF rules, place p1 in the top slot and give
them a bye in the first round. Place p2 in the bottom slot. Draw p3 and p4 randomly
into the two middle slots. Finally, draw the remaining three players randomly into
the remaining three slots.
Let si be the player in slot i, where we number slots according to the way that
people make a deterministic draw. I.e., s1 is the top slot, s2 is the bottom slot, s3
is the slot at the top of the bottom half, etc. Straightforward calculation gives the
probabilities in Table 1 that the player in each slot will win the tournament.
From this it is straightforward to calculate the probability (before the draw is
made) that each player will win the tournament. See Table 2. It is easy to check
that 1/2 < x < 1 implies that


1−x
3
1−x
x+
<
(x + 1).
8
2
6
So, it is better to be seeded 5th–7th rather than 3rd–4th. Table 3 contains the
probabilities that each player wins the tournament for various values of x.
Slot
s1
s4 , s5

Probability
x2
1−x
4
1−x
4



1
s2 , s3 , s6 , s7
x+ 2
Table 1. Probability player in slot wins tournament

Player
p1
p2
p3 , p4

Probability
x2 

1−x
1
x+ 2
4 

1−x
x + 32
8

p5 , p6 , p7 1−x
(x + 1)
6
Table 2. Probability player wins tournament
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Probability p1 wins a match
0.6
0.7
0.8
0.9
p1
0.3600 0.4900 0.6400 0.8100
p2
0.1100 0.0900 0.0650 0.0350
p3 , p4
0.1050 0.0825 0.0575 0.0300
p5 , p6 , p7 0.1067 0.0850 0.0600 0.0317
Table 3. Probability player wins tournament
Player

The intuition is that it is better to be in the bottom half (away from the first
seed). The 3rd and 4th seeds each have a 1/2 chance of being in the bottom half,
but the 5th–7th seeds each have a 2/3 chance of being in the bottom. Therefore it is
better to be seeded lower.
A fair way to make the draw is to place byes randomly. For the above example,
we can see this intuitively. The farther away you are from the first seed, the better
(since they may lose before reaching you). The 3rd and 4th seeds each have a 1/2
chance of being in the top half, as do the 5th–7th seeds. However, the 5th–7th
seeds have a 1/4 chance of being in the top quarter, while the 3rd–4th seeds can’t
be in the top quarter. Hence, it is better to be seeded 3–4. To check this rigorously,
you could, without too much trouble, calculate the probabilities assuming the bye
is placed randomly. There are three more cases to consider (corresponding to each
of the possible locations for the bye).

APPENDIX G

Screen Resolution and Font Size
Windows lets you set the screen resolution via Control Panel > Appearance and
Personalization > Personalization > Adjust screen resolution (this is for Windows
Vista; in other versions of Windows, the setting may be in a different place). Zermelo will work at any screen resolution, but the higher the resolution, the smaller
Zermelo’s text will be.
Windows also lets you set the font size (e.g., large or small fonts) via Control Panel > Appearance and Personalization > Personalization > Adjust font size
(DPI) (again this is the Windows Vista location). However, Zermelo will ignore this
setting.
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APPENDIX H

User Interface
This chapter gives detailed information on Zermelo’s user interface, i.e., how
to use the keyboard and mouse with Zermelo.
1. Persistence
Zermelo remembers the position and size of all windows, the size and order
of grid columns, which column each grid is sorted on, and the selected printer.
Zermelo remembers this information both during a single invocation and between
invocations. To do this, Zermelo writes the information to the file Zermelo.ini in
the database folder. You can delete the Zermelo.ini file if you want Zermelo to
revert to the default positions, sizes, etc.
2. Basic Window Operation
The buttons in the top-right of a window’s title bar work just as they do for
other Windows applications to minimize, zoom, or close the window. You can
right-click the title bar or press ⟨Alt+Space⟩ to activate the Windows system menu.
You can close a window by pressing ⟨Alt+F4⟩. You can resize a window by dragging
its border with the mouse. A few of Zermelo’s windows cannot be resized while
some others can have their width changed, but not their height. (In the latter case,
Windows doesn’t know that the window can only be resized in one dimension and
so will change the mouse cursor if you hover over any of the borders.) You can
maximize a window by double-clicking its title bar and restore it to its previous
size by double-clicking it again. And, of course, you can move a window to a new
position by dragging its title bar with the mouse.
Note that closing a window by ⟨Alt+F4⟩ or clicking the close button in the title
bar (i.e., the “×” button) is similar to clicking the Cancel or Close button (whichever
the window has). So, if you are currently editing something (e.g., an event or player),
any edits that you’ve made will be discarded. The ⟨Esc⟩ key is generally the same
as pressing the Cancel or Close button.
3. Scroll Bars
Scroll bars work just as they do for other Windows apps. Click one of the arrow
buttons to scroll one line or column. Click the area between the arrow buttons and
the thumb (i.e., the slider in the middle of the scroll bar) to scroll by one screenful.
Drag the thumb to scroll a variable amount. Scroll bars in grids work slightly
differently; see Section 10 on page 167.
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Figure 1. Window showing disabled and read-only controls
4. Focus
A control is a menu, grid, button, edit field, drop-down list, check box, radio
button, etc. The control that is currently receiving keyboard input is said to have
the focus. The ⟨Tab⟩ key moves the focus to the next control while ⟨Shift+Tab⟩
moves the focus to the previous control. Controls generally show that they have the
focus by either some sort of highlighting or by displaying a dotted focus rectangle.
Windows may hide the focus rectangle until you use the keyboard; to turn off this
“feature”, see Section 7 on the facing page.
5. Disabled and Read-Only Controls
Controls can be enabled, disabled, or read-only. When a control is disabled,
its background is the same color as the window and its label is grayed. A control will be disabled if it doesn’t currently apply. When a control is read-only, its
background is the same color as the window, but its label is displayed normally. A
control will be read-only if it does apply, but you aren’t allowed to change it.
For example, in Figure 1, the Event is doubles check box is read-only (since you
can’t change whether an event is doubles if the event is drawn) while the Teamrating cutoff field is disabled (because a singles event doesn’t have a team-rating
cutoff).

8. ENTER KEY
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6. Log Window
When you start Zermelo, the log window has the focus. ⟨Up⟩ scrolls up one line,
⟨Down⟩ scrolls down one line, ⟨PgUp⟩ scrolls up one screenful, ⟨PgDn⟩ scrolls down
one screenful, ⟨Ctrl+Home⟩, ⟨Ctrl+Up⟩, and ⟨Ctrl+PgUp⟩ scroll to the beginning of
the log, ⟨Ctrl+End⟩, ⟨Ctrl+Down⟩, and ⟨Ctrl+PgDn⟩ scroll to the end, ⟨Left⟩ scrolls
the display left one column (i.e., one character), ⟨Right⟩ scrolls the display right
one column, ⟨Ctrl+Left⟩ scrolls the display left ten columns, ⟨Ctrl+Right⟩ scrolls
the display right ten columns, ⟨Home⟩ scrolls all the way to the left, and ⟨End⟩
scrolls all the way to the right.
7. The Main Menu
The main menu (and Zermelo’s only menu) is at the top of Zermelo’s main
window. Each menu and submenu item has one letter underlined.
If you don’t see the underlines, then the underlines should appear if you press
⟨Alt⟩. You can also tell Windows to always show the underlines: In Windows 10,
turn on All settings > Ease of Access > Interaction > Keyboard > Change how keyboard shortcuts work > Underline access keys when available. This setting may
also affect whether the focus rectangle is hidden until you use the keyboard.
You can select a menu or submenu item by pressing ⟨Alt⟩ and the underlined
letter. If the menu has the focus, you can just press the letter without holding down
the ⟨Alt⟩ key. You can toggle the focus between the menu and the log window by
pressing ⟨Alt⟩ or ⟨F10⟩.
If the menu has the focus, then ⟨Left⟩ moves to the previous menu item, or if
a submenu is displayed, displays the previous submenu. Similarly, ⟨Right⟩ moves
to the next menu item or submenu. ⟨Up⟩ and ⟨Down⟩ move to the previous or next
submenu item. If no submenu is displayed, then they display the submenu. ⟨Enter⟩
selects the current menu or submenu item. ⟨Esc⟩ closes a submenu. If no submenu
is open, then it gives the focus back to the log window.
Most of the submenu items have a single letter to their right. This letter specifies the shortcut key for the item. You can press the shortcut key to select the
submenu item. For example, there is a “C” next to ::Matches > Call. If you press
⟨C⟩, it is the same as clicking on Call. The shortcut keys only work if the log window has the focus (as it normally does), not if the menu has the focus. Table 1
on the following page lists the menu items and shortcut keys. Note that ⟨+⟩ is a
shortcut for Enter Result even though the submenu only shows “R”. The bold letters in the table show how the shortcut keys were chosen. The shortcut keys “Q”
and “Z” were chosen because those shortcut keys were available even though the
letters don’t appear in the menu items.
Each submenu has one item in bold. If you double-click a main menu item,
then the submenu item in bold will be selected.
8. Enter Key
Most windows have a default button that will be selected if you press ⟨Enter⟩
even if the button does not have the focus. For example, in Figure 2 on page 167,
the Import button is the default button. If there is no default button and the field
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Menu

Submenu
Keys
Call
⟨C⟩
Enter Result
⟨R⟩, ⟨+⟩
Call One
⟨O⟩
Matches
Call Stages
⟨G⟩
Call Some
⟨S⟩
Undo One
⟨U⟩
List Playing
⟨Y⟩
Modify Calling
Display
⟨D⟩
Print
⟨N⟩
Draw Sheets
Swap Slots
⟨A⟩
Modify Posting
Modify
⟨P⟩
Enter Doubles
⟨B⟩
Players
Check In or Out
⟨K⟩
Print Lists
⟨L⟩
Import
Export
Modify
⟨E⟩
Events
Draw
⟨W⟩
Modify
⟨T⟩
Display Statistics
Tournament
Print Table Numbers
Write USATT Report
Export Finalists
⟨F⟩
Create New
Import
⟨I⟩
Lists
Browse Rating
⟨Z⟩
Browse Club
Visit Website
⟨V⟩
Ratings Central
Submit Tournament
Exit
⟨X⟩
Set Up Internet
Zermelo
Select Printer
⟨Q⟩
Display Version
Print modified draw sheets for posting ⟨M⟩
Table 1. Main-window menu items and shortcut keys

that has the focus does not respond to the ⟨Enter⟩ key, then the ⟨Enter⟩ key moves
the focus to the next field. If a button has the focus, then ⟨Enter⟩ clicks the button.
9. Accelerator Keys
Most labels have an underlined letter. (If you don’t see the underlines, see
Section 7 on the preceding page for how to tell Windows to show them.) You
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Figure 2. The Import button is the default button

can press ⟨Alt⟩ plus the key corresponding to the letter to move the focus to the
associated control. If the control you are moving to is a button, it will also be
clicked. If the control is a check box, it will be toggled (i.e., checked if unchecked
and vice versa). If the control is a radio button, it will be selected. If the control
that has the focus doesn’t respond to letter keys (e.g., a button or an edit field that
only accepts numbers), then you don’t have to hold down the ⟨Alt⟩ key; just press
the letter key. Note that drop-down lists do respond to letter keys.
In the Check In or Out window, pressing the accelerator key for a radio button
without holding down ⟨Alt⟩ makes the radio button selected, but doesn’t change
which control has the focus.

10. Grids
You can find grids in ::Lists > Browse Rating, ::Events > Modify, and ::Players >
Modify, as well as a few other places. (The grid on the second page of the doubles
notebook is a different sort of grid; see Section 10.2 on the next page.)
The selected item in a grid is indicated by a right-pointing arrowhead in the
leftmost column. If the grid has the focus, then the selected item is also highlighted.
The scroll bars in grids are standard Windows scroll bars, with the following
differences: Click the area between the arrow buttons and the thumb of the horizontal scroll bar to scroll by one screenful minus one column. So, if you scroll
right (say), the last fully visible column on the right before you scroll will be the
column on the left after you scroll. Click the area between the arrow buttons and
the thumb of the vertical scroll bar to move the number of rows in one screenful.
Drag the thumb to move a variable amount.

168

H. USER INTERFACE

You can resize or reorder columns by dragging with the mouse. To resize,
drag the vertical line in the header that separates two columns. To reorder, drag
the header for the column to where you want it.
You can sort the grid on a column by clicking the button to the right in the
column header. Not all columns have the button. You can only sort on columns
that do have the button. The column that the grid is currently sorted on will
display a downward-pointing arrowhead in the button. Columns with buttons will
also have an underlined letter in the column header. This indicates the accelerator
key that you can press to sort on the column. These accelerator keys work like
other accelerator keys in that you will have to also press ⟨Alt⟩ while pressing the
accelerator key if the control that currently has the focus responds to letter keys.
The sort order is decreasing for ratings and increasing for everything else.
In a grid, ⟨Up⟩ moves up one row, ⟨Down⟩ moves down one row, ⟨PgUp⟩ moves
up the number of rows in one screenful, ⟨PgDn⟩ moves down the number of rows
in one screenful, ⟨Ctrl+Home⟩ and ⟨Ctrl+PgUp⟩ scroll to the beginning, ⟨Ctrl+End⟩
and ⟨Ctrl+PgDn⟩ scroll to the end, ⟨Ctrl+Up⟩ moves to the first row displayed in the
window, ⟨Ctrl+Down⟩ moves to the last row displayed in the window, ⟨Left⟩ scrolls
the display left one grid column, ⟨Right⟩ scrolls the display right one grid column,
⟨Ctrl+Left⟩ scrolls the display left one screenful minus one column, ⟨Ctrl+Right⟩
scrolls the display right one screenful minus one column, ⟨Home⟩ scrolls all the
way to the left, and ⟨End⟩ scrolls all the way to the right. Clicking with the mouse
makes the row you clicked the current row.
In the grids on the Browse page of the player, event, or doubles notebooks, you
can double-click a player or event to switch to the Edit page for the player or event.
If the grid does not have the focus, pressing ⟨Ctrl+G⟩ sets the focus to the grid.
In a Find field, pressing ⟨Up⟩ moves the focus to the grid.
10.1. Incremental Search. The player, rating list, and club grids have associated Find fields that let you search for a specific record. These are incrementalsearch fields, so you can type just the first part of what you are searching for and
the grid will move to the first matching record. The search happens after every
keystroke. The value you type must be the sort of thing that is in the column that
the grid is sorted on. For example, if you want to search for a player by name, you
must sort the grid by name by clicking on the button in the header of the grid’s
“Name” column.
10.2. Doubles-Team Grid. The grid on the Edit page of the ::Players > Enter
Doubles notebook is somewhat different from the other grids. In this grid, ⟨Left⟩
moves left one cell (wrapping to the previous row), ⟨Right⟩ moves right one cell
(wrapping to the next row), ⟨Up⟩ moves up one cell, ⟨Down⟩ moves down one
cell, ⟨Ctrl+Left⟩ moves to the left-most cell in the same row, ⟨Ctrl+Right⟩ moves
to the right-most cell in the same row, ⟨PgUp⟩ moves up the number of rows in
one screenful, ⟨PgDn⟩ moves down the number of rows in one screenful, ⟨Ctrl+Up⟩
moves to the cell at the top of the screen in the same column, ⟨Ctrl+Down⟩ moves
to the cell at the bottom of the screen in the same column, ⟨Ctrl+PgUp⟩ and
⟨Ctrl+Home⟩ both move to the very first cell in the grid, ⟨Ctrl+PgDn⟩ moves to
the cell in the very last row and first column, and ⟨Ctrl+End⟩ moves to the very last
cell in the grid.
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The ⟨Tab⟩ key, like the ⟨Right⟩ key, moves to the next cell. However, if you
are in the last cell, ⟨Tab⟩ takes you out of the grid to the next control. Similarly,
⟨Shift+Tab⟩, like ⟨Left⟩, moves to the previous cell. However, if you are in the first
cell, it takes you out of the grid to the previous control.
If you type a number, it will replace whatever is in the current cell and the cell
will enter editing mode. To edit an existing value, press ⟨F2⟩ or click the current
cell to put the cell into editing mode. If you are not in editing mode and you press
⟨Del⟩, the contents of the current cell will be deleted and the cell will enter editing
mode. To get out of editing mode, press ⟨Tab⟩ or ⟨Shift+Tab⟩, click another cell or
control with the mouse, or use any of the keys listed above for moving through the
grid other than ⟨Left⟩, ⟨Right⟩, ⟨Ctrl+Left⟩, and ⟨Ctrl+Right⟩.
Note that the ⟨Enter⟩ and ⟨Esc⟩ keys do the same thing in editing mode that
they do when not in editing mode: The ⟨Enter⟩ key clicks the default button (either
Save or Cancel) and ⟨Esc⟩ clicks the Cancel button.
In editing mode, ⟨Left⟩ and ⟨Right⟩ move one character left or right (respectively), ⟨Home⟩ and ⟨Ctrl+Left⟩ move to the beginning of the cell, and ⟨End⟩ and
⟨Ctrl+Right⟩ move to the end of the cell. The ⟨Del⟩ key deletes the character to
the right of the caret, unless more than one character is selected, in which case
it deletes the selected text. The ⟨Backspace⟩ key deletes the character to the left
of the caret, unless more than one character is selected, in which case, it deletes
the selected text. The ⟨F2⟩ key deselects the text and moves the caret to the end
of the cell, ⟨Ctrl+C⟩ copies the selected text to the clipboard, ⟨Ctrl+X⟩ cuts the selected text, ⟨Ctrl+V⟩ pastes, ⟨Shift+Home⟩ extends the selection to the start of the
cell, ⟨Shift+End⟩ extends the selection to the end of the cell, ⟨Shift+Left⟩ extends
the selection left one character, and ⟨Shift+Right⟩ extends the selection right one
character,
You can’t reorder the columns. To resize them, resize the window.

11. Drop-Down List
A drop-down list (also called a combo box) is a control that drops down a list of
choices when you click the arrow at the right of the text, e.g., ::Players > Modify >
Edit > USATT membership > Bought. With the list open or closed, ⟨Up⟩ and ⟨Left⟩
select the previous item, ⟨Down⟩ and ⟨Right⟩ select the next item, ⟨PgUp⟩ moves
up the number of items in one screenful, ⟨PgDn⟩ moves down the number of items
in one screenful, ⟨Home⟩ goes all the way to the first item, ⟨End⟩ goes all the way
to the last item, ⟨F4⟩, ⟨Alt+Down⟩, and ⟨Alt+Up⟩ act as toggles, opening and closing
the list, and ⟨Esc⟩ closes the list without changing the selection from what it was
when the list was opened. With the list open, clicking with the mouse selects an
item and ⟨Enter⟩ closes the list.
With the list either open or closed, you can also select an item by typing it into
the control. For example, to select “Adult”, you can type “a” or “ad”. Similarly,
you can select “2” by typing “2”. In general, the list moves to the first item which
starts with the string you typed. After 1.5 seconds, the control forgets what you’ve
typed, so you can type a new string. You can also press ⟨Backspace⟩ to erase the
last character you typed.
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12. Dates and Date Fields
In grids, Zermelo displays dates using the short-date format specified in your
Windows regional settings. You can change these settings in Control Panel > Regional and Language Options.
When entering a date, use the year-month-day order that matches your shortdate Windows regional settings. The ::Tournament > Modify > Start date field
displays the month name, but you can still enter the date into this field using
numbers. However, unlike the other date fields, you must enter the numbers in
this field using the month-day-year order (since the month comes first when the
number is converted to a word).
You can use either a two-digit year or a four-digit year in any date field. Zermelo assumes that two-digit years are between eighty years ago and twenty years
from now. However, for the Birth field, Zermelo assumes that a two-digit year is in
the past.
In either date field, ⟨+⟩ increments the day, ⟨-⟩ decrements the day, ⟨Up⟩ increments the month, ⟨Down⟩ decrements the month, ⟨Ctrl+Up⟩ increments the year,
and ⟨Ctrl+Down⟩ decrements the year.
12.1. Calendar. For most date fields, you can click the button at the right of
the field or press ⟨Alt+Down⟩ or ⟨F4⟩ to drop down a calendar. Today’s date will
have a maroon frame around it. You can select today’s date by clicking the Today
button. You can select any date by clicking a day. Click one of the buttons at the
top of the calendar to move to the previous month or next month. If you click one
of the buttons and hold the mouse down, the month will keep changing (and speed
up the longer you hold the mouse down).
You can also select the month by clicking on the header text that displays the
month name. This displays a pop-up menu that lists the months. Select the month
you want by clicking on it or by using the ⟨Up⟩, ⟨Down⟩, and ⟨Return⟩ keys. You
can also select the year by clicking on the header text that displays the year. This
displays two buttons on either side of the year. Click the left button to move to the
previous year and the right button to move to the next year. If you click one of the
buttons and hold the mouse down, the year will keep changing.
As for the keyboard, ⟨Left⟩ moves to the previous day, ⟨Right⟩ moves to the
next day, ⟨Up⟩ moves to the previous week, ⟨Down⟩ moves to the next week,
⟨Home⟩ moves to the first day of the month, ⟨End⟩ moves to the last day of the
month, ⟨PgUp⟩ moves to the previous month, ⟨PgDn⟩ moves to the next month,
⟨Esc⟩ closes the calendar without changing the date, and ⟨Return⟩ accepts the selected date and closes the calendar.
13. Time Fields
Zermelo displays times using the format specified in your Windows regional
settings. You can change these settings in Control Panel > Regional and Language
Options. You can enter a time using either 12-hour or 24-hour format.
In a time field, ⟨Up⟩ increments the minute, ⟨Down⟩ decrements the minute,
⟨+⟩ increments the hour, and ⟨-⟩ decrements the hour. By the way, “12:00 pm” is
noon, not midnight.

17. CHECK LISTS

171

13.1. Time-picker. You can click the button at the right of a time field or press
⟨Alt+Down⟩ to drop down a time-picker. You set the hour by clicking or dragging
with the left mouse button. You set the minute by clicking or dragging with the
right mouse button.
As for the keyboard, ⟨Up⟩ increments the minute, ⟨Down⟩ decrements the
minute, ⟨PgUp⟩ increments the hour, ⟨PgDn⟩ decrements the hour, ⟨Esc⟩ closes
the time-picker without changing the time, and ⟨Return⟩ accepts the selected time
and closes the time-picker.
When you use the mouse, the time-picker will round the time to the nearest
multiple of five minutes. If you want to enter a time that isn’t a multiple of five
minutes, use the keyboard or type it directly into the edit.
14. Buttons and Radio Buttons
If a button has the focus, you can click it via either ⟨Enter⟩ or ⟨Space⟩. If a
button has an icon, but no text, you can hover the mouse over the button to pop
up a hint that explains what the button does.
In a radio group, you can use the ⟨Up⟩, ⟨Left⟩, ⟨Down⟩, and ⟨Right⟩ keys to
change which radio button is selected.
15. Button Edits
A button edit is an edit control that has a button as part of the control to the
right of the edit box, e.g., ::Lists > Import > Rating list. If the button edit has the
focus, you can click the button by pressing ⟨Alt+Down⟩.
16. Check Boxes
You can toggle a check box by clicking it (either the box or the text) or, if it has
the focus, pressing ⟨Space⟩.
17. Check Lists
Zermelo has three check lists. They are similar, but not identical. For all three,
you can toggle a check box in the check list by clicking the box or, if the item is
highlighted, by pressing ⟨Space⟩.
17.1. Player Events. The player-events check list is on the ::Players > Modify >
Edit notebook page. For this check list, clicking the text of an item moves the
highlight to the item.
You can also move the highlight using the keyboard: ⟨Up⟩ and ⟨Left⟩ move to
the previous item, ⟨Down⟩ and ⟨Right⟩ move to the next item, ⟨Home⟩ goes all the
way to the first item, and ⟨End⟩ goes all the way to the last item.
Note that ⟨PgUp⟩ and ⟨PgDn⟩ do not move the highlight for this check list.
Instead, they will save your changes and move to the previous or next player, just
as if you clicked the navigator bar.
You can also move the highlight to an event by typing the event number into
the check list. After 1.5 seconds, the check list forgets what you’ve typed, so you
can type a new event number. You can also press ⟨Backspace⟩ to erase the last
character you typed.
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17.2. Print Player Lists. The print-player-lists check list is in the ::Players >
Print Lists window. For this check list, clicking the text of an item toggles the
check box.
You can move the highlight using the keyboard: ⟨Up⟩ and ⟨Left⟩ move to the
previous item, ⟨Down⟩ and ⟨Right⟩ move to the next item, ⟨PgUp⟩ moves up one
screenful, ⟨PgDn⟩ moves down one screenful, ⟨Home⟩ goes all the way to the first
item, and ⟨End⟩ goes all the way to the last item.
You can also move the highlight to an event by typing the event number into
the check list. After 1.5 seconds, the check list forgets what you’ve typed, so you
can type a new event number. You can also press ⟨Backspace⟩ to erase the last
character you typed.
17.3. Print Sheets. The print-sheets check list is in the ::Draw Sheets > Print
window. For this check list, clicking the text of an item moves the highlight to the
item.
You can also move the highlight using the keyboard: ⟨Up⟩ moves to the previous item, ⟨Down⟩ move to the next item, ⟨PgUp⟩ moves up one screenful, ⟨PgDn⟩
moves down one screenful, ⟨Home⟩ goes all the way to the first item, and ⟨End⟩
goes all the way to the last item.
You can also move the highlight to an event by typing the event number, but
⟨Backspace⟩ won’t do anything, and the exact behavior may depend on what version of Windows you have.
If you check the check box for one stage of a two-stage event, then the check
box for the event will show a square rather than a check.
18. List Box
The list of events in the ::Draw Sheets > Display window is a list box. You can
select an event in the list by clicking it with the mouse. Double clicking an event is
equivalent to selecting the event and clicking the OK button.
As for the keyboard, ⟨Up⟩ and ⟨Left⟩ select the previous event, ⟨Down⟩ and
⟨Right⟩ select the next event, ⟨PgUp⟩ moves the selection up one screenful, ⟨PgDn⟩
moves the selection down one screenful, ⟨Home⟩ selects the first event, ⟨End⟩ selects the last event, and ⟨Space⟩ selects the next event, wrapping to the first event
if the last event is currently selected.
If the list box has the focus, you can also select an event by typing the event
number. After 1.5 seconds, the list box forgets what you’ve typed, so you can type
a new event number. You can also press ⟨Backspace⟩ to erase the last character
you typed.
19. Draw-Sheet Window
If you display a draw sheet via ::Draw Sheets > Display, the draw sheet is
displayed in a draw-sheet window. The draw-sheet window is resizable. If the
draw sheet is larger than the current size of the window, scroll bars will appear.
In addition to using the scroll bars, you can use the keyboard: ⟨Up⟩ scrolls up,
⟨Down⟩ scrolls down, ⟨PgUp⟩ scrolls up one screenful, ⟨PgDn⟩ scrolls down one
screenful, ⟨Ctrl+Home⟩, ⟨Ctrl+Up⟩, and ⟨Ctrl+PgUp⟩ scroll to the top, ⟨Ctrl+End⟩,
⟨Ctrl+Down⟩, and ⟨Ctrl+PgDn⟩ scroll to the bottom, ⟨Left⟩ scrolls left, ⟨Right⟩
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scrolls right, ⟨Ctrl+Left⟩ scrolls left one screenful, ⟨Ctrl+Right⟩ scrolls right one
screenful, ⟨Home⟩ scrolls all the way to the left, and ⟨End⟩ scrolls all the way to
the right.
In addition to the usual ways to close a window, you can press ⟨Esc⟩, ⟨Enter⟩,
or ⟨Space⟩.

20. Navigator Bar
If a navigator bar (i.e., the bar containing four buttons in the bottom left of
::Events > Modify > Edit or ::Players > Modify > Edit) has the focus, you can click
the selected button with ⟨Space⟩ (but not ⟨Enter⟩) and select a different button with
⟨Left⟩ or ⟨Right⟩. If you hover over a button with the mouse, Zermelo will display
a hint that explains what the button does and what shortcut key you can use to do
the same thing.
The shortcut keys are ⟨PgUp⟩ moves to the previous record, ⟨PgDn⟩ moves to
the next record, ⟨Ctrl+PgUp⟩ moves to the first record, and ⟨Ctrl+PgDn⟩ moves to
the last record. These keys work regardless of which control on the Edit page has
the focus.

21. Notebooks
Notebook tabs can have the focus, just like any other control. If a notebook
tab has the focus, then ⟨Up⟩, ⟨Left⟩, and ⟨Home⟩ change to the first notebook page,
while ⟨Down⟩, ⟨Right⟩, and ⟨End⟩ change to the second notebook page (since all of
Zermelo’s notebooks only have two pages).

22. Edit Fields
An edit field is a control into which you type text, numbers, or dates. In an edit
field, ⟨Del⟩ deletes the character at the caret (the caret is the vertical bar that shows
where you are in the field), ⟨Backspace⟩ deletes the character to the left of the caret,
⟨Left⟩ moves left one character, ⟨Right⟩ moves right one character, ⟨Home⟩ moves
to the beginning of the field, ⟨End⟩ moves to the end of the field, ⟨Ctrl+Left⟩ moves
left one word, ⟨Ctrl+Right⟩ moves right one word, ⟨Alt+Backspace⟩ and ⟨Ctrl+Z⟩
undo the last change you made, ⟨Ctrl+C⟩ copies the selected text to the clipboard,
⟨Ctrl+X⟩ cuts the selected text, ⟨Ctrl+V⟩ pastes, ⟨Shift+Home⟩ extends the selection
to the start of the field, ⟨Shift+End⟩ extends the selection to the end of the field,
⟨Shift+Left⟩ extends the selection left one character, ⟨Shift+Right⟩ extends the selection right one character, ⟨Ctrl+Shift+Left⟩ extends the selection left by one word,
and ⟨Ctrl+Shift+Right⟩ extends the selection right by one word.
You can also drag with the mouse to select text. If any text is selected, then
whatever you type will replace the selected text and ⟨Del⟩ and ⟨Backspace⟩ will
delete the selected text. When you move to an edit field using the keyboard, the
contents is selected, so whatever you type will replace the contents. To edit the
contents, press a key that moves the caret (e.g., ⟨Left⟩ or ⟨End⟩) or click with the
mouse to deselect the text.
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Figure 3. Progress bar
22.1. Money Fields. Money fields only accept integer amounts. The field will
display a currency symbol when you leave it, but you shouldn’t (and can’t) type
the currency symbol into the field. If your Windows region format setting is not
U.S. English or Canada English, negative amounts will display according to your
Windows negative currency format. However, you must enter negative amounts as
a negative integer using a minus sign.
The following money fields interpret a blank value as zero (the value will
change to “$0” when you leave the field): ::Tournament > Modify > Registration
fee, ::Events > Modify > Edit > Fees > Regular, and all the money fields on ::Players > Modify > Edit.
23. Progress Bars
When Zermelo needs to do something that may take some time, it puts up a
progress bar, e.g., Figure 3. For some operations, it doesn’t put up a progress bar,
but does change the cursor to an hourglass. When Zermelo puts up a progress bar,
you can abort the operation by clicking the Abort button or the “×” in the window
title bar, or by pressing ⟨Esc⟩, ⟨Enter⟩, or ⟨Alt+F4⟩.

APPENDIX I

Crashes and Bugs
If Zermelo crashes, you will see a window like Figure 1. If you don’t understand the message, then it may be a bug. You can copy the message and the details
to the clipboard by clicking the Copy Report to Clipboard button or by pressing
⟨Ctrl+C⟩. The message and details in the window will also automatically be written to the file ZermeloCrash.txt in the database folder. There may also be a file
ZermeloDatabaseError.txt that contains additional error messages.
If you wish to report a bug or have any questions or suggestions, please contact
us; see https://www.ratingscentral.com/Problems.php for our email address. If you
are reporting a bug, please include specific steps so that we can reproduce it, send
us the ZermeloCrash.txt and ZermeloDatabaseError.txt files, and also send us the
database files (if these will help us reproduce the bug).

Figure 1. Crash window
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APPENDIX J

Data Safety
The database library that Zermelo uses writes all information to a journal file
before updating the database files. After updating the database files, the journal
file is deleted. This helps to prevent the files from being corrupted even if the
computer loses power in the middle of writing to the files. If writing is interrupted,
you may see a file with an n$1 extension in the database folder. This is the journal
file. When you start Zermelo, it should process the journal file and delete it.
Windows provides a write-caching feature. If this feature is on, applications
may not be able to force data to be physically written to the disk and a software,
hardware, or power problem may cause data corruption. The settings are in Device
Manager. How you get to Device Manager varies in different versions of Windows.
In Windows 10, you can find Device Manager in Control Panel > Hardware and
Sound > Devices and Printers > Device Manger. Expand the Disk drives node. Right
click on your hard disk or SSD (solid state drive) and choose Properties > Policies.
The options vary in different versions of Windows. In Windows 10, you will see a
check box labeled Enable write caching on the disk and under it another one that
is labeled Turn off Windows write-cache buffer flushing on the device. Checking the
second check box is very dangerous. Checking the first is dangerous. The slight
speed increase is not worth the risk of data corruption. For safety, uncheck both
check boxes.
Some hard disks and SSDs have built-in write caching that cannot be turned
off. For safety, use a UPS (uninterruptible power supply) or both AC power and a
battery.
Antivirus apps can interfere with an app’s ability to write to the disk. For
safety, exclude the database folder from your antivirus app.
You should put the database folder on the most reliable disk that you have,
e.g., your C: drive. Using a USB key, removable disk, OneDrive folder, etc. is not
a good idea. Of course, USB keys are excellent for transferring the database files
between computers or making short-term backups. For long-term backups, CD-R
or DVD-R disks are best.
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APPENDIX K

Cost
Zermelo is not free. The cost for Zermelo depends on whether you are using it
in conjunction with Ratings Central.
If you use Zermelo to run a tournament that you submit to Ratings Central,
then include the cost to use Zermelo in the fee that you pay to use Ratings Central,
as described in Section 1.
If you use Zermelo to run a tournament that you do not submit to Ratings
Central, then the cost to use Zermelo is US$20 per tournament. See https://www.
ratingscentral.com/Cost.php for how to pay.
1. Ratings Central Cost
Ratings Central uses a pay-what-you-think-is-fair fee system.
Different people use Ratings Central in different ways. Some directors have
only a few players, a few matches, and an occasional event. Others have many
players, many matches, and many events and tournaments. Some directors and
clubs are independent. Others are part of larger organizations. Some clubs and
organizations have many directors. Others have only one. Some use Cantor and
Zermelo. Others use some other method of submitting results. Some grab data
from the website for download or redisplay.
Rather than try to accommodate all the different ways that people use Ratings
Central in a fee schedule, Ratings Central uses a pay-what-you-think-is-fair fee system: Each year that you, an event director, or your players use Ratings Central, you
should pay what you think is fair, taking into account how you, your players, and
your club or organization use Ratings Central.
If you are part of a club, organization, or some other entity that has multiple
event directors, then you (the event directors) can pay as a group. If you think that
your players should contribute, then you should collect the money from them.
That is, directors should handle the payments, but directors can decide how they
raise the money within their club, organization, or tournament.
What you should pay should include what you think is fair for the use of all
aspects of Ratings Central, including the ratings, website, Cantor, Zermelo, the API,
notification emails, etc.
See https://www.ratingscentral.com/Cost.php for how to pay.
We are not going to tell you how much you should pay each year to use Ratings
Central (where “you” includes the clubs and organizations that you represent). If
you are not sure how to determine what is fair, the following may help: What is the
most that you would pay to avoid the alternative of not using Ratings Central? You
should not pay more than that. On the other hand, that is probably more than you
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feel comfortable paying. So, come up with an amount that you feel is reasonable
and fair. You should be able to say to yourself, “I’m getting a good deal. I’d be
willing to pay 50% or 100% more for what I get.” But, if you can say, “Wow. I’m only
paying 5% of what I’d be willing to pay”, then do you think that is fair?
If you think that it is fair to pay nothing, then apparently Ratings Central is of
no value to you, so you should not be using it.
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advancers, see advancers in bold
submenu item, 165
Bookkeeping, 59, 95
Bought, 59, 60, 80, 81, 169
Browse
Enter Doubles, 87
Events > Modify, 63–64
Players > Modify, 75–76
Browse Club, 52, 125
Browse Rating, 52, 85, 87, 167
bugs, 175
button, 167, 171
button edit, 171

⟨+⟩, 113, 165, 170
⟨-⟩, 170
accelerator key, 165, 166, 168
Acrobat, 145
Add Event, 26, 64
Add Player, 26, 76, 86
add player to event, 26, 67, 68, 84, 85, 87, 89,
127
Adding, 68
Address 1, 60, 78, 79
Address 2, 60, 78, 79
Adjustment, 80, 174
Adobe, 145
Advance, 54
advancers in bold, 103
Age, 79
Age cutoff , 66, 72
All, 100, 145
All Done, 82
⟨Alt⟩, 165, 167, 168
⟨Alt+Backspace⟩, 173
⟨Alt+Down⟩, 169–171
⟨Alt+F4⟩, 137, 163, 174
⟨Alt+Space⟩, 163
⟨Alt+Up⟩, 169
Amount paid, 174
antivirus, 177
Any, 66, 79
arrow buttons, 163
At Lunch, 81, 82, 95, 114
Auto, 66, 67, 107, 128
Autocalc, 81
Autoname, 64

⟨C⟩, 165
calendar, 25, 170
Call, 27, 28, 66, 67, 69, 106, 107, 111, 112,
114, 118, 120, 121, 128, 165
Call One, 76, 114, 115, 118
Call Some, 22, 66, 69, 116, 118
Call Stages, 22, 69, 115
Cancel, 163
caret, 173
Cash box, 95
cash box, 127
Change
Club, 57, 78, 125
check box, 167, 171
Check in, 81, 90, 95, 107, 114, 116, 127
Check In or Out, 27, 81, 90, 94, 167
check list, 84, 171
chess, 139
City, 60, 78, 79
Clear
Club, 57
clipboards, 109, 120, 127
clock, see time-picker
Close, 163
Club
player, 77, 79
tournament, 57
club browser, 52, 57, 78, 125

⟨Backspace⟩, 169, 171–173
backups
making, 19
restoring, 20
balls, 109
Birth, 60, 79, 170
bold
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Club list, 51
club list, 19, 49, 52, 57, 125
add your club, 49
club priority, 78
Club.nx1, 19, 57
ClubList.csv, 50, 51
cohort randomized seeding, 73
columns
reorder, 64, 76, 163, 168
resize, 64, 75, 163, 168
combo box, see drop-down list
Computer, 95
computer desk, 94, 127–128
Continue and Ignore Errors, 52
Continue Importing, 52
control, 164
control desk, 59, 109, 120, 127–128
correcting errors, 46, 113, 114, 117, 134, 136
cost, 179
Country
player, 78, 79
tournament, 54
Counts for ratings for. . . , 66
crash, 175
Create New, 29, 60–62
CSV, 51, 60, 98
⟨Ctrl+A⟩, 137
⟨Ctrl+C⟩, 137, 169, 173, 175
⟨Ctrl+Del⟩, 64, 76
⟨Ctrl+Down⟩, 165, 168, 170, 172
⟨Ctrl+End⟩, 165, 168, 172
⟨Ctrl+G⟩, 168
⟨Ctrl+Home⟩, 165, 168, 172
⟨Ctrl+I⟩, 84
⟨Ctrl+Left⟩, 165, 168, 169, 173
⟨Ctrl+N⟩, 77, 85
⟨Ctrl+PgDn⟩, 165, 168, 172, 173
⟨Ctrl+PgUp⟩, 165, 168, 172, 173
⟨Ctrl+R⟩, 83, 85
⟨Ctrl+Right⟩, 165, 168, 169, 173
⟨Ctrl+Shift+Left⟩, 173
⟨Ctrl+Shift+Right⟩, 173
⟨Ctrl+T⟩, 84, 85
⟨Ctrl+U⟩, 83, 85
⟨Ctrl+Up⟩, 165, 168, 170, 172
⟨Ctrl+V⟩, 169, 173
⟨Ctrl+X⟩, 169, 173
⟨Ctrl+Z⟩, 173
Current, 81
current folder, 61
Cutoff dates, 54
Database folder, 61
database folder, 19, 20, 22, 23, 28, 57, 60–62,
98, 175, 177
database-folder pane, 23, 98
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date
wrong, see Start date, wrong
day two, 82
Days, 54, 66
Deceased, 79
Default, 113
default button, 104, 112, 165
default card, 64, 66, 107, 109, 113, 114, 116,
118, 121, 128
Default times, 66, 121
defaults, 85, 118
Defaults Out, 64
⟨Del⟩, 169, 173
Depends on Who Advances, 82
Desired size, 68, 149
director
retiring, 56
Director ID, 55
director ID
deleting, 56
policies, 56
second, 45
wrong, 47
director password, see Password, Director
disabled, 164
Discard all, 50
discard card, 108, 118
Display
button, 104, 112
menu item, 99, 172
Display Statistics, 57, 95, 96
Display Version, 42
Done for the Day, 82
Double clipboards, 120–122
double clipboards, 109, 120, 121, 148
double default, 108, 113
doubles, 66, 70, 87, 89, 92, 127, 167
fees, 72
Doubles first, 123
⟨Down⟩, 165, 168–173
Draw
field, 66, 67, 72, 90, 128, 148
menu item, 27, 67, 72–74, 106, 147
draw
deterministic, 72
separating players, 78
Draw club, 78, 99, 101
Draw Sheets, 99
Print, see Print
draw sheets
changing, 104
deleting, 67
modified, 22, 64, 100, 105
posting, see draw sheets, modified
printing, see Print
viewing, 99
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Drawing, 68, 149
Drawn, 67
draws
manual, 74
drop-down list, 169
dummy event, 148
duplicate players, 135–136
duplicate record, 50
Edit, 173
Enter Doubles, 88
Events > Modify, 64–72
Players > Modify, 76–85, 134
edit field, 173
Eligibility, 66
Email, 60, 79
enabled, 164
⟨End⟩, 165, 168–173
⟨Enter⟩, 28, 104, 112, 137, 165, 166, 169, 171,
173, 174
Enter Doubles, 84, 87, 168
Enter Result, 27, 28, 84, 107, 111, 114, 118,
165
Entries, 59, 64
entry form, 127
sample, 151–158
Entry.nx1, 19
error-message window, 137
errors, 137
correcting, see correcting errors
⟨Esc⟩, 137, 163, 165, 169–171, 173, 174
Event, 121
event
capacity, 65
code letter, 84
ID, see ID, event
Name, see Name, event
Sex, see Sex, event
starting times, 66, 71, 123, 151–152
Event Director Support, 45
Event format, 65, 67, 148
event formats
other, 147
Event is doubles, 66, 67, 164
Event.nx1, 19
Events
check list, 84, 100, 101, 171
menu item, 63
Modify, see Modify, Events
Print Lists, 92, 172
events
deleting, 64
start times, 122
Excel, 51, 60
exclamation point, 78
Existing records, 50
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Exit, 39
Expiration, 86
Expiration, 81
Expired, 81
Export, 76, 98
Export Finalists, 60
⟨F10⟩, 165
⟨F2⟩, 169
⟨F4⟩, 169, 170
Fee
Juniors, 72
Low-rated players, 72
Fees, 72, 80
files
lost, see lost files
moving, see backups, restoring
final group, 105, 113, 122
finalists, 60
Finals last, 123
Find, 76, 168
club list, 125
rating list, 86, 87
Finished, 64
focus, 164, 165
font size, 161
For duplicates, keep. . . , 50
Foreign, 81
Full, 64
giant round robin, 21, 122, 147–148
Gone for Good, 81
Gone for the Day, 81, 82, 95
grayed, 164
grid, 26, 63, 75, 87, 163, 167–168
sorting, 76, 163, 168
group
adding, 105
order of play, see order of play
group sizes, 68
handicap
chart, 70, 71
event, 67, 69, 71, 74, 107
hardware requirements, 18
Help, 17
Here Now, 81, 82, 95, 107, 114, 116, 119, 127
hint, 171
⟨Home⟩, 165, 168–173
hourglass, 174
hover, 163, 171
Icon caption, 61
ID
Director ID, see Director ID
ITTF , 84
player, see player ID
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Ratings Central, 80, 83, 134, 136
Tournament, see player ID
TT Australia, 79, 83
USATT , 60, 79, 83
ID
event, 64
ID list, 97
IDs, 79, 80, 83
Import, 85
Lists, 25, 49
Players, 96
Include clubs, 99, 101
Include USATT info, 94
Incomplete, 100
incremental search, 76, 86, 125, 168
installation, 18
Interval, 106
ISO 8859-1, 21, 57
ITTF
ID, see ID, ITTF
ITTF ID, 79, 80, 134
ITTF rules
draws, 72, 159
place, 102
journal file, 177
junior events, 66, 71, 79
Juniors, 54
Fee, see Fee, Juniors
Keep, 50
Last Played, 86
Latin 1, 21, 57
⟨Left⟩, 165, 168–173
libeay32.dll, 19
License.txt, 19
life membership, 86
lifetime membership, 81
List database folder, 57, 87
List Playing, 118
Lists, 49
Import, see Import, Lists
log in to website, see website login
log window, 22, 26, 85, 89, 109, 165
lost files, 47
Low-rated players
Fee, see Fee, Low-rated players
Rating cutoff , see Rating cutoff , Low-rated
players
Lunch
At, see At Lunch
Lunch, 121
⟨M⟩, 23, 101
main menu, 22, 165
main window, 22, 25, 165
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Manage match calling, 21, 66, 71, 82, 102,
110, 115, 116, 119, 148
Match, 122, 148
match
result, 111
match card, 27, 54, 76, 82, 107, 112–115, 118,
120, 127
lost, 115
Match format, 67, 69
match points, 103
Matches
menu item, 107
matches
not calling, 69, 81
per event, 58–59
queued, 109
remaining, 23, 59, 64
time per, 58
Matches Playing, 76
matches-playing pane, 23
max overflow, 68, 149
Max underflow, 68, 149
Mean
player unrated prior, 83
tournament, 55
Member.nx1, 19
Men, 66
Merge Player, 86
Method, 121, 148
mistakes, see errors
Mixed, 66
Modified, 64
Modified, 100, 101
Modify
Events, 25, 63–72, 167
Players, 26, 75–87, 167
Tournament, 25, 53–57, 75
Modify Calling, 72, 110, 117–123
Modify Posting, 105
More to Play, 82
moving files, see backups, restoring
multiple tournaments on same date, 45
n$1, 177
Name, 79
event, 64
player, 60, 76
Player List Sorted by. . . , 92
Sort event lists by. . . , 93
tournament, 25, 54, 60
navigator bar, 64, 76, 147, 173
Never, 86
Never, 81
Never Here, 81, 95
New
For duplicates, keep. . . , 50
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New personal info, 46, 79, 134
New Player, 87
new tournament, see Create New
noon, 170
Not Called, 113
Not Entered, 82
Not here, 66
Not Here Today, 81, 82
notation, 23
notebook tab, 173
Notes, 84, 96
nx1, 19
nxTrans.cfg, 19
Old, 50
On-deck matches, 120–122
OpenSSL, 19
Order, 69, 110, 121
order of play, 121, 141
one advancer, 142
two advancers, 143
Organization, 97
Overdue, 23
overdue-results pane, 23, 123
overview, 25–29
Overwrite Player, 86
Owes, 80, 94, 174
paging, see public-address system
Paid, 80, 81, 95
paper cutter, see ruler
parentheses
numbers in, 26, 84, 104, 112
Password
Email, 40
Ratings Central Director, 56
Web proxy server, 41
PDF, 145, 147
⟨PgDn⟩, 165, 168–173
⟨PgUp⟩, 165, 168–173
Phone, 60
place, 102, 103
Place byes randomly, 67, 73, 85, 149
player
Name, see Name, player
Sex, see Sex, player
Player ID, 27, 90
player ID, 26, 84, 88, 94, 96, 101, 104, 112,
127
Player list sorted by. . . , 92
Player notes, 84, 96
Player.csv, 98
Player.nx1, 19
Players, 75
Import, see Import, Players
Modify, see Modify, Players
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players
deleting, 76
Players that advance, 67, 69, 148
Playing, 23
Playing, 82
Playing Now, 82
Playing or Played, 64
Port, 41
Postal code, 60, 78, 79
posting, see draw sheets, modified
posting-reminder pane, 22, 27, 101, 106
Print, 27, 100, 145, 172
Print Lists, 27, 67, 90
Print Table Numbers, 59
printer, 18, 41
progress bar, 174
Province, 79
player, 78
tournament, 54
public-address system, 21, 108, 109, 127
pushpin icon, 22, 27, 101, 106
queued matches, see matches, queued
⟨R⟩, 113
radio button, 167, 171
radio group, 171
Rating, 147
Rating, 80, 82
Player List Sorted by. . . , 92
Sort event lists by. . . , 93
Rating cutoff
Eligibility, 54, 66
Low-rated players, 72
Rating List, 26, 76, 85
Rating list
::Lists > Import, 51
rating list, 19, 49, 52, 85, 134, 168
rating-list browser, 52, 76, 83–85
RatingList.csv, 50, 51
RatingList.nx1, 19, 57
Ratings Central, 66, 133
ID, see ID, Ratings Central
menu item, 45
Ratings Central Director, 55
Ratings Central website, 17
Read-only, 20
read-only, 164
ReadMe.txt, 19
registration desk, 81, 82, 89, 90, 93–96, 123,
127–128
Registration fee, 54, 80, 174
Registration list, 27, 81, 93, 94, 96, 127
Regular, 72, 174
Remaining, 23, 59, 64
remaining-matches pane, 23
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Remind, 23, 106
Renumber players, 96
Result overdue time, 123
results, 127
correcting, 113, 117
⟨Return⟩, 170, 171
⟨Right⟩, 165, 168–173
round robin
giant, see giant round robin
order of play, see order of play
place, see place
rounds
adding, 105
numbering, 101, 105, 121
RR, 65, 147, 148
RR groups, 68
RR to RR, 65, 68, 69, 101, 105, 113, 122, 148
RR to SE, 65, 68, 101, 149
ruler, 109, 127
SampleClubList.csv, 19, 25
SampleRatingList.csv, 19, 25
Schedule, 26, 65
Schwenk, Allen J., 72
Score, 28, 112
score
correcting, 114
scratch, 26, 67, 84, 85, 87–89
screen resolution, 161
scroll bar, 163, 167
thumb, see thumb
SE, 65, 149
searching, 69, 107
second day, see day two
Second format start, 69
Select Club, 125
Select Printer, 41
senior events, 66, 71, 79
Seniors, 54
Separate club members, 67, 73, 85
Server name, 41
set theory, 139
Set Up Internet, 39
Sex
event, 66, 79
player, 60, 79
⟨Shift+End⟩, 169, 173
⟨Shift+Home⟩, 169, 173
⟨Shift+Left⟩, 169, 173
⟨Shift+Right⟩, 169, 173
⟨Shift+Tab⟩, 164, 169
shortcut key, 77, 83–85, 165, 166
singles, 70
SMTP port, 40
SMTP server, 39
Sort event lists by. . . , 93
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Source, 86
Source, 50, 51
⟨Space⟩, 137, 171–173
Sport, 56
sports
multiple, 46, 56
ssleay32.dll, 19
St. dev. threshold, 55, 72, 74, 83
staff, 128
Stages, 22, 69, 102, 109, 110, 115, 117
Standard deviation
player, 80, 82
player unrated prior, 83
tournament, 55
Start date, 25, 54, 63, 170
wrong, 47
Start day, 65
Start in, 61, 62
Start time, 26
Modify Posting, 106
Schedule, 65, 121
starting times
event, see event, starting times
State
player, 60, 78, 79
tournament, 54
Status, 81
Check in, see Check in
Playing, see Playing
status bar, 22, 27, 98, 101, 106, 123
Stop Importing, 52
Submission method, 39
Submit, 46
Submit Tournament, 45, 133
Submitted, 46
Swap Slots, 74, 85, 104, 112
⟨Tab⟩, 104, 112, 164, 169
table numbers, 120
Tables, 120
Team-rating cutoff , 54, 66, 164
Test, 41
third day, 82
thumb, 163, 167
tie-break, 102
time scheduled, 21, 151
Time-Event, 121–123
time-picker, 66, 106, 171
Time-Round, 121–123
title bar, 163
Today, 170
Total, 80
Tournament, 53
ID, see player ID
tournament
lost, see lost files
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multiple day, 94
Name, see Name, tournament
new, see Create New
submitting, see Submit Tournament
two on same date, see multiple tournaments
on same date
wrong director ID, see director ID, wrong
wrong start date, see Start date, wrong
tournament player ID, see player ID
tournament-report file, 54, 83, 148, see Write
USATT Report
Tournament.nx1, 19, 47
TournamentLog.txt, 19, 22
TT Australia
ID, see ID, TT Australia
tutorial, see overview
two tournaments on same date, see multiple
tournaments on same date
uncall, 117
underlined letter, see accelerator key
Undo One, 67, 82, 84, 104, 110, 113, 115, 117
unrated event, 66, 71
Unrated players, 72
Unrated prior
player, 80, 83, 129
tournament, 55, 129
Unrateds advance, 60, 102, 103
Unrateds can enter, 66
⟨Up⟩, 165, 168–173
upgrading, 20
UPS, 177
USATT
Counts for ratings for. . . , 66
ID, see ID, USATT , 94
USATT membership
associate, 83
USATT membership, 81, 86, 95
USATT report, see Write USATT Report
Use authentication, 40
Use player’s club, 78
Use proxy server, 41
Use TLS, 19, 40
user interface, 163–174
persistence, 163
Username
Email, 40
Web proxy server, 41
Validity, 81
VersionHistory.txt, 19
Visit Website, 45
Web, 145
website login, 45
window
closing, 163
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log, see log window
resizing, 163
winners, 60
Women, 66
write caching, 177
Write USATT Report, 60, 66, 147
wrong director ID, see director ID, wrong
wrong start date, see Start date, wrong
Your email address, 39
Zermelo, 39
Zermelo, Ernst, 42, 139
Zermelo.exe, 19, 62
Zermelo.ini, 42, 163
Zermelo.pdf, 19
ZermeloCrash.txt, 175
ZermeloDatabaseError.txt, 175
Zhizhong Han, 141

